
About NetObjects Fusion
NetObjects Fusion™ is the first smart Web site production application that combines automated site 
building, database publishing, and professional-quality design features. Its visual, site-oriented approach 
to Web site authoring offers unprecedented efficiency and ease of use for users of all levels. 

You can use NetObjects Fusion to design and create an entire site without any HTML knowledge. When 
you preview or publish a site, NetObjects Fusion automatically generates the necessary HTML code. You 
can use NetObjects Fusion to design and prototype sites that will later be completed using other tools, 
and you can import sites created in other tools to NetObjects Fusion. NetObjects Fusion’s open 
architecture and HTML standards support let you create sites that can be integrated with scripts, Java™ 
applets, Shockwave™, digital video, and other rich media plug-ins. 



Contacting NetObjects
There are three convenient ways for you to contact NetObjects: 

· Visit our Web site at www.netobjects.com for the latest information on NetObjects Fusion. The 
support section of our Web site contains many resources such as frequently-asked questions and 
detailed usage notes. Using the NetObjects Web Site tells how to use the NetObjects Web site.

· Visit our e-mail based news groups, which you can access through the support section of our Web site.
Review the various discussion threads for the topic that interests you.

· If you have a question on how to use NetObjects Fusion that is not covered in this online help system, 
the manual, the Web site, or by the news groups, send it via e-mail to support@netobjects.com.



Getting Help
NetObjects Fusion 2.0.x provides a full Windows help system to assist you while creating sites. There are 
two main components:

· Windows Help version of the NetObjects Fusion User Guide

Select Help Topics from the Help menu to launch this help system and display the main table of 
contents. 

· Context-sensitive Help

To view help for objects in the workspace and controls in dialogs and properties palettes, right-
click the item, then select What's This? from the pop-up menu.    

Alternatively, to view help for dialog and palette controls, click the question mark icon in the title 
bar, then click the item to display help. 

· To view help for menu commands, highlight the command, then press the F1 key.

To display an overview of NetObjects Fusion help, select Help Overview from the Help menu to open the 
Help Overview HTML page in your browser. 

If you have questions about NetObjects Fusion that are not answered in this help system, the NetObjects 
Fusion User Guide, or the NetObjects Fusion Getting Started manual, you can take advantage of active 
news groups, usage notes, and frequently asked questions (FAQs) by visiting the support section of the 
NetObjects Web site at:
http://www.netobjects.com/html/support.html
The Help Overview HTML page contains active links to all the NetObjects Fusion support options, 
including the online Getting Started manual, NetObjects newsgroups, FAQs, and usage notes available 
through the NetObjects Web site.



NetObjects Fusion Primary Views
NetObjects Fusion uses five different views to let you design, create, and manage the various aspects of 
your site. They are arranged to guide you through the main steps of building a Web site. Changes made 
in one view are reflected in the others. 

· Use the Site view to create the overall site structure.

· Use the Page view to add content to your pages. 

· Use the Style view to apply a site-wide visual theme.

· Use the Assets view to manage your files, links, data objects, and variables.

· Use the Publish view to stage or publish your completed site.

In each view, you can double-click the title bar of the Tools or Properties palettes to reduce them to just 
their title bars. And you can use the Undo command repeatedly to step back through a series of changes 
you have decided against, back to the state the view or page first appeared when you switched to it.



Moving Around in NetObjects Fusion
You can navigate to different views using the control bar, menu commands, and keyboard shortcuts. 

As you construct your site, you can move freely from page to page and from one view to another using a 
variety of navigation methods. 

Open any view at any time by clicking one of the view buttons in the control bar at the top left of the 
screen.

The three buttons on the right of the control bar provide a site-wide search, an immediate return to the 
previous display, and a shortcut for creating a new object.

To search the entire site for any named NetObjects Fusion object (a page, layout, style, data list, and so 
on), click the Go To button and enter the name of the item you want to see.

To return to the previous view, click the Last button. Clicking Last twice redisplays the current page or 
view. This button allows you to quickly switch back and forth between two pages.

To create a new object specific to the current view, click the New button. In Site and Page views, New 
creates a new page; in Style view, it creates a new SiteStyle; and in Assets view, it creates a new asset.

In the Site view, you can immediately open a Page view by double-clicking a page icon. 

In the Page view, use the buttons at the lower left corner to move from page to page. You can move up, 
down, left, or right within your site without leaving the Page view.

The Go menu provides all the navigation features in one place. 

The first five commands open any of the views. The next four commands switch between pages. The Go 
To... command offers a keyword search. The Last command opens the last page or view you were 
working on. Use the Recent... command to select from a list of the views and pages you have displayed 
during the current NetObjects Fusion session.

The Go menu also displays the keyboard shortcuts for its navigation commands.



Previewing Your Site

At any time during your site production process, you can click the Preview button in the control bar to 
quickly check the results of your work.

Preview displays your whole site in the browser you specify in the Preferences dialog. To quickly preview 
just the page you are working on, hold down the Control key while clicking Preview. If you are optimizing 
your site for multiple platforms or browsers, hold down the Shift key while clicking Preview. This makes 
HTML table borders visible in your preview, which can help you identify and correct problems. Table 
borders never appear when you stage or publish.

Previewing creates folders and files on your disk, but they do not comprise a working site. Certain 
information critical to a published site—for example, relative paths for assets—are not included in preview
files. By not including this information, previewing can display your site for testing more quickly than 
staging or publishing. When you are satisfied with your preview, go on to stage and publish your site as 
described in the topics beginning with About Publish View.



Setting Preferences
You can change your preferences at any time. Changes take place immediately and apply to the current 
site only. Preferences are saved with the site.

1. Choose Preferences from the Edit menu.

NetObjects Fusion displays the Preferences dialog box.

2. Set your general preferences.

· AutoSave. If you deselect AutoSave, you must save your site periodically by choosing 
Save Site from the File menu.

· Window Maximized at Startup. If you deselect Window Maximized, the site opens in the 
last size you set.

· Choose the browser for Preview by selecting it from the Browser drop-down list.

· Choose whether to Preview the Current Page or the Entire Site. Previewing the entire site
takes longer, but lets you use your site’s navigation buttons to move from page to page in
your Web browser.

· Choose whether Page view should display text spacing exactly as it will appear in either 
Netscape Navigator™ or Microsoft® Internet Explorer™. These browsers space text 
differently, even when given the same HTML. So, no matter which option you choose, 
NetObjects Fusion generates the same HTML. WYSIWYG stands for "What you see is 
what you get." When you choose the WYSIWYG option that matches your Preview 
browser, the text spacing you see in Page view is the text spacing you get in Preview.

· To choose an HTML editor, click Browse. You can launch the selected editor from within 
NetObjects Fusion by double-clicking on an External HTML page in Page view.

3. To set Page preferences, click the Page tab.

4. Click the appropriate Font button to set default proportional and monospace fonts.

So that your pages appear in your Web browser the way you design them in NetObjects Fusion, 
be sure to choose the same font settings in your browser. For example, if you use Times, size 16, 
and Courier, size 14, for NetObjects Fusion proportional and monospace fonts, choose the same 
ones in your Web browser.

5. Set your default page size by specifying a width and height.

6. Set Background Image Offset, in pixels.

Some Web browsers add a border to the page display, moving any background image the 
thickness of the border, which may vary from six to sixteen pixels. If the alignment of foreground 
page elements with a background image is important, use this setting to compensate for your 
background image.

Background Image Offset works by clipping the set number of pixels from the left and top of the 
background image. The default settings are optimized for Netscape Navigator and Microsoft 
Internet Explorer.

7. Select the Auto-resize Margins option. When set, you can drag the MasterBorders boundaries to 
set margin size as long as no elements are in the way. If you do not set this option, you must use 
numeric properties to set the MasterBorders size, although MasterBorders always expand 
automatically to accommodate any large element you place inside them.

8. To set Backup preferences, click the Backup tab.    See Backup Options.



Backup Options
Automatic
NetObjects Fusion 2.0.2 offers an automatic backup feature.    The new Backup tab in the Preferences 
dialog box is used to configure various Backup options, described below.

1. Enabling or Disabling Automatic Backup.

Enable or disable NetObjects Fusion's automatic backup feature by checking or unchecking the 
Automatic Backup checkbox.    The feature is enabled by default (it is recommended that this 
option be enabled). Customize settings with the options found in the Backup Settings group box.

2. Configuring Backup Settings. 

· Backup location.    Specify the location you wish to keep your backup site files.    Click on 
the Browse button to browse for a new location.    The default backup location is a 
"Backups" folder found within the current site folder (User Sites\sitename\Backups).

· Maximum number of backups kept.    Specify the maximum number of backup files to be 
maintained in the specified backup location.    When the maximum number is reached, the
earliest backups are deleted. The maximum allowed number of backup files is 20, and 
the default setting is 2.

· File naming convention.    Select a file naming convention for your backup files from the 
dropdown list.    Choose either dated backup files or sequentially numbered backup files.

3. Enabling or Disabling Database Compaction.

When the Compact database upon exit checkbox is checked, NetObjects Fusion compacts the 
active site's database whenever you exit the application. Enable or disable this feature by 
checking or unchecking the checkbox. The feature is enabled by default (it is recommended that 
this option be enabled). A result of compaction is decreased .nod file sizes.

Manual
NetObjects Fusion makes it easy to make a copy of the active .nod file. 

1. In Site view, choose Save Site As... from the File menu.

2. In the Choose a Filename dialog that appears, choose a name and location for your backup file.

3. Type a name for your backup file and click OK.

NetObjects Fusion creates a copy of your .nod file in the location you specified. 

Note: The backup you make with the Save Site As command does not include assets. To make a copy 
that includes assets and other information that can be valuable if problems occur, back up your site as a 
template as described in Exporting a Site as a Template.



NetObjects Fusion Mouse and Keyboard Shortcuts
This section contains many of the most frequently used NetObjects Fusion mouse and keyboard 
shortcuts.

Working in Site View
· You can immediately open a page in Page view by double-clicking a page icon. 

· Press Enter to turn edit mode on and off    for the page name of the selected page. 

· To add a page, select the page you want to be the parent of the new page, then click the New Page 
button in the control bar, press the Insert key, or choose New Page from the Edit menu.

· To delete a page, select it, then press the Del key.

Working in Page View
· Use the buttons at the lower left corner to move from page to page. You can move up, down, left, or 

right within your site without leaving the Page view.

· You can replace a misspelled word with a suggestion by double-clicking the suggestion.

· When drawing a line,    to constrain the line to vertical or horizontal,    hold down the Shift key while 
dragging.

Selecting Elements in Page View
· To select multiple elements,    drag a selection box around them, or    hold down the Shift key while you 

click them one at a time. 

· You can    deselect one element at a time by holding down the Shift key while you click the element. 

· To select all elements in the MasterBorder or Layout area, click in the area, then press Ctrl-A.

Working with Pictures in Page View
· To change the size of a bounding box, drag one of its handles. This does not affect the size of the 

image.

· To crop the lower right portion of a picture, select the picture you want to crop, then drag the lower-right
bounding box handle until you see only the portion of the image you want to display.

· To return a bounding box to the picture’s original size, select the picture, then choose Size to Image 
from the Page menu.

· To copy a picture, hold down the Control (Ctrl) key while you drag the picture to a new location. The 
original will remain in place. 

· To change an image, double-click on it to display the Image File Open dialog.

· When using the Image File Open dialog,    the path appears in the File Path field of the Image Assets 
tab. Use the right-arrow key to scroll and view the whole path and name. You can do the same in the 
File field of the Picture properties tab.

Selecting Text in Page View
Use these methods to select text and paragraphs:

· Drag to select specific characters.

· Double-click to select a word.

· Triple-click to select a paragraph.

· To select a block of text, click the first word, then Shift-click the last word.

· To select multiple paragraphs, drag through them.



· When formatting paragraphs, to end a paragraph, press Enter. NetObjects Fusion automatically inserts 
a double space before the next paragraph.

· To force a line break within a paragraph, press Shift-Enter.

Previewing, Staging, and Publishing
· To quickly preview just the page you are working on,    hold down the Control key while clicking 

Preview. 

· When staging your site, if your Web server is not responding, hold down the Control key while clicking 
the Stage button. This will start the FTP client application that is built into NetObjects Fusion without re-
generating all the HTML and assets.

· When publishing your site, if your Web server is not responding, hold down the Control key while 
clicking the Publish button. This will start the FTP client application that is built into NetObjects Fusion 
without re-generating all the HTML and assets.



About Site View
The NetObjects Fusion Site view is a visual site-structure editor, where you create the hierarchy of your 
site’s sections and subsections. You can drag a page or section to any location in a site, and NetObjects 
Fusion updates its links to other pages automatically.

The Site view lets you focus on organizing and updating the information of your Web site freeing you from
the details of files and links.



Using Site Tools
There are three site tools:

    Selection. The Selection tool lets you select page icons and drag them to new positions. Also use 
the Selection tool to select and change page names.

    Zoom In. Zoom in to enlarge the Site view.

    Zoom Out. Zoom out to see more page icons in the Site view.

You can reduce the Tool palette to its title bar by double-clicking the title bar, and restore it with another 
double-click.



Constructing a Site
In the Site view, the pages of your Web site are represented by page icons. When you want to add 
content to a particular page, you use the Page view. When you construct a site, you typically go back and 
forth between the Site view and the Page view. In the Site view, you work on all the pages and their 
relationships. In the Page view, you work on one page at a time.

A page is always selected in the Site view. The selected page is indicated by a blue border drawn around 
it. You change which page is selected by clicking another page icon.



Starting with a Blank Site
You can build your site from a single Home page.

1. Choose New Site from the File menu.

2. In the New Site dialog box, enter a site name.

The site name serves as the file name for storage. It is also the name of the subfolder that stores 
the NetObjects Fusion site (.nod) file and the assets for the site.

3. If you want to save the site file somewhere outside the NetObjects Fusion folder, click the Change
button to choose another folder. 

4. Click OK.

NetObjects Fusion creates a folder with a .nod file and an Assets folder. The default folder 
location is NetObjects Fusion 2.0\User Sites.

The Site view opens and displays a Home page. You are ready to begin adding pages to create 
your site’s structure.



Opening an Existing Site
Any site you have named can be opened as a .nod file.

1. Choose Open Site from the File menu.

NetObjects Fusion displays the Open dialog box.

2. Select an .nod file and click Open.

Note: As you open and close sites in NetObjects Fusion, a list of the most recently used site files is 
created and displayed in the File menu. NetObjects Fusion remembers the last four site files opened.



Starting with a Template
A template is an existing site structure or page design file that has the extension .nft. NetObjects Fusion 
offers a set of templates for sites and pages that you can use as starting points for your work. An 
AutoSite™, located in the NetObjects Fusion 2.0\Templates folder, provides a complete site 
structure with designed pages and suggested content. A page template is a professionally designed 
single page or form containing generic content that you can replace with your own information. You can 
also start with a template you’ve created yourself as described in Exporting a Site as a Template.

You can select any of the AutoSite and page templates that accompany NetObjects Fusion when a new 
site is created. They can also be inserted into an existing site file. 

Note: All new Blank sites you create are also based on a template. When you select the default Blank 
setting in the New Site dialog, NetObjects Fusion bases your new site on the Blank Site template (Blank 
Site.nft) that resides in the AutoSites folder. To adjust the default settings of a new blank site, make a 
backup of the standard Blank Site.nft that resides in the AutoSites folder, open a new blank site named 
Blank Site, make the adjustments you want, export the site as a template, and replace the default Blank 
Site template and folder in the AutoSites folder with your own.

To start with a template
1. Choose New Site from the File menu.

NetObjects Fusion displays the New Site dialog box.

2. Enter a name for the site in the Site Name field.

The site name serves as the file name for storage. It is also the name of the subfolder that stores 
the NetObjects Fusion site (.nod) file and the assets for the site.

3. Select the AutoSites option    and choose a template from the list.

This list presents the .nft files found in the AutoSites folder. To use a template stored elsewhere,
select Other Template and browse for the file.

4. Select an AutoSite or page template from the displayed list.

5. To save the site file somewhere outside the NetObjects Fusion 2.0 folder, click the Change… 
button to choose another location.

6. Click OK.

NetObjects Fusion creates a folder containing a new .nod file in the folder identified at the bottom 
of the dialog. The default location is NetObjects Fusion 2.0\User Sites\your site 
name.

The Site view opens, displaying the page icons of the site (or a single page icon if you selected a 
Page Template).

You can now modify the site’s structure by adding, deleting, moving, and renaming pages.

Note: The first time you work with an AutoSite or Page Template, you should explore the individual 
pages in the Page view before you delete or rearrange them.



Starting with an Imported Site
The New Site dialog also offers the option of starting with an imported site. If you are new to NetObjects 
Fusion, this can help you carry forward any sites you might have created elsewhere. 

1. Choose New Site from the File menu.

NetObjects Fusion displays the New Site dialog box.

2. Enter a name for the site in the Site Name field.

3. Click either the Local or Remote Site Import option, then click OK.

One of two dialogs appears. They are identical except for a Home Page field.

4. For a local site, enter the path to the site’s home page and its domain name. For a remote site, 
enter the site’s URL and make sure your Internet access is active.

When importing a local site, NetObjects Fusion needs the domain name to resolve relative vs. 
hard-coded path names.

5. Choose whether to convert the imported pages to NetObjects Fusion format.

When you convert pages to NetObjects Fusion format, NetObjects Fusion places their content in 
the Layout area of the corresponding new NetObjects Fusion page. The MasterBorders of each 
new page have the characteristics of the NetObjects Fusion 2.0\Templates\
Autosites\Import\import.nft template. 

When the import is complete, you will be able to edit the imported pages in Page view as you 
would any page you create in NetObjects Fusion. For example, you can edit the default 
MasterBorder and see the changes reflected on all pages or create and assign a new 
MasterBorder to different pages as needed.

When you do not convert the imported pages to NetObjects Fusion format, NetObjects Fusion 
imports all the site section’s assets and marks each page as External HTML. It does not add 
SiteStyles or MasterBorders and thus preserves the appearance of each page. You can manage 
the page’s location in the site as you would any other page even though its icon appears shaded 
in Site view. However, you cannot edit an external page in Page view; a large X covers the page. 

If you double-click the X, the HTML of the external page appears for editing in the default HTML 
editor selected in the Preferences dialog. If later you decide you want to edit the page in Page 
view, you can use the Import Page command, which makes the page internal and adds 
MasterBorders and a SiteStyle.



6. Choose the maximum number of pages to import.

NetObjects Fusion starts with the site’s Home page and stops importing when it reaches the end 
of the site or completes the number of pages you specify.

7. Choose how many levels to import.

NetObjects Fusion imports as many pages as possible at a higher level before going to a lower 
level.

8. Click OK.

NetObjects Fusion imports the number of pages you specified from the site. Complex pages take 
longer to import. If you have chosen not to convert the pages to NetObjects Fusion format, the 
pages are stored in NetObjects 2.0\User Sites\Site Name\Import\
www.domain.com.

9. If you selected the Convert pages to NetObjects Fusion format option, switch to Page view and 
verify that each page appears as you expect. 

Some pages will convert more accurately than others, and pages with frames will not convert. 
Check your pages carefully and make sure no imported objects are overlapping by choosing 
Select Overlapping Elements in the Page view Page menu. Adjust font size and style if needed, 
and add NetObjects Fusion navigation bars and banners as appropriate to your design.

NetObjects Fusion imports all assets such as Java applets, Shockwave, and other rich media. If 
you have converted to NetObjects Fusion format, these should appear in place in Page view. It 
does not import client-side image maps or manage server-side resources. This means that if the 
imported site used a resource on its server such as a CGI script, you must manually set up your 
server with those resources.



Adding, Deleting, and Moving Pages
You modify the structure of a site by adding, deleting, and moving pages in Site view. NetObjects Fusion 
automatically changes the links between pages when you modify the structure.

You can add, delete, and move pages at any time.

You can change a page’s location in the hierarchy by dragging its page icon to a new location. Child 
pages of a dragged page are moved along with the parent page.



Adding a Page
1. In Site view, select the page you want to be the parent of the new page.

2. Click the New Page button in the control bar, press the insert key, or choose New Page from the 
Edit menu.

The new page appears just beneath the page you selected. The new page is named “Untitled.”

You can create as many new pages as you like.



Deleting a Page
1. In Site view, select the page you want to delete and choose Delete Page from the Edit menu (or 

press the Delete key).

2. Click Yes to confirm the deletion.

Any child pages of a deleted page are also deleted.



Moving a Page
1. In Site view, select the page you want to move by clicking it.

2. Drag the page to its new location.

A moved page will be either a sibling or a child of a target page.

As you drag the page, NetObjects Fusion highlights the target page in a red border and shows 
whether it will be a child or a sibling page by a red triangle on the border.

· A triangle pointing to the side of the target page shows it will become a sibling of the 
target page.

· A triangle pointing to the bottom of the target page shows it will become a child of the 
target page. 



Renaming a Page
You rename a page to give it an appropriate title, clearly suggesting its contents.

When your site is published, the page names are used as HTML filenames for the pages. All spaces and 
non-alphanumeric characters except periods (.), hyphens (-) and underscores (_) are automatically 
converted to underscores (_) when previewed, staged or published. 

By default, banners and navigation buttons use the page name. You can specify different names to be 
used for your title, banner, navigation buttons, and HTML file extension by clicking the Custom NamesÉ 
button in the Page tab of the Properties palette.

If you give two pages the same name, NetObjects Fusion adds a numeral to the filename when it creates 
the HTML files. For example, if you have two pages named “Great,” upon previewing or publishing, 
NetObjects Fusion creates great.html and great1.html. 

To rename a page
1. In Site view, select the page you want to rename.

2. Change the name directly on the page icon or in the Name field in the Page tab of the Properties 
palette.

· To change the name on the page icon, click the page name text so that it becomes 
highlighted. Then edit the name.

· To change the name in the Name field in the Page tab, click the page icon to select it. 
Then edit the name in the tab.

3. When you are finished, click anywhere outside the page icon, or press the Enter key.



Specifying Custom Page Names
1. In Site view, select the page you want to reference by a custom name.

2. On the Page tab, click the Custom Names... button.

· If you want the filename of the HTML file for this page to have a custom name, type it as 
the Title.

· If you want all automatic navigation buttons that reference this page to display a custom 
name, enter it as the Button name. 

· If you want the banner for this page to display a custom name, type it as the Banner 
name.

· To assign a different extension to the HTML file for this page, enter it as the Extension. 
For this page only, this overrides the extension specified in your Publish settings’ 
Configure Publish dialog.

3. When you are finished, click OK.



Changing Page Properties
The properties associated with each page are in the Page tab of the Properties palette in Site and Page 
view. They also appear in the Site Management table in the Site Outline, giving you a powerful way to 
manage site development.

Use the Page tab settings to assist you in developing a site. For example, you can color-code your site 
structure display by assigning different colors to page icons. This can help you distinguish between 
different sections at a glance. You can instruct NetObjects Fusion to publish or not publish a particular 
page. You can note whether a page is done or not, and combine this information with a comment 
explaining the status in detail.

The page properties are as follows:

· Page Name. The name assigned to the page. You can rename a page at any time. For information on 
Custom Names, see Renaming a Page.

· Page Type. Shows whether the page is a normal page or a stacked page. Stacked pages are created 
when you use a data list. For information about stacked pages, see About Data Publishing.

· Page Color. Use Page Color to set the color of individual page icons in the Site view. Colors can help 
you visually group pages for various purposes, such as indicating which are finished or which have 
been assigned to a particular author.

· Status. Lets you set Done and Not Done indicators, a convenient way to manage individual pages in a 
large site. This setting is for information only, and has no effect on the functioning of the site. It can be 
used in conjunction with the Comments field. The page icon displays a check mark symbol when you 
have selected “Done.”

· Publish/Don’t Publish. This setting allows you to publish some pages, while retaining others which 
might be under construction or private. The page icon displays a red bullet symbol when you have 
selected “Don’t Publish.”

A page that is designated “Don’t Publish” can still be previewed as an individual page, but it is removed
from the navigation bars of other pages in the site and any text links to it are also broken. No HTML is 
produced for these pages during the staging and publishing process.

· Comments. Use the Comments area to enter notes to yourself or your coworkers about the status or 
content of individual pages.



Exporting a Site as a Template
You can save any site as a template in order to use its style or content in another site. If you use the 
template when you create a new site, any pages subsequently added to the site will take on the SiteStyle 
of the template. If you use the template to transfer pages to another site, the transferred pages will take 
on the SiteStyle of the other site. If several people will be working on a site, you can design a page layout 
and style, save it as a template, and then distribute the template folder and let other contributors build 
their pages based on the original template. Template files have an .nft extension. To share a custom 
SiteStyle, you must distribute your style folder as well.

Note: All .nod files have absolute asset pathing information. This means that NetObjects Fusion finds all 
assets based on their exact address on your hard drive. Moving your document to another machine 
changes the address of your assets. All .nft files convert these absolute paths to relative paths. 
Therefore, saving a site as a template (.nft) is the only way to share sites with other NetObjects Fusion 
users. The templates you export from NetObjects Fusion version 2.0 can be imported only by other 
version 2.0 users. For more information, see Sharing NetObjects Fusion Site Files.

To export a site as a template
1. In the Site view, choose Export Template... from the File menu.

NetObjects Fusion displays a Select Folder dialog box. 

2. Select the folder in which you want to store the template file, and click OK.

Note: Do NOT save a template to the root of your hard disk. Always save it to a separate empty 
folder that you create first in the Explorer. Or to make your template appear in the list of AutoSites
available in the New Site dialog, choose the NetObjects Fusion 2.0\Templates\
Autosites folder.

NetObjects Fusion creates a new folder, using the site’s name as the folder name. Into this folder 
it places a template file with a .nft extension and an Assets folder containing all the assets of 
the site.

The current site remains open.



Importing a Template or Site
To add pages to your site that have already been developed elsewhere, you import them as a section. To 
import the contents of a single HTML file into a blank page, use the Import Page command in Page view, 
described in Importing Pages.

You can import any of the following: a Page Template, an AutoSite, a NetObjects Fusion template that you
or one of your colleagues has developed, or pages from an existing site stored either on your local disk or
on a remote server. 

Importing a NetObjects Fusion template is a way to consolidate distributed work, as when several people 
develop different parts of a site. When you import a template, all imported pages take on the SiteStyle of 
the current site. So, when each person saves his or her work as a template and all the templates are 
imported into a single site for publishing, the published site will have a consistent look and feel overall.

With NetObjects Fusion 2.0, you can import templates exported from any version of NetObjects Fusion. 
When you insert a 1.0 template into a 2.0 site, some features are automatically converted. For example, 
headers and footers are converted to MasterBorders. 

Importing pages from an existing site can help you take advantage of work you’ve already done. For 
example, if you are new to NetObjects Fusion, you can import sites you might have created using other 
tools. Be aware that importing a complex site might take more processing time than you expect. If you 
created the site in NetObjects Fusion, it is far more efficient to import it as a template than to import the 
published HTML pages.



Importing a Template
1. In the Site view, select the page under which you want to insert the template.

The selected page will be the parent of the imported page or pages.

2. Choose Import Section... from the File menu.

3. To import a page template, select it from the list.

4. To insert an AutoSite or a template you or one of your colleagues has developed, click the Other 
Template option and the BrowseÉbutton. Select the template you want and click Open.

5. Click OK in the Import Section dialog.

The page or pages you imported appear in the Site view, and are completely stored within your 
current site. The original template is still available in case you need to use it elsewhere.

Note: When choosing to insert a template, remember that it begins with a single root page, which was the 
Home page in the site from which it was exported. This is not a problem if you are adding the template as 
a branch to your site. But if you want the Home page of your site to look like the Home page of your 
template, open a new site based on the template rather than importing it.



Importing an Existing Site
1. In the Site view, select the page under which you want to insert the site.

The selected page will be the parent of the imported page or pages.

2. Choose Import Section... from the File menu.

3. Click either the Local or Remote Site Import option, then click OK.

One of two dialogs appears. They are identical except for the Home Page field.

4 For a local site, enter the path to the site’s home page and its domain name. For a remote site, 
enter the site’s URL and make sure your Internet access is active.

When importing a local site, NetObjects Fusion needs the domain name to resolve relative vs. 
hard-coded path names.

3. Choose whether to convert the imported pages to NetObjects Fusion format.

When you convert pages to NetObjects Fusion format, NetObjects Fusion places their content in 
the Layout area of the corresponding new NetObjects Fusion page. The MasterBorders of each 
new page have the characteristics of the current site’s default MasterBorders. When the import is 
complete, you will be able to edit the imported pages in Page view as you would any page you 
create in NetObjects Fusion. For example, you can edit the default MasterBorder and see the 
changes reflected on all pages or create and assign a new MasterBorder to different pages as 
needed.

When you do not convert the imported pages to NetObjects Fusion format, NetObjects Fusion 
imports all the site section’s assets and marks each page as External HTML. It does not add 
SiteStyles or MasterBorders and thus preserves the appearance of each page. You can manage 
the page’s location in the site as you would any other page even though its icon appears shaded 
in Site view. However, you cannot edit an external page in Page view; a large X covers the page. 
If you double-click the X, the HTML of the external page appears for editing in the default HTML 
editor selected in the Preferences dialog. If later you decide you want to edit the page in Page 
view, you can use the Import Page command, which makes the page internal and adds 
MasterBorders and a SiteStyle.

3. Choose the maximum number of pages to import.

NetObjects Fusion starts with the site’s Home page and stops importing when it reaches the end 
of the site or completes the number of pages you specify.

7. Choose how many levels to import.

NetObjects Fusion imports as many pages as possible at a higher level before going to a lower 
level.

8. Click OK.

NetObjects Fusion imports the number of pages you specified from the site. Complex pages take 
longer to import. If you have chosen not to convert the pages to NetObjects Fusion format, the 
pages are stored in NetObjects 2.0\User Sites\Site Name\Import\
www.domain.com.

9. If you selected the Convert pages to NetObjects Fusion format option, switch to Page view and 
verify that each page appears as you expect. 

Some pages convert more accurately than others, and pages with frames will not convert. Check 
your pages carefully and make sure no imported objects are overlapping by choosing Select 
Overlapping Elements in the Page view Page menu. Adjust font size and style if needed and add 
NetObjects Fusion navigation bars and banners as appropriate to your design.

NetObjects Fusion imports all assets such as Java applets, Shockwave, and other rich media. If 
you have converted to NetObjects Fusion format, these should appear in place in Page view. It 



does not import client-side image maps or manage server-side resources. This means that if the 
imported site used a resource on its server such as a CGI script, you must manually set up your 
server with those resources. 



Sharing NetObjects Fusion Site Files
You might need to share your site files with others who are using NetObjects Fusion on other hardware 
platforms or who are using current or previous versions of NetObjects Fusion.

NetObjects Fusion 2.0 is compatible with any data files created with a previous release of NetObjects 
Fusion. When you open a file created with NetObjects Fusion 1.0, NetObjects Fusion 2.0 offers you the 
opportunity to make a backup copy of the original file before proceeding. Once NetObjects Fusion 2.0 has
opened a 1.0 file, the resulting file is not backwardly compatible and can no longer be used with 
NetObjects Fusion 1.0. 

You cannot insert an AutoSite template created in NetObjects Fusion 1.0 into NetObjects Fusion 2.0. To 
make a 1.0 template insertable in 2.0, you must first open a new site based on the 1.0 template in 
NetObjects Fusion 2.0. Then create a new template using the Export Template menu command in the File
menu. Move the new template to \NetObjects Fusion 2.0\Templates\Autosites\ where you 
can access it as you would any other 2.0 template.

To share sites among NetObjects Fusion 2.0 Windows and Macintosh users, you must save the sites as 
templates. Because of relative assets paths and hard disk naming conventions, you cannot simply open 
an .nod file created by a NetObjects Fusion 2.0 user on another computer.

Saving your site as a template collects all the assets external to your site and puts them in a folder called 
Assets. This process also updates the assets’ paths within your site file. The Assets folder must be 
maintained and cataloged by NetObjects Fusion, which updates associated HTML files. Do not manually 
add or delete files from the Assets folder.

Note: If the site that you save as a template has an internal data object in it, the data will NOT transfer if 
you import the template into a new site. Any data stored in internal data objects is lost.    



Sharing a Windows File with Another Windows User
1. On the source PC, open the NetObjects Fusion site file (.nod) using NetObjects Fusion 2.0 for 

Windows.

2. In the Site view, choose Export Template from the File menu.

3. Select a location to save your template and click OK.

4. Click OK to confirm the save.

After your template has been saved, a folder is automatically created using the same name as 
your original (.nod) file. The template file (.nft) appears in the folder along with an Assets 
folder.

Note: Once the template has been saved, do NOT change its folder name or the names of any 
files it contains.

5. Copy the new template folder to the NetObjects Fusion 2.0\Templates\AutoSites 
folder on the destination Windows machine. If you need to copy the template folder to a network 
server first, make sure that the folder and filenames are not truncated or changed in the process.

6. Start NetObjects Fusion 2.0 for Windows on the destination machine.

7. Choose New Site from the File menu.

NetObjects Fusion displays the New Site dialog box.

8. Select AutoSites from the Templates drop-down menu.

9. Select the template, by name, from the displayed list.

10. Enter a name for the new template in the Site Name field and click OK.

The site that was created in NetObjects Fusion 2.0 on the source PC is now a .nod file on the 
destination PC.

Note: If your source site included a custom SiteStyle, you will need to copy its folder from the Styles 
folder on the source PC to the Styles folder on the destination PC, then import it as described in Using 
Styles.



Working with a Site
The Site view lets you work with the structure of your site: how you arrange its pages into sections.

When working with the structure, you can use the Zoom Out tool to get an overall view of larger sites. 
When the view is zoomed out, you can continue to change the structure by dragging pages. To bring 
forward a smaller part of the site, use the Zoom In tool. The site zooms in on the page you click with the 
Zoom In tool. 

The Site tab of the Properties palette displays site information: the site name, date created, date last 
modified, and the number of pages in the site. When you enter an author name, NetObjects Fusion 
includes it in an HTML Meta tag that appears in each page’s file when the site is published.



Setting Structure Orientation and Background Color
Depending on your preferences and the way you distribute windows on your screen, you may want to 
look at the site structure horizontally or vertically. You can also change the background color for the Site 
view.

In Site view, change the Site view orientation and background color in the View tab of the Properties 
palette.



Expanding and Collapsing the Site Structure
NetObjects Fusion lets you expand and collapse the child pages so that you can display only the page 
icons you want to see. The Outline and Structure views both display the same expanded and collapsed 
pages. So if you change which child pages are hidden and shown in one view, the other view reflects your
changes. See Site Management Information for a description of Outline view.

In Structure view, page that has one or more hidden child pages displays a plus symbol beneath the page
icon.

· To expand the display to see child page icons, click the plus symbol.

· To collapse the display of child pages, click the small triangle beneath the parent’s page icon.



Printing the Site Structure
In Site view, the PrintÉ command on the File menu prints your site structure. To print the entire site, select
the home page before choosing Print. To print a section of the site, select the top-level page of the section
you want to print. When you print, the hard copy shows the same magnification, colors, orientation, and 
expanded or collapsed child pages as you see on the screen. 

Options in the Print dialog let you print the entire structure, or just the selected page and its children. A 
Print To Fit option in the Print Settings dialog reduces the site structure image to fit on your page. 

The printout’s footer automatically includes the author name, number of site pages, and the date last 
modified. 



Working with the Outline
The Site view offers an Outline option. Like the Structure view option, Outline view lets you expand and 
collapse your site structure level by level. However, it lets you see all pages’ site management information
at once, giving you an instant overview of site status. You can sort pages by information type such as the 
names of child pages, page type, status, and comments, so you can quickly identify pages with common 
characteristics.

To see the site in outline
· Click the Outline View button in the control bar.

NetObjects Fusion displays the site in outline form, with additional information about the selected 
page’s child pages.

The Outline view uses three page symbols. 

· A plus sign indicates a collapsed page that contains hidden child pages.

· A minus sign indicates an expanded page; child pages are visible.

· No sign means there are no child pages.

You can expand and collapse each section of your site to see all, a few, or none of the pages in the 
hierarchy.

· To expand a level, click the small plus symbol to the left of a contracted page.

· To collapse a level, click the small minus symbol to the left of an expanded page.



Site Management Information
The columns on the right side of the outline in Site view provide information about pages that you can use
to manage your site. They display information about the child pages of the selected page. If the selected 
page has no child pages, the information displayed is about the selected page.

· Child Name. Displays the names of the child pages of the selected page.

· Page Type. Shows whether the page is a normal page or a stacked page.

· Status. Shows whether the page has been declared Done or Not Done.

· Publish. Shows whether the page has been assigned to be published.

· Comments. Displays comments entered about the page.

To sort the display
· Click the column heading of the column you want to use to sort the list.

For additional information about managing your site, see About Assets View.



About Page View
The NetObjects Fusion Page view is a graphical, draw-based layout editor. This view gives you drag-and-
drop control to author your pages with pixel-level accuracy. You can place elements anywhere on a page 
and NetObjects Fusion will generate an HTML Web page that preserves its precise position.

Your pages will retain their NetObjects Fusion layouts when visitors view your site with Netscape 
Navigator 2.01, Microsoft® Internet Explorer™ 2.1, or any later versions. However, other browsers may 
display your site differently. Because NetObjects Fusion generates HTML tables for each page of your 
site, it requires a tables-capable browser such as these.



Working in the Page View
There are four ways to open the Page view for the page selected in Site view:

· Double-click a page icon in the Site view.

· Click the Page button in the NetObjects Fusion control bar.

· Choose Page from the Go menu.

· Press Ctrl-2.



Page View Workspace
The Page view has two distinct workspace areas: the MasterBorders area and the Layout area of the 
page. The MasterBorders area represents the page margins, and the Layout area is the body of the page.

The Page view also provides a separate Tools palette and Properties palette for working with content 
elements. Content elements are the text, graphics, and other items that you place on your pages. For 
accurate placement of elements, NetObjects Fusion can display grid or guide lines.

The Properties palette controls the attributes of your page and its elements. The palette has four basic 
kinds of tabs:

· The View tab controls the way the Page view is displayed. It does not affect the page you are editing.

· The Page tab is identical to the Page tab you see in the Site view, and it controls the general attributes 
of each page.

· The Layout tab is for creating and modifying page layouts. This tab is described in Working with 
Layouts.



· The tab for the selected element. The properties palette is context-sensitive and displays a tab based 
on the content element you select.



Setting the View Properties
The View tab controls the measurement units, the page grid and guides, and the display of element 
borders, links, and anchors.

When you are placing elements on a page, you’ll use the following features to achieve an accurate page 
layout:

· You can set the measurement unit for the page to Centimeters, Inches, Points, or Pixels.

· Use the page grid to align your layout and gauge the distances between content elements. You can set 
the grid size, and display or hide the grid. 

· Use the page guides to help align objects vertically and horizontally. You can drag page guides and 
display or hide them. 

· To hide all grid and guide lines, including MasterBorder boundaries, select None in the Grid/Guides 
section.

· Use the Snap feature to align elements exactly on grid lines, guide lines, or flush with other objects.

· Select the Show Element borders check box to display element boundaries so you can control element 
size and position. 

· Select the Show Element Icons check box to display small icons indicating where links, anchors, 
scripts, and HTML tags exist on a page.

Link icon. The element has an associated link. Does not appear in text links.

Anchor icon. The element has an anchor point inserted here, to which you can link.

Script icon. The element has an associated script.

HTML tag icon. The text element has an HTML tag inserted at this point.

The View menu also helps you control various aids in Page view. You can open or close the Tools and 
Properties palettes; and show or hide element borders or element icons. With the Page Labels command,
you can also show and hide the labels and margin lines for the Layout area and MasterBorders. The 
Layout Only command hides the MasterBorders area, which can improve performance.

The page grid, page guides, element borders, and element icons are aids for page editing, and do not 
appear as part of your published pages.



Setting the Page Properties
You use the Page properties tab in the Page view to control the name, color, and status of the current 
page, just as you do in Site view. For information on using the Page Properties tab, see Changing Page 
Properties.



The Page Tools
The Tools palette contains 15 basic tools for creating, editing, and manipulating different types of content, 
including interactive and multimedia elements. When you select certain tools, a group of secondary tools 
appears, each performing a different function on the same type of content element.

Page Tools Palette



The Control Tools
The three control tools are identical to the ones you saw in the Site view. In Page view, they control any 
element on a page, plus your overall view of your work.

Selection. Use the Selection tool to select, move, or resize content elements. Click an object to select it, 
drag to move it, or drag the handles of its bounding box to resize it. You can select multiple elements by 
dragging a selection box around them, or by holding down the Shift key while you click them one at a 
time. You can also deselect one element at a time by holding down the Shift key while you click the 
element. This is the default tool; NetObjects Fusion automatically reverts to it when you finish using any 
other tool in the palette.

Zoom In. Click anywhere in the page window with the Zoom In tool to magnify the workspace. Zoom In 
magnifies everything on the page.

Zoom Out. Use the Zoom Out tool to reduce the view. Zoom Out shrinks everything on the page.



The Content Tools
Each content tool inserts a different type of content element. You can place content elements anywhere 
on a page because the Page view is draw-based. This means that each element is placed in a bounding 
box and that box can be resized and positioned.

Each content element is documented in detail in the appropriate topic.

Text. Create a text box, then type to insert text, or use the Edit menu to paste text inside it. Use the Text 
properties tab to format your text just as you would in a word processor.

Picture. Use the Picture tool to insert and format image files. With the picture in place, you can create an 
imagemap that links parts of the image to other Web pages, or select one color in the image as 
transparent. The Picture tool contains five secondary tools:

Picture (default). Drag a box to contain the picture you select in the Image File Open dialog. The box 
automatically adjusts to the size of the image.

Transparency Color. Click a point on a GIF image that contains the color you want to be transparent. 
In a browser, pixels of that color will be suppressed, so that the background shows through.

Rectangular Hotspot. Draw and link a rectangular hotspot on a picture to turn it into an imagemap.

Elliptical Hotspot. Use this tool to create circular or elliptical hotspots for imagemaps.

Polygon Hotspot. Create hotspots of any multisided shape using this tool.

Draw. Use the Draw tool to create your own geometric shapes. When you use this tool in combination 
with its properties tab, you can add text and color to your shapes. The Draw tool contains six secondary 
tools:

Rectangle. The Rectangle tool draws four-sided polygons of any dimensions.

Rounded Rectangle. This tool creates four-sided polygons with rounded corners.

Ellipse. Draw circles and ellipses on your pages.

Rule. Draw a horizontal line that will be displayed in the browser as an HTML rule

Polygon. You can draw any closed, multisided shape. Once the shape is drawn, you can edit it by 
dragging its vertices.



Line. Draw straight lines of any length, color, or angle Add line head and tail styles.

Table. Web tables are similar to the tables you create in any word-processing program to display 
information.

Navigation Bar. Insert horizontal or vertical navigation bars or banners. The Navigation tool contains four
secondary tools:

Banner. Draw a rectangle to contain a horizontal banner image.

Vertical Banner. Draw a rectangle to contain a vertical banner image.

Navigation Bar. Draw a rectangle to contain a horizontal button bar.

Vertical Navigation Bar. Draw a rectangle to contain a vertical button bar.

Rich Media. Insert sound, video, and animation into your site. The Rich Media tool contains three 
secondary tools:

Sound. Draw a bounding box in which to place an icon as a visual placeholder for an audio file. In the 
final, published Web page, site visitors can click the icon to hear the audio or play it inline.

Video. Like audio files, video files are not played until the site visitor clicks an icon for the file in a 
browser or clicks on them inline.

Shockwave. Macromedia¨ Shockwaveª for Director and Shockwave audio files bring your site to life 
with interactive animation and sound.

NetObjects Components. Add NetObjects Components to include interactive functionality and effects to 
your Web site. The NetObjects Components tool contains six secondary tools:

NetObjects Components (default). Choose from a list of installed components. NetObjects Fusion 
includes a time-based picture, a picture loader, or a rotating picture. You can also create your own mini-
application and add it to the list of NetObjects Components.

DynaButtons. Add Java-based buttons that have a dynamic state (mouse over, pressed, depressed). 



Use DynaButtons to give users direct feedback as they interact with your site, enhancing their 
experience as they navigate around it.

Ticker Tape. Add this Java-based applet that gives your Web site visitors a scrolling ticker tape 
message in an LED font.

SiteMapper. Add this advanced Java-based application that, at the click of a button, creates an instant 
map of your site to assist users in viewing and navigating in your site’s hierarchy.

Message Board. Add this full-featured bulletin board so your site visitors can post, read, and reply to 
messages.

AutoForm. Creates a Submit button and attaches a CGI (Common Gateway Interface) script 
automatically, so you can process your forms without editing scripts.

Java. Java applets are software programs that can add interactivity to your site. They are viewable with 
most current browsers.



ActiveX. ActiveX controls add programmability and interactivity to your Web pages, for browsers with 
Microsoft ActiveX support.

Data List. Use the Data List tool to insert a table of information that will be filled in with data either from 
NetObjects Fusion’s internal database or from an external database. The list automatically includes a row 
for each record in the data source. Each row presents a button that navigates to the record’s stacked 
page, which typically presents the record in full. Data lists and stacked pages are discussed in About Data
Publishing. The Data List tool has two secondary tools:

Data List (default). Use this tool to create a data list that will reference data stored either in NetObjects
Fusion’s internal database, or in an external database that is already referenced elsewhere in your site.

New External Data Source. Use this tool to create a data list that will reference data stored in an 
external source that is not yet referenced anywhere in your site.

Data Field. When designing a stacked page, use this tool to specify a location for each field. Data fields 
are discussed in About Data Publishing.

Forms. Forms let your site visitors enter data and send it to your Web server for processing. With forms, 
you can collect information from site visitors or allow them to request information from your server. The 
Forms tool has six secondary tools:

Button. This tool creates either a Submit button or a Reset button. A Submit button sends the contents 
entered into the form objects to the server after a site visitor has entered information. A Reset button 
clears the contents of the form to allow the visitor to start over.

Check Box. Check boxes let site visitors select one or more items from a group. A check box can 
either be checked or unchecked, and any number of them can be checked at the same time. 

Radio Button. Use radio buttons when you want site visitors to select only one item in a group. Radio 
buttons behave just like check boxes, except that only one radio button in a group can be checked at a 
time.

Edit Field. This tool creates a single line in which visitors can enter text for submission to your server.

Multi-Line Text. To provide a way for site visitors to enter more than one line of text, you can create a 
multiple-line text box of any size using this tool.

Combo Box. A combo box contains a list of items for site visitors to choose from. Combo boxes can be
displayed as a drop-down menu or a list box with a scroll bar.



Controlling Page Size
In NetObjects Fusion, page size is dynamic: your page can “grow” as you place elements on it. This is 
quite unlike a word processor or page layout program, where page size is fixed. In the latter, typically one 
of your first tasks is to specify the dimensions of your finished product—the printed page—either by 
choosing a standard size such as 8.5 x 11, or by entering custom dimensions for whatever paper stock 
your design requires. Any margin size you then choose will reduce the body area of the page.

Because Web pages do not require a physical existence to be effective, setting their size can be a more 
dynamic process. For example, sites typically include pages of different heights. NetObjects Fusion helps 
you take advantage of this flexibility by dynamically expanding each page’s size as needed to 
accommodate the elements you place on it.



Working with MasterBorders
NetObjects Fusion divides a page into two workspace areas: the MasterBorder area and the Layout area. 
A MasterBorder is an area you can define to extend in from the edge of a Web page, just as you would 
set a top, bottom, left, or right margin for a page to be printed by a word processor. With a single click, 
you can convert a MasterBorder margin to an AutoFrame, which lets your site visitor scroll the body of 
your page while elements in the AutoFrame, such as navigation buttons, remain in view for easy access.

The Layout area controls elements that are unique to your page. You can design a layout in Page view, or
instruct NetObjects Fusion to use an external HTML file for your page’s layout. Because many of your 
visitors probably have slow modem connections, NetObjects Fusion helps you evaluate your design so it 
can generate the most efficient HTML possible to limit display delays. And because you can’t depend on 
any two visitors’ browsers to display your design the same way, it helps you manage how browser 
variations impact your design. 

MasterBorders appear on the top, bottom, left, and right sides of the Layout area in Page view, and 
represent the top, bottom, left, and right margins of your page. You can set the size of each margin in the 
unit of measurement selected for the page. 

Like headers and footers in a word processing document, MasterBorders can display elements that you 
want to appear consistently on a number of pages, such as a company logo or call-to-action buttons. 
Typically they present navigation controls, but you can place any text or picture in a MasterBorder just as 
you do in the Layout area. 

You can give a set of top, bottom, left, and right MasterBorder margins a name, and then apply them to 
individual pages much as you would apply a named style to a paragraph. These MasterBorders make it 
easy to give a consistent look and feel to any number of pages in your site, whether they reside 
contiguously in a branch of your site or are sprinkled widely throughout your site structure.

When you make a change in a MasterBorder, NetObjects Fusion automatically makes that change on 
every page that shares that MasterBorder. In effect, left and right MasterBorders are like vertical headers 
and footers. Top and bottom MasterBorders replace the header and footer functions available in 
NetObjects Fusion 1.0. 



Creating and Modifying MasterBorders
You can modify a site’s default MasterBorders, or you can create your own MasterBorders. You can use 
multiple MasterBorders in your site. When you modify the MasterBorder on one page, NetObjects Fusion 
updates all pages whose layouts that use the same MasterBorder. This means any object you place in a 
border automatically appears on all pages with that MasterBorder. 

In a new blank site, the left MasterBorder contains graphical navigation controls, and the bottom 
MasterBorder contains text navigation controls. You can modify the default MasterBorder or create a new 
MasterBorder style from scratch.



Applying a Different MasterBorder to a Page
1. Navigate to a page where you want to apply a different MasterBorder.

2. Click inside the Layout area.

3. Select the MasterBorder you want from the MasterBorders list in the Layout tab of the Properties 
palette.

The margins of the page display the contents of the selected MasterBorder.



Modifying an Existing MasterBorder
1. In Page view, click inside any MasterBorder or in the grey area outside of the page.

The Properties palette displays the MasterBorders tab. The Name field shows the name of the 
MasterBorder assigned to the current page. If you have not changed the MasterBorder, this name
is “Default.”

2. In the Margins section, scroll or type to change the number of pixels for the Left, Right, Top, 
and/or Bottom Margin.

Note: When Auto-resize Margins is turned on in the Page tab of the Edit Preferences dialog, you 
can drag the margins to increase or decrease their size. When Auto-resize Margins is turned on, 
you can also place an oversized graphic element in the margin to automatically increase its size.

3. Use the Selection tool to arrange content elements, if necessary.

4. Delete unwanted content elements, if necessary.

5. Use the content tools to insert additional text or content.

The changes apply to all pages with the selected MasterBorder.



Creating a New MasterBorder
1. In Page view, click inside the Layout area of the page.

The Properties palette displays the Layout tab. The MasterBorders field shows the name of the 
MasterBorder assigned to the current page. If you have not selected a different MasterBorder 
from the MasterBorders list, this name is “Default.”

2. Click the New button.

NetObjects Fusion creates a new MasterBorder and names it Untitled 2, or the next number in 
sequence. 

Note: Each time you click the New button in the Layout tab, NetObjects Fusion creates a new 
untitled MasterBorder. You can ignore extra borders, or rename them in the MasterBorders tab for
use later. You cannot delete MasterBorders. 

3. Click inside the MasterBorder.

The Properties palette displays the MasterBorders tab. The Name field shows the name of the 
MasterBorder you just created—Untitled 2. 

4. In the Name field, type a name for your new MasterBorder.

5. In the Margins section, scroll or type to change the number of pixels for the Left, Right, Top, 
and/or Bottom Margin.

If Auto-resize Margins is turned on in the Page tab of the Edit Preferences dialog, you can drag 
the margins to increase or decrease their size.

6. Use the Selection tool to arrange content elements, if necessary.

7. Delete unwanted content elements, if necessary.

8. Use the content tools to insert additional text or content.

9. When done, click inside the Layout area to see the new MasterBorder listed in the Layout 
properties tab for this page.

The new MasterBorder can be used on any page. To do so, go to a page and click inside the Layout area,
then select your new MasterBorder from the MasterBorders list in the Layout tab of the Properties palette.



Importing MasterBorders
When you create a new site, NetObjects Fusion automatically creates a default MasterBorder for it. For 
example, the default MasterBorder for a new blank site contains three navigation aids: a banner showing 
the page name at the top, a graphical navigation button bar on the left, and a text navigation bar on the 
bottom. This is because they’re included in the default MasterBorder of the Blank Site template. 

Default MasterBorder

When you import a template, or create a new site based on a template, the new pages have the same 
MasterBorders as they did in the site from which they were exported (the source site). When you import, 
all MasterBorder styles that were present in the source site appear in the destination site. So, for 
example, unless you changed the name of the default MasterBorder style in either the source or the 
destination site, you will see Default listed twice in the list of MasterBorder styles available on the Layout 
tab of the Properties palette. In this case, it’s easy to determine which one is the site’s default: the site’s 
default is always the first one on the list, even if you edit its name.

When you create a new site based on imported pages, NetObjects Fusion bases the site on the Import 
template, whose default MasterBorders have the following widths in pixels: Top, 10; Left, 10; Right, 10; 
Bottom, 40. This means any new pages you create in the site will also initially have these margin widths, 
unless you edit the default MasterBorder.

In Site view, when you import HTML pages from a local or remote site, NetObjects Fusion gives each 
imported page the current site’s default MasterBorders. This means when you first view an imported page
in Page view, its size will be equal to the site’s default MasterBorders plus the size of the imported page.

NetObjects Fusion’s Page view supports two methods for adding HTML pages created in other 
applications: Import Page and External HTML. When you import a single HTML page using the Import 
Page command, NetObjects Fusion expands the Layout if needed to accommodate the imported page, 
but makes no adjustment to the page’s MasterBorders. When you specify that a NetObjects Fusion page 
should be replaced by an External HTML page by using the External HTML option on the Layout tab, 
NetObjects Fusion makes no adjustment to its own page size; it simply makes sure your site visitor will 
see that External HTML page in the browser. To learn how to set up an External HTML page in Page view,
see Using External HTML Files.



Using Navigation Button Bars
Navigation bars are rows or columns of buttons or text that are automatically linked to other pages in your
site. By default, every MasterBorder contains button and text navigation bars. You can use the Navigation 
Bar tool to add new ones.

A Navigation Button Bar

By default, button names are the same as the page name, unless you specified a custom name for 
buttons, as described in Renaming a Page.

The default style for buttons is determined by the SiteStyle you set in the Style view, described in About 
Style View. The SiteStyle button image is automatically distributed to the buttons throughout your site. 
You can change the button style for a button bar without changing the SiteStyle. 



Adding a Navigation Bar
1. In Page view, go to the page where you want to place the Navigation bar.

2. Click the Navigation Bar tool. 

3. From the secondary tool palette, click the Horizontal or Vertical Navigation Bar tool.

4. Drag a box in the MasterBorder or Layout area where you want to place the button bar.

A new graphical button bar appears, and the Properties palette displays the Nav Bar tab. The 
button bar contains the buttons indicated by the setting in the Display field of the Nav Bar 
properties tab.

5. Position the bar by dragging it with the Selection tool.



Setting the Display Level
1. In Page view, select the button bar, then click the Nav Bar tab in the Properties palette.

2. In the Display section of the Nav Bar tab, click the Set button.

The Nav Bar Display dialog appears.

3. In the Show section, set the navigation option for this bar:

· First Level generates buttons linked to the children of your Home page.

· Parent Level includes links to all pages in the level above the current page in the site 
structure.

· Current Level links the buttons to this page and all other pages on the same level with the
same parent page.

· Child Level generates links to the children of the current page.

Open the Site view if you are unsure which level of the site you want to link to.

4. Select Include Home Page to include your Home page as a link in this button bar. 

By default, Include Home Page is selected to provide quick access to the hub of your site.



Setting Button Type
In Page view, in the Buttons section of the Nav Bar properties tab, set whether the selected bar displays 
text or graphical buttons:

· To apply the primary button style for the current SiteStyle, select Primary Buttons. 

· To apply the secondary button style, select Secondary Buttons.

· For a text-only button bar, select Text. 



Setting Button Style
In Page view, in the Style section of the Nav Bar properties tab, select whether to use the current 
SiteStyle or a different style for the buttons in the selected button bar.

· To use the current SiteStyle, select Site Style.

· To use a different style, select Other Style, then select a style from the drop-down list box.

· To highlight a button when its page is open, select Use Highlighting.



Setting Button Spacing
In Page view, in the Display (in pixels) section of the Nav Bar properties tab, set the pixel size of the 
selected Navigation button bar border, and the spacing between buttons.

· To increase or decrease the Navigation bar border, scroll or type to enter a new number 
in the Border field.

· To increase or decrease the spacing between buttons, scroll or type to enter a new 
number in the Spacing field.



Setting Button Fill Background
In Page view, in the Fill Background section of the Nav Bar properties tab, set whether to use a 
background color in the selected Navigation button bar.

· To use a background color, click the Color button, select a color from the Color dialog, 
then click OK. 

· To use no background color, select None in the Fill Background section.



Changing the Image on a Particular Button
You might want to change the image on just one or two buttons in a Navigation button bar, instead of all 
buttons in the bar.

You can change the image on an individual button to a primary or secondary SiteStyle image, or to your 
own image.

If you are using a primary or secondary SiteStyle image, you can select the appropriate image file from 
the NetObjects Fusion folders.

If you are using your own image, you can select files in gif, jpg, bmp, pcx, and pct formats. Most Web 
browsers support images in gif or jpg format only, so if you select an image in one of the other formats, 
NetObjects Fusion will offer to convert it to gif or jpg for you. Your image should be an appropriate size 
for a button. 

1. In Page view, click the button you want to change.

The entire button bar appears selected.

The Properties palette displays the Button tab, which shows the name of the selected button. The
Picture field shows the path and name of its associated image file.

2. Click the Browse button.

The Image File Open dialog appears.

By default, the Folders tab shows the image file for the selected button, and possibly other image 
files for other buttons.

· To display the path to the current folder, Click the down-arrow in the Look in field.

· To find other button styles, look in NetObjects Fusion 2.0\Styles and view the 
folder for each NetObjects Fusion style. Open the folder for the desired style, then look in 
the Primary Buttons and Secondary Buttons folders for button image files. 

· To preview the button image, select Show thumbnail image, then click once on the image 
file to preview. A picture of the button appears.

· To show image formats other than GIF and JPG, select the formats you want to view from
the Files of type list box.

· To display all the image files associated with the current site, click the Image Assets tab. 

The Image Assets tab shows the NetObjects Fusion name and the Windows file name of 
each image file. Click the Name to preview the image.

The path appears in the File Path field. (Use the right-arrow key to scroll and view the 
whole path and name.)

3. When you have selected the button image you want to use, click the Open button.

The button changes to the selected image, and the file name is listed in the Picture field of the 
Button properties tab. 

Note: NetObjects Fusion creates a copy of the selected image, gives it a filename that includes 
both the site name and the pagename, and places it in the appropriate button folder of the 
button’s SiteStyle.



Using the Image File Open Dialog
You use the Image File Open dialog when you want to insert a picture, or change a banner or navigation 
button image. The default folder you see when you open this dialog depends on the object that is selected
when you open the dialog.

In general, use the Image File Open dialog like this:

· To display the path to the current folder, Click the down-arrow in the Look in field.

· To preview an image, select Show thumbnail image, then click once on the image file to preview. A 
picture of the image appears.

· To show image formats other than GIF and JPG, select the formats you want to view from the Files of 
type list box.

· To display all the image files associated with the current site, click the Image Assets tab. 

The Image Assets tab shows the NetObjects Fusion name and the Windows file name of each image 
file. Click the Name to preview the image.

The path appears in the File Path field. (Use the right-arrow key to scroll and view the whole path and 
name.)



Deleting a Navigation Bar
1. In Page view, select the Navigation bar you want to delete.

Be sure the bounding box handles are solid and not hollow.

2. Delete the Navigation bar using one of these methods:

· Choose Cut or Delete Element from the Edit menu.

· Press Ctrl-X.

· Press the Delete key.

· Right-click the navigation bar and choose Delete Element from the pop-up menu.

The Navigation bar disappears.

If you wish to undelete the Navigation bar, choose Undo from the Edit menu.



Using Banners
Banners are graphical title bars that display the title of the page, helping site visitors navigate your Web 
site. You can use the Navigation Bar tool to add new banners. 

A Banner

Banners are just like pictures, except that they contain the page names shown in Site view and listed in 
the Name field of the Page properties tab. 

By default, banner names are the same as the page name, unless you specified a custom name for the 
banner, as described in Renaming a Page.



Adding Banners
1. In Page view, go to the page where you want to place the banner.

2. Click the Navigation Bar tool. 

3. From the secondary tool palette, click the Horizontal or Vertical Banner tool. 

4. Drag a box in the MasterBorder or Layout area where you want to place the banner.

A new banner appears in the current SiteStyle, and contains the page name specified in the Page
properties tab. The Properties palette displays the Banner tab.

5. Position the banner by dragging it with the Selection tool, if necessary.



Changing the Banner Image
The MasterBorder includes a default banner that matches the current SiteStyle. You can change the 
banner style or use your own banner image. 

If you are using your own image, you can select files in GIF, JPG, BMP, PCX, and PCT formats. Most 
Web browsers support images in GIF or JPG format only, so if you select an image in one of the other 
formats, NetObjects Fusion will offer to convert it to GIF or JPG for you. Your image should be an 
appropriate size for a banner, and be able to accommodate the page name in text inside it. 

If you are using a SiteStyle image, you can select the appropriate image file from the NetObjects Fusion 
folders.

1. In Page view, select the banner you want to modify.

The Banner properties tab appears.

2. In the Picture section of the Banner tab, click the Browse button.

(You can also double-click the banner.)

The Image File Open dialog appears.

By default, the Folders tab shows the image file for each banner on the current page. For 
example, you might have two different banner images on a page.

· To display the path to the current folder, Click the down-arrow in the Look in field.

· To find other banner styles, look in NetObjects Fusion 2.0\Styles and view the 
folder for each NetObjects Fusion style. Open the folder for the desired style, then look in 
the Banners folder for the banner image file. 

· To preview the banner image, select Show thumbnail image, then click once on the image
file to preview. A small picture of the banner appears.

· To show image formats other than GIF and JPG, select the formats you want to view from
the Files of type list box.

· To display all the image files associated with the current site, click the Image Assets tab. 

The Image Assets tab shows the NetObjects Fusion name and the Windows file name of 
each image file.

· To view a file’s path or location, select it. The path appears in the File Path field.

3. When you have selected the banner image you want to use, click the Open button.

The banner changes to the selected image, and the file name is listed in the Picture section of the
Banners properties tab.

Note: NetObjects Fusion creates a copy of the selected image, gives it a filename that includes 
both the site name and the pagename, and places it in the Banners folder of the banner’s 
SiteStyle.



Changing the Banner Style
1. In Page view, select the banner you want to change.

2. In the Style section of the Banner properties tab, select a SiteStyle from the Other list.

The selected banner changes to reflect the new style.

To return the banner to the style selected for the site, click the Site Style button.



Deleting Banners
1. In Page view, select the banner you want to delete.

2. Delete the banner using one of these methods:

· Choose Cut or Delete Element from the Edit menu.

· Press Ctrl-X.

· Press the Delete key.

· Right-click the banner and choose Delete Element from the pop-up menu.

The banner disappears.

If you wish to undelete the banner, choose Undo from the Edit menu.



Using AutoFrames in MasterBorders
A frame is an area of a page that contains content independent from the rest of the page. When a site 
visitor scrolls another part of the page, the frame content does not move. 

NetObjects Fusion 2.0 supports two types of frames:

· AutoFrames

· Scripted frames

The NetObjects Fusion AutoFrames feature lets you add frames to MasterBorders with a single click. As 
with MasterBorders, you can add navigation controls, banners, text, graphics, and links to frames, just as 
you normally do. You can also add scroll bars to frames, so site visitors can view more information than 
currently appears on the screen. Links within a frame can display a page, or display information within the
frame or in a different frame. The easiest and most convenient way to create frames is by using the 
AutoFrames feature.

NetObjects Fusion also provides a scripting interface that lets you manually code frames using the HTML 
page description language. This method requires knowledge of HTML codes and the NetObjects Fusion 
script interface.

Links within a frame can display a page, or display information in the same frame or a different frame. 
Frames can also reduce the amount of refreshing your visitor’s browser must do. To learn how you can 
take advantage of these frame features using AutoFrames, see Behind the Scenes with AutoFrames.

Within a frame, you can influence how variations in browser fonts affect your design using the Rows and 
Columns option on the Frame properties tab. These options work within a frame the same way they do 
within a layout.

Although Netscape Navigator and Microsoft Internet Explorer support frames, not all browsers do. If you 
use frames, you might need to create an alternate site for visitors with browsers that do not support 
frames. Site versions are described in About Publish View.



Adding AutoFrames
1. In Page view, click an empty space inside a MasterBorder. 

The Properties palette displays the MasterBorders tab.

2. In the AutoFrames section, click the icon for the border where you want to place the frame—Left, 
Right, Top, or Bottom. 

The frame automatically occupies the entire border area, up to the next overlapping frame, if one 
is present. 

When you create a top or left frame, consider the elements you want to add to it. At the upper-left 
corner of a page created with NetObjects Fusion defaults, no boundary line exists between the 
top and left MasterBorder margins. This lets you place elements that extend into both the top and 
left margins. If you convert either the top or left margin to an AutoFrame, this benefit is lost. You 
must place elements within one AutoFrame or the other because elements cannot straddle 
AutoFrame boundaries.

Note:  The order in which you turn on each frame determines the order in which the 
MasterBorders overlap each other when viewed in a Web browser. To check the sequence, look 
at the numbers in parentheses next to Left, Right, Top, and Bottom on the MasterBorders 
properties tab. You can change the order by turning a frame off, then turning on a different frame 
first.

If the margin is wide enough, a red label such as “Left Frame” appears inside the new frame, and 
the grey margin line changes to red, indicating a frame is present. The Properties palette displays
the Frame tab, showing a name such as Left Frame in the Frame Name field.

3. To view the properties of the frame, click the Frame tab.

It displays all the options for the frame. The Frame Name field presents a default name such as
Left Frame. 

4. To change the frame name, type a new name in the Frame Name field. 

Short names work best. NetObjects Fusion will include the frame name as part of the HTML 
filename for the frame in the form framename_pagename.html. 

A frame’s name becomes significant when you want the destination of a link to display in an 
AutoFrame. For more information, see AutoFrames and Links. 

You can set the frame background to the SiteStyle, change it to a color, or place a picture inside 
the frame. Small pictures are tiled to fill the frame. 



Setting the Frame Background
You can set the frame background to the SiteStyle, change it to a color, or place a picture inside the 
frame. Small pictures are tiled to fill the frame. 

1. In Page view, click inside the frame where you want to set the background.

2. In the Background section of the Frame properties tab, set the background options:

· To use the SiteStyle background, select Site Style Background.

· To use a color, select Solid Color, click the Color button, select a color from the Color 
dialog, then click OK. The selected color fills the frame background.

· To use a picture, click Picture. The Image File Open dialog appears. Select an image 
from your hard disk, CD-ROM, or Local Area Network (LAN), then click the Open button. 
The image, if smaller than the frame, is repeated to fill the frame.



Creating a Scrollable Frame
A scrollable frame appears in the browser with vertical and/or horizontal scroll bars, so the site visitor can 
display information that is not currently visible in the frame.

1. In Page view, click inside the frame where you want to set scrolling options.

2. In the User Scrollable Frame section of the Frame tab, set when to turn scroll bars on.

· To force vertical and horizontal scroll bars to appear in the frame, select Yes.

· To prevent scroll bars from appearing in the frame, select No.

· To display scroll bars when there is more information in the frame than can be viewed on 
the screen, select Auto. The browser will display scroll bars only when necessary.



Creating a User-Resizable Frame
When a frame is a fixed size, a site visitor with a small display might think it takes up too much screen 
space. With the User Resizable Frame option, you can allow the browser or your site visitor to stretch 
and/or resize the frame when necessary.

1. In Page view, click inside the frame you want to set.

2. In the Frame tab of the Properties palette, select the User Resizeable Frame check box.

If the option is not available, enable it by selecting the Generate HTML frame borders option in 
the MasterBorders properties palette. HTML borders must appear so that the site visitor can drag 
them to specify a new size.



Generating Frame Borders in Browsers
You can set NetObjects Fusion to create a rule line separating the frame and the Layout area when 
viewed in a Web browser.

1. In Page view, click inside the MasterBorder.

2. Click the MasterBorders tab in the Properties palette.

3. In the AutoFrames section, select Generate HTML frame borders.

When viewed in the browser, the frames on the current page will display rule lines.



Working with Layouts
A layout is the arrangement of elements in the Layout area of a page. A page’s layout controls elements 
that are unique to that page. A page can have one or several layouts. The layout that is “on top” is the one
that is in control and will be published. You might create several layouts per page for as you experiment 
with alternative designs, various prototypes, or for several versions of your site, such as English, French, 
rich media, and text-only. 

A new page has one “Untitled” layout. You select among a page’s various layouts and create new ones 
using the Layout menu next to the navigation buttons in the lower left corner of Page view. You can name 
your layouts individually using the Layout tab in the Properties palette. Other options for controlling layout 
characteristics are available in various locations.

· When the Page Labels option in the View menu is checked, the labels for and margin line between the 
Layout area and MasterBorders appear. 

· When the Auto-resize margins option is turned on in the Page tab of the Edit Preferences dialog, you 
can drag the margin lines to increase or decrease the Layout area.

· To automatically size the Layout area to the elements it contains, choose Size Layout to Elements from
the Page menu. The Layout area retains a size large enough to accommodate any elements in the 
MasterBorders. To enlarge the Layout later, reset the Layout Width and Height in the Layout properties 
tab, or drag the margins.

· To view the Layout area only, choose Layout Only from the View menu. Choosing this option also 
improves product performance. When in Layout Only mode, your MasterBorders are hidden but still 
preview. Choose Layout Only again to redisplay MasterBorders.



Creating a Layout
1. In Page view, arrange content elements on a page until you have a layout you want to keep.

2. Click the Layout properties tab.

3. In the Layout Name field, type a name for the layout.

NetObjects Fusion saves the layout for this page.

4. If you like, set the page width and height for this layout. You can set the unit of measurement 
(centimeters, inches, points, or pixels) in the View tab of the Properties palette.

You can either enter values or click the up or down arrows to increase or decrease the current 
value. A standard size is 640 pixels in width.

5. If you like, select a MasterBorder for the page. For information, see Working with MasterBorders.

6. In the Background section, set the background to be used in this layout:

· SiteStyle. SiteStyles include backgrounds. Select this option to use the default 
background specified by the SiteStyle selected in the Style view.

· Solid Color. Select this option and click Color... to select a solid background color. Solid 
backgrounds offer significantly faster download times than picture backgrounds.

· Picture. Browsers can display pictures as backgrounds by tiling them over the area of a 
page. Select this option and click Browse... to choose an image file for the background. 
For information about the Image File Open dialog see Using the Image File Open Dialog.



Adding Background Sounds
You can assign a sound to play when a site visitor views the page. You can use sound files in au, mid, 
midi, or wav formats. The sound can play once, or continuously.

For your site visitors to hear sounds, they need a sound board and speakers installed on their computer, 
and the browser they are using must be capable of playing sounds, either through a built-in player or a 
helper application on the visitor’s computer. For more information about using sound files, see Adding 
Rich and Interactive Media.

To add a background sound
1. In Page view, click the Layout area of the page where you want the sound to play.

2. In the Background Sound section of the Layout tab, click the Background Sound check box.

3. In the Background Sound dialog, type a path or click Browse to select a sound file from your hard 
disk, CD-ROM, or local area network (LAN). 

4. To make the sound repeat while the page is open, select the Continuous Loop check box.

5. Click OK.

The sound plays when you preview the page.



Arranging and Sizing Elements
You can align two or more elements on their left, right, top, or bottom, and you can center them 
horizontally and vertically. You can also make two or more elements the same height or width.

Note: The selected elements assume alignment or size of the last element you select.

· To align elements, select the elements you want to align, then choose an appropriate option from the 
Align Elements command in the Page menu. The elements align accordingly. To undo an alignment, 
choose Undo from the Edit menu.

· To make two or more elements the same height or width, select the elements, then choose Width or 
Height from the Size Elements command in the Page menu. 



Adding Layouts to a Page
1. Design a page using the Page view tools and procedures.

The default page layout name, “Untitled Layout,” appears in the Layout drop-down menu in the 
lower-left corner of the Page view window.

2. Choose Add... from the menu.

The Layout area becomes blank.

3. Type a name for the layout in the Layout Name field of the Layout properties palette.

4. Add content elements to the page.

5. If necessary, configure the page layout settings in the Layout properties tab.

The Layout drop-down menu always lists the layouts you’ve applied to the current page. Choose from this
menu to switch between layouts. 



Using Multiple Layouts
A single page can have multiple layouts for prototyping or publishing several versions of a page. Use the 
Layout drop-down menu in the lower-left corner of the Page view to choose the current layout and create 
additional ones. 

When you publish your site, NetObjects Fusion publishes the current layout selection for each page. 

The Layout Drop-Down Menu



Adding Assets Using Drag and Drop
You can drag image, text, sound, video, and other files from Windows Explorer and drop them onto your 
page in Page view. You can also drag text, images, and links from any Windows application such as 
Microsoft Word that supports drag and drop.

In general, you can drag in any kind of file you can place using a tool or command in Page view. Before 
you add a media file, consider whether its format is appropriate for the platforms and browsers you’re 
planning to support. 

You can drag and drop the following types of files:

· Image files in .gif, .jpg, and other common graphics formats. The image appears on the page. For
.bmp, .pct, and .pcx formats, NetObjects Fusion offers to convert the files into .gif and .jpg, so most 
browsers will be able to display them.

· Text files in plain text or ASCII format, such as .txt. The text appears in a text box on your page. 

· HTML files. Files with .htm or .html extensions are treated as external HTML files, and display the gray
crossed out page, indicating the original HTML format is preserved.

· Sound files in .aiff, .au, .mid, .midi, .ra, .ram, and .wav formats. The sound icon appears on the page.

· Video files in .avi, .mov, .qt, .mpg, .mpeg, .mpe, and .mpv formats. The video icon appears on the 
page.

· Shockwave files in .dcr format. The Macromedia image appears on the page.

· NetObjects Fusion Components in .nfx format. The component placeholder appears on the page.

· Java applets with the .class extension. NetObjects Fusion displays the Java applet image on the page.



About Using External HTML Files
You might want to add to your site an HTML file that you downloaded from a web site or created with an 
HTML editor. When you use the External HTML option in the Layout properties palette, NetObjects Fusion
replaces the current page with your selected external HTML file when you preview or publish your site. 
This option is useful when:

· You want to add an existing HTML page without converting it to NetObjects Fusion format

· You have created a special page with another tool, and prefer to maintain it with that tool

· You've created a page in NetObjects Fusion, want to directly edit its HTML, and do not want NetObjects
Fusion to overwrite your HTML changes next time you preview or publish.

Because external HTML files are not converted to NetObjects Fusion format, you cannot combine 
NetObjects Fusion page elements and external HTML files on the same page. 

For information on importing more than one HTML file from other sites, see Importing an HTML page. For 
information on importing text, Rich Text Format (RTF), and HTML files that are converted to NetObjects 
Fusion format, see Importing Pages.



Referencing an External HTML File
1. In Page view, go to the page you want to replace with an external HTML file.

2. Click the Layout area, and in the Layout properties tab, select the External HTML check box.

3. In the Open dialog, select a file with an HTM or HTML extension, then click the Open button.

The Layout and MasterBorders area displays a grey background with an X from corner to corner, 
to indicate that it has been replaced by an external HTML file. In Site view, the icon for this page 
is shaded.

The HTML page is displayed by the browser when you preview or publish the page. 

Note: You can toggle between internal layouts and external HTML files by clicking the External 
HTML check box in the Layout properties tab. This is useful when recreating pages in NetObjects 
Fusion. You can publish with a working external HTML file while designing your layout.

When you publish or stage, your external HTML pages are included in the my_html folder. Adding an 
external HTML page does not automatically bring in its assets. Make sure all assets used by your page 
are registered in the Assets manager. Otherwise, you must move them to the server manually. One 
shortcut to add all assets is to import the page as described in Importing Pages, then use the procedure 
above to cover the imported elements with the original HTML.



Editing an External HTML File
In Page view, double-click the grey area that covers the replaced page.

NetObjects Fusion launches the HTML editor specified in the HTML Editor field in the Page tab of the Edit
Preferences dialog.



Editing the HTML of a NetObjects Fusion Page
1. Create the page in NetObjects Fusion Page view.

2. Preview your site.

You must preview to compel NetObjects Fusion to create an HTML file for you to edit.

3. Back in Page view, click the Layout area, and in the Layout properties tab, select the External 
HTML check box.

4. In the Open dialog, navigate to your Preview folder, select the HTML file that NetObjects Fusion 
created for your page, then click the Open button.

5. Double-click the grey area that covers your page.

NetObjects Fusion launches the HTML editor specified in the HTML Editor field in the Page tab of 
the Edit Preferences dialog. Here you can tweak the HTML that NetObjects Fusion created for 
your page. Because you've made the page external, NetObjects Fusion will not update it and 
potentially overwrite your changes when you preview or publish.



Optimizing Your Layout
Two critical aspects of how your site visitor’s browser displays your layout are beyond your control: 
connection speed and text size. It’s likely that many of your visitors have slow modem connections, so 
you want your pages to use the most efficient HTML possible to limit display delays. Also, visitors might 
set their browsers to display text in a larger or smaller size, or in a different font. Differences in default font
sizes on different platforms, and differences in how browsers from different manufacturers display text 
create additional variations. For example, default browser fonts on a Macintosh are smaller than the 
defaults on a PC-compatible, and Microsoft Internet Explorer puts slightly more white space between lines
of text than Netscape Navigator does. Any of these variations can make a text block in your visitor’s 
browser larger or smaller than it appears when you’re designing a page in NetObjects Fusion’s Page 
view. 

To help your designs accommodate these visual and performance dynamics, NetObjects Fusion 2.0.x 
includes new controls for:

· Choosing a Preferred Table Structure for page elements, which helps control the layout when the site 
visitor’s browser is set to a larger font than you had planned

· Locking a Text Block's Minimum Size, which helps control the layout when the site visitor’s browser is 
set to a smaller font than you had planned

· Viewing the HTML Table Structure that NetObjects Fusion uses to describe your pages to the browser, 
which helps troubleshoot the efficiency of your layout

· Selecting Overlapping Objects to help identify problems in your layout



Choosing a Preferred Table Structure
NetObjects Fusion 2.0.x includes a new feature that lets you choose a relationship between text blocks 
and other elements on your page. You can specify whether it’s more important for elements to retain their 
alignment either vertically or horizontally. By default, NetObjects Fusion assumes vertical relationships 
are most important. So, for example, if your page has 10 pixels of white space between the end of a text 
block and a picture beneath it, NetObjects Fusion will set up the HTML for your page in a way that 
ensures that white space will always be 10 pixels, regardless of the size of the text in the browser. 
Examples in this topic illustrate this concept in more detail.

To specify the relationship, you’ll use the Table Structure options found on the Layout or Frame tab of the 
Properties palette, in Page view.    The two radio buttons are labeled Columns and Rows. 

· To maintain relative vertical positioning of text blocks and other elements, select Columns 

· To maintain relative horizontal positioning of text blocks and other elements, select Rows 

To understand how the Column and Row options work, consider this layout in NetObjects Fusion Page 
view:

Designer's layout of page as seen in NetObjects Fusion Page view

The two text blocks are aligned at the top, as are the pictures below them.    This alignment is maintained 
when you preview the site with a browser using the default font, as shown below:



Page generated with default Columns option shown with default font size selected in browser

This text is normal sized because the default proportional font and size settings of NetObjects Fusion 
match those of the browser.    However, your site visitor might be browsing from a different platform, or the
browser might be using a different proportional font.

The Row and Column options offer you more control for influencing what happens when a browser is set 
to display in a larger font.

The following shows what happens when a site visitor's browser font is set to a larger point size.    In this 
the default Columns option is selected.    Notice that the white space between each text block and the 
image under it stayed constant: they maintained their vertical relationship.    However, the tops of the two 
pictures are no longer aligned.



Page generated with default Columns option shown with larger font size selected in browser

The Columns option is recommended to ensure layout fidelity.    This option is selected by default.

The following illustration shows what happens if you select the Rows option.    Notice that the two pictures 
at the bottom of the page are side-by-side: they maintained their horizontal relationship.    However, 
additional white space appears under the right-hand text block.



Page generated with Rows option shown with larger font size selected in browser.

It's easy to experiment with this yourself.    Set up a page with relationships similar to those shown above, 
then preview the page.    If you're using Microsoft Internet Explorer 3, you can simply click the Font button 
on the main toolbar to increase and decrease the font size and to observe layout dynamics at different 
sizes.    If you're previewing in Netscape Navigator, you must choose Preferences from the Options menu,
select the Fonts tab in the dialog that appears, then choose a different font size using the Choose Font 
buttons.    In either case, choosing a different font size can show you how variations can affect your 
layout.    For example, choosing a smaller font in Microsoft Internet Explorer for Windows can simulate 
how the fonts will look in a Macintosh browser.

To view the current table structure, use the Show HTML Table button. See Viewing the HTML Table 
Structure for more information.

To adjust your text blocks for visitors browsing with smaller fonts, see Locking a Text Block's Minimum 
Size.



Viewing HTML Table Structure
To display your page with the greatest possible accuracy, the HTML file NetObjects Fusion generates 
describes your page using HTML tables. The more your design allows NetObjects Fusion to isolate text 
elements in table cells, the more efficient the HTML it generates will be, and therefore the more quickly 
your design will render in your site visitor’s browser. Viewing HTML table structure in Page view lets you 
see whether NetObjects Fusion can divide your layout into cells efficiently.

· To preview how NetObjects Fusion divides your page content into table columns and rows in 
Page view, press and hold down the Show HTML Table button on the Layout tab of the Properties
palette.

All grid or guide lines as well as element borders disappear temporarily while NetObjects Fusion 
draws lines that show where it is dividing the page into tables. 

When creating tables, NetObjects Fusion does its best to isolate text blocks from adjacent elements—
those on either side. This prevents text expansion and contraction from moving those adjacent elements 
up and down. Of course when text expands, elements below it must move down. But, according to 
whether you choose to emphasize vertical or horizontal alignment in the Layout tab of the properties 
palette, expanded text pushes down just the objects immediately below it (Columns option), or all objects 
below it (Rows option). The Rows and Columns options are described in Choosing a Preferred Table 
Structure.

Optimization works best when your design allows NetObjects Fusion to isolate text boxes using straight 
horizontal and vertical lines.

The Show HTML Table button can help you identify design problems. If you press the button and see that 
a text block is not isolated from its neighbors, adjust your design and view the result by pressing the 
button again. 

If elements still are not grouped as you want, consider that they might not be aligned with pixel accuracy, 
even though they appear to be perfectly aligned with the grid. To solve this, select the elements you want 
to group and choose from the Page menu either Align Elements Left or Align Elements Right, depending 
on which makes sense for your design.



Selecting Overlapping Objects
When your layout includes elements whose boundaries overlap, a browser cannot display the elements in
the positions you specified. If you preview your page and objects do not appear where you expect them to
be, you could have an overlap problem. 

In Page view, it might be hard to see where objects overlap if, for example, your design includes many 
elements or you have not enabled the Show Element Borders option on the View tab of the Properties 
palette. Here’s how to quickly identify overlapping elements:

1. In Page view, choose Select Overlapping Objects from the Page menu.

2. In the dialog that appears, note the number of overlap occurrences and dismiss the dialog.

3. Scroll through your layout and observe which elements are selected. Their overlaps are 
highlighted.

4. Move objects as needed to eliminate the overlaps.

5. Choose Select Overlapping Objects again to verify that you’ve corrected all the problems.



About Working With Text
This section tells you how to create text elements on your page, edit text, and work with paragraph styles.
It also tells you how to insert HTML tags and variables into your text.

For information on importing text, HTML or RTF (Rich Text Format) files, see Checking Spelling. For 
information on inserting links and anchors, see About Creating Links. 



Creating a Text Box
Use the Text tool to add text to the MasterBorders and Layout area of your page. When you draw a 
bounding box for text, you create a space in which you can type and format text as you would in a page 
layout program. 

A text box holds space for text, but it doesn’t need to be completely filled with text. For example, you can 
enter a small amount of text in a larger text box, but the box does not shrink to fit the size of the text 
block. However, it expands if you enter more text than the box can contain. A text block can contain any 
number of paragraphs, headings, lists, or other types of text.

It is helpful to turn on Show element borders in the View properties tab or View menu, so you can see the 
text element boundary when the element is not selected.



Entering Text
1. In Page view, select the Text tool.

2. Drag a boundary for the text box.

When you release the mouse button to complete the boundary, a blinking cursor appears inside 
the text box, hollow handles appear around it, and the Text tab appears in the Properties palette.

3. Type text in the text box or paste text from somewhere else.



Selecting Text
Use these methods to select text and paragraphs:

· Drag to select specific characters.

· Double-click to select a word.

· Triple-click to select a paragraph.

· To select a block of text, click the first word, then Shift-click the last word.

· To select multiple paragraphs, drag through them.

· To end a paragraph, press Enter. NetObjects Fusion automatically inserts a double space before the 
next paragraph.

· To force a line break within a paragraph, press Shift-Enter.



Managing the Text Box
You can move and resize the text box like you do other NetObjects Fusion elements:

· To select the text box, click the border line or drag a selection box, so the handles are solid. 

· To resize the selected text element, drag a handle when the pointer is a double-sided arrow.

· To move the selected element, drag the border when the pointer is the default selection tool.



Using the Text and Edit Menus
Whenever you select text, the Text menu appears in the NetObjects Fusion menu bar.

· To indent selected paragraphs, choose Indent from the Text menu. Choose Unindent to move the 
paragraph to the left.

· To display a word count for the selected text element and the whole page, choose  "Word Count from 
the Text menu.

· To insert symbols such as trademark, copyright, quotes, dashes, and so on, choose Insert Symbol from
the Text menu.

· To insert HTML, choose Insert HTML from the Text menu. See Inserting HTML Tags.

· To insert a variable, choose Insert Variable from the Text menu. See Inserting Variables.

· When editing text, you can use the Cut, Copy, Paste, Select All, and Clear commands in the Edit menu 
as usual.

· To find or replace a word or phrase in a selected text element, choose Find or Replace from the Edit 
menu.



About Formatting Text
The Text tab contains options for formatting selected characters and whole paragraphs. 

· To change the font, size, style, and text color, select all the text you want to change.

· To change alignment, bullet, or paragraph style, you need only click inside the paragraph.

· To undo a style, choose Undo from the Edit menu.

Note: You can format selected characters only in text boxes and Rich Text data fields, which are available
only in internal data objects. In Simple Text data fields, all characters have the same format. For more 
information on data objects, see About Data Publishing.



Formatting Text
1. In Page view, select the text you want to format.

The Properties palette displays the Text tab: 

2. Choose a text format by clicking on a character style icon.

You can choose bold, italic, underline, strike-through, or a combination of these. You can also 
choose superscript or subscript.

You can select Left, Center, or Right alignment.

3. Select a font from the Font list. This box displays the fonts installed on your Windows system. 
Select Site Style to use the default font for the style selected in Style view. This font setting affects
only the Layout area.

To affect the HTML tags output by NetObjects Fusion, you must redefine the Normal paragraph 
style. See Editing a Paragraph Style by Example.

Note: TrueType™ and PostScript® fonts are read by browsers that support the latest HTML font 
tags. To view multiple fonts in your site, your site visitors need an HTML 3.x compatible browser 
(such as Netscape Navigator 3.0) and the actual fonts installed on their systems. 

Text normally assumes the font assigned to it by a browser, but NetObjects Fusion allows you to 
assign unique fonts to your text. If the specified font is installed on the site visitor’s system, HTML 
3.x compatible browsers such as Netscape Navigator 3.0 will display it. If the font is not installed, 
the browser will use its default font.

4. Select a font size from the Size list. 

The number in parentheses shows the HTML tag that is equivalent to the point size.

5. If the selected text is to be a bulleted list, a numbered list, or an outline format, select the 
appropriate form from the Bullet list. Select None to use no bullet style. For more information see 
Creating Lists.

6. Change the Inset value to set the space between the text and the element border.

7. In the Text Color section, select Site Style to use the default color for the style selected in Style 
view, or click Color... to select a different color.

8. In the Background Color section, select None to use no background, or click Color... to select a 
color to fill the text element.



Locking a Text Block's Minimum Size
Locking a text block’s size can influence what happens when your site visitor chooses a smaller font than 
you used to design the page. It can help you minimize the white space that separates the text block from 
the element beneath it.

NetObjects Fusion 2.0.x offers a Lock Size option on the Text tab of the Properties palette. When you 
select the option, you can adjust the block’s bounding box to be larger than the text it contains, which 
creates white space. The locked text block will always be at least this big in both Page view and the 
browser. You cannot lock the maximum size of a text block; it always grows to fit the text, both in Page 
view and in the browser.

To minimize white space, you must lock text block size to the minimum needed to accommodate the 
smaller font. 

To lock the text block
1. Select the text in the block.

2. Set it to the smallest size you want to support.

3. Select the Lock Size option. 

4. Restore your text to its original size and the block will expand to display it and you can continue 
designing as normal.

When you preview the page in a browser that is set to use small fonts, the text block will still contain the 
same amount of white space it would contain if the browser were set to use the font size you used to 
design the page. 

Choosing a smaller font in Microsoft Internet Explorer for Windows can simulate how the fonts will look in 
a Macintosh browser.



Checking Spelling
NetObjects Fusion can verify whether English text on the current page is spelled correctly. 

You can add words to a personal dictionary so they will no longer be flagged. Your personal dictionary is a
simple text file, so you can use any text editor to add or delete words.

1. In Page view, choose what you want to check.

· To check all text blocks and tables on the page, select nothing.

· To check a particular block, text string, or word, select it.

2. Choose Spell Check... from the Edit menu.

If an error is detected, the Spelling dialog appears with the misspelled word selected in the 
Change To field.

3. Choose a replacement for the misspelled word. You can either:

· Type a correction.

· Select a suggestion from the list.

4. Choose how to correct the selected word and go on to the next, if any.

· Click Ignore to skip this instance of the word.

· Click Ignore All to skip all instances on this page.

· Click Change to replace this instance.

· Click Change All to replace all instances on this page.

· Click Add to put the word in your personal dictionary so it will not be flagged as an error 
on any page in the future. 

· Click Suggest to see alternate spellings for the word in the Change to field.

· Click Options to choose U.S. or U.K English, and to choose a location for your personal 
dictionary.

· Click Close to cancel the spell check.

As a shortcut, you can replace a misspelled word with a suggestion by double-clicking the 
suggestion.



Using an Existing Paragraph Style
1. In Page view, click in the paragraph you want to format, or if formatting multiple paragraphs, drag 

to select them. 

2. Choose a style from the Paragraph Style list. 

The list contains standard styles including Numbered List, Bulleted list, Normal, Headings 1-6 
(with 1 offering the largest HTML 2.0 type size and 6 offering the smallest), and more.

The selected paragraphs change to the style you selected.



Editing a Paragraph Style by Example
1. In Page view, select a paragraph that is in the style you want to modify, so the style name is 

selected in the Paragraph Style list.

2. Select the text and change it to the font, size, color, and alignment you want.

3. Now select the style again from the Paragraph Styles list.

The Reapply Style dialog appears, showing the name of the selected style.

4. Select Redefine the style using the selection as an example.

Note: If you select Reapply the formatting of the style to the paragraph, you will lose all your 
changes and the paragraph will return to its original settings for that style.

The selected style now has the new format you created.



Editing a Paragraph Style Using a Dialog
1. In Page view, click a paragraph that is set to the style you want to edit, so the style name shows 

in the Paragraph style list.

2. Click Edit....

The Paragraph Style dialog appears.

3. Select the font, size, effects, paragraph indent, bullet style, alignment, and color you want to use 
for the style. 

The number in parentheses shows the HTML tag that is equivalent to the point size.

4. Click OK.

The selected paragraph changes to the settings you specified. The next time you choose the style
you edited, the selected paragraph will appear in the new format.



Creating Your Own Paragraph Styles
1. In Page view, select the text you are going to format. 

2. Format the text in your paragraph using the features in the Text tab, as described in Formatting 
Text.

3. Click New....

4. In the New Paragraph Style dialog that appears, type a name for the new Paragraph Style you 
wish to create, then click OK.

The new style appears as a choice in the Paragraph Style list, and you can use it as you would 
any paragraph style.



Creating Lists
NetObjects Fusion offers several options for presenting items in a list. Each item must be a separate 
paragraph. You can choose from a variety of numbered lists and bulleted list types. Bulleted lists are 
optimized for viewing in Windows browsers.

1. Separate your list items by pressing Enter. 

2. Select all the items you want to include in the list.

3. Choose a listing system from the Bullet drop-down menu. 

· To create unordered lists choose Solid circle, Solid square, or Open circle. 

· To create an ordered list, choose upper case alphabetic (A, B, C), lowercase alphabetic 
(a, b, c), roman numeral (upper and lowercase), or Arabic numerals.

4. For ordered lists, you can set the list start value by clicking anywhere in the list and choosing Set 
List Start from the Text menu.

Enter a start value in the dialog and click OK.

Your list now begins with the new value regardless of the numbering system chosen.

Note: Ordered list counters such as 1, 2, a), b) and so on, do not show in your font style, as this is
not an HTML option. Such counters are generated by the browser in the default browser font.



Inserting HTML Tags
Although NetObjects Fusion provides visual support for most HTML tags, a new tag might be developed 
that you want to use. You can insert HTML tags into a text element.

Use this feature to insert HTML tags that affect text. To insert other kinds of HTML tags, use a script. For 
more information see Advanced Scripting.

1. In Page view, click in a text element where you want to place the tag. For example, if you are 
formatting text, click at the beginning of the text.

2. Choose Insert HTML from the Text menu.

The Insert HTML Tag dialog appears.

3. Type the tag you want to insert, such as <B> for Begin Bold.

4. Click OK.

If Show Element Icons is turned on in the View properties tab or View menu, a small icon appears
in the element border to indicate the presence of an HTML tag. The icon is blue when selected 
and grey when deselected.

5. If necessary, at the end of the text to format, insert an ending HTML tag, such as </B> for End 
Bold, the same way.

When you preview the page you can view the effects of the HTML tags you entered. 

To edit the tag, click it. The Insert HTML Tag dialog opens again, showing the tag you entered. Edit the 
tag and click OK.



Inserting Variables
NetObjects Fusion provides a list of variables you can include on your pages, such as the date and time 
the site was created or last modified, the site name and author, and so on. You can also define your own 
variables to include on your pages.

1. In Page view, click in the text element where you want to insert a variable.

2. Choose Insert Variable from the Text menu.

The Insert Variable dialog appears.

3. In the Type list, select a category, such as Date & Time, Site & General, or User defined.

The available variables appear in the Variable list.

4. Select the one you want to use. For example, to display the date and time the site was last 
modified, select Site Modified from the Variable list.

For Date & Time you can select a date format. Click Date Format... and select a format from the 
list. The format you select appears in the Value section of the dialog.

For Site & General, NetObjects Fusion generates the values automatically from the site 
information. For example, if you entered an author name in the Site properties in Site view, it 
appears in the Value section when the Author variable is selected.

5. Click OK.

· The variable appears in the text element at the cursor location. It is highlighted to identify 
it.

· To edit the variable, click it, then choose Edit Variable from the Text menu. You can also 
edit variables in Assets view.



Inserting User-defined Variables
User-defined variables give you a way to enter information that is subject to change, without re-entering 
the information every place it occurs.

For example, you might be referring to a product that is in development and at this point has only a code 
name. The name appears on many pages in your site. You can enter the product name as a user-defined 
variable and insert it anywhere you want. When the product name changes, edit the variable and let 
NetObjects Fusion update all the pages in your site.

You can edit a user-defined variable in Assets view, as described in Managing Variables.



Defining Your Own Variable
1. In Page view, click in the text element where you want to place the variable.

2. Choose Insert Variable from the Edit menu.

3. In the Type list of the Insert Variable dialog, select User defined.

4. Click New....

5. In the Variable name field of the New Variable dialog, type a name for your variable.

6. In the Value box, type the information you want to display. 

7. Click OK.

The information appears in the text element.



Using Tables
NetObjects Fusion tables are similar to the tables you create in powerful word-processing and page 
layout programs. You can format a table’s rows, columns, and borders, and fill its cells with text or 
images. Table cells can have borders of any width. You can also adjust the space between table cells, or 
the cell padding. The margin of each cell is called the cell spacing.

Table Spacing

Use the Table properties tab to set whether each cell contains text or an image. Use the right-click menu 
to add and remove columns and rows. You can easily change the content setting for any cell if you want 
to switch.



Creating a Table
When you first create a table, you configure all of its specifications, including the numbers of rows and 
columns, in the Table dialog. When you want to modify an existing table, you’ll use the Table properties 
tab instead.

1. In Page view, select the Table tool.

2. Drag the tool to create a table box approximately the size you want.

The Table dialog appears.

3. Enter the number of columns.

4. Enter the number of rows.

5. Select a content type, either text or picture, for each column number.

6. Click OK.

The dialog closes and NetObjects Fusion inserts the table into the table box you drew.

7. Add text or image content to the table cells:

· When you click a cell in a text column, a text cursor appears. Type or paste text into the 
cell.

· When you click a cell in an image column (marked with an X), the Image File Open dialog
appears. Select an image file from your hard disk, CD-ROM, or LAN. For information on 
using this dialog, see Using the Image File Open Dialog .



Modifying a Table
You may want to modify a table after you’ve created it. By selecting the table, you bring up the Table 
properties tab, which you can use to change the table’s border size, padding, spacing, and background 
color. You can use the right-click menu to add and remove columns and rows. 



Setting Table Properties
1. In Page view, select the table you want to modify by drawing a selection box around it.

The Table properties tab appears.

2. Toggle the border size up or down, or enter a new border size.

3. Adjust the cell padding by toggling its value up or down, or by entering a new value.

4. Adjust the cell spacing by toggling its value up or down, or by entering a new value.

5. Click Color... to select a background color.

6. If you want to change a column width or row height, use the Selection tool to drag the column 
border or row border.

Note: The table remains at a fixed size as you move interior columns and rows. It automatically grows 
down when you type more text than the current cell can hold. You can manually resize the table by 
dragging the resizing handles.

Like all content elements, a table can be manipulated with the Selection tool. You can resize a table at 
any time by dragging its handles. You can also add or remove rows and columns.



Adding and Removing Rows and Columns
1. In Page view, right-click any table cell.

The pop-up menu appears.

2. Select whether you want to add or remove the current row or column.

When you add a new row, it appears below the selected cell. When you add a new column, it 
appears to the right of the selected cell.



Changing Content Setting
Although you set the content type for each column when you create the table, you can change this setting
easily.

1. In Page view, right-click any table cell in the column you want to change.

2. Select Cell Type... from the pop-up menu.

The Cell Type dialog appears.

3. Select Text or Picture, then click OK. Click Cancel to close the dialog without making any 
changes.



Importing Pages
NetObjects Fusion allows you to import pages authored elsewhere. You can import the following types of 
pages:

· HTML documents (HTM or HTML extension)

· Rich Text Format files (RTF extension)

· text-only files (typically TXT extension)



Importing an HTML Page
1. Navigate to the page where you want to import an HTML page.

2. Display this page in Page view.

It is easiest to import an HTML file onto a page that has no content, because elements from the 
HTML file overlay existing elements.

3. Choose Import Page... from the File menu.

The Open dialog appears.

4. Select an HTM or HTML file from your hard disk, CD-ROM, or LAN.

5. Click Open.

NetObjects Fusion places the contents of the HTM or HTML file on the current page, beginning in 
the upper left corner of the Layout area.

Note: Depending on the complexity of the HTML, you may have to manually re-position and 
resize your content elements, especially if the HTML contains pictures or tables.



Importing Plain Text
NetObjects Fusion automatically places text you import into a text element on the selected page.

1. Navigate to the page where you want to import plain text.

2. Display this page in Page view.

3. Choose Import Page... from the File menu.

The Open dialog appears.

4. Choose Text Files (*.txt) from the Files of type drop-down list.

5. Select a text file from your hard disk, CD-ROM, or LAN.

6. Click Open.

The text appears in a text box beginning in the upper left corner of the Layout area, regardless of 
other elements that might be on the page. The width of the text box is the same as the widest line
in the text. The length adjusts to accommodate the text. To resize the text box, drag one of its 
handles. Make sure the handles are solid black before you drag.



Importing a Rich Text Format page
You can import Rich Text Format (RTF) files onto a page. The text is automatically placed inside a text 
box.

1. Navigate to the page where you want to import formatted text.

2. Display this page in the Page view.

Make sure that this page contains no content.

3. Choose Import Page... from the File menu.

The Open dialog appears.

4. Choose Rich Text Format (*.rtf) from the Files of type drop-down list.

5. Select a rich text file from your hard disk, CD-ROM, or LAN.

The text you are importing must be in Rich Text Format (.rtf). Other formats such as Microsoft 
Word format (.doc) are not supported.

6. Click Open.

The text appears in a text box beginning in the upper left corner of the Layout area, regardless of 
other elements that might be on the page.

The width of the text box is the same as the widest line of text. The length of the text box adjusts 
to the length of the text. To resize the text box, drag one of its handles. Make sure the handles are
solid black before you resize.



About Adding Pictures
You can place pictures in the MasterBorders and Layout area of your page. This section tells you how to 
add pictures, modify their size and appearance, set a transparent color, add text to pictures, and rotate 
text and pictures. 

Each picture on a Web page is a separate image file that browsers download and display. There are two 
widely supported image file formats for the Web:

· Joint Photographic Experts Group (JPEG)

JPEG supports 24-bit “true color.”

· Graphics Interchange Format (GIF)

GIFs are 8-bit, 256-color images. NetObjects Fusion also supports GIF 89a format.

NetObjects Fusion also supports animated GIFs. An animated GIF file contains multiple images that your 
browser plays in sequence. You can use a GIF animation program to create an animated GIF image. 
Animated GIFs provide an efficient way to add movement to your pages without the need for browser 
plug-ins. Simply insert them as you would an ordinary GIF image. 

You can add a link to a picture to make it more useful. You can link an entire picture or only certain 
regions of the picture, called hotspots. When you place a hotspot on a picture, NetObjects Fusion creates 
a client-side imagemap. Client-side imagemaps do not require Common Gateway Interface (CGI) scripts 
to decipher the imagemaps’ coordinates. For information on creating links and imagemaps see About 
Creating Links.

Because some browsers do not support pictures, it is important to provide text as a backup to the 
information you present in images. If you use images, take advantage of alt tags. Alt tags provide text 
titles that appear when the images are not displayed. Make your alt tags descriptive, so that site visitors 
know what the pictures are even if they can’t see them. The alt tag is linked if the image is a link, but not if
it is an imagemap. If you use an imagemap, it’s a good idea to place text links elsewhere on the page, so 
that site visitors can still reach the destinations in the imagemap.

Note: When placing pictures on a page, be sure that they do not overlap. Most Web browsers do not 
support overlapping pictures. If your pictures or other content elements are layered, they may not appear 
the way you expect in your site visitor’s browser.



Adding a Picture
1. In Page view, click the Picture tool and draw a bounding box for your picture.

The Image File Open dialog appears, with gif and jpg formats selected in the Files of Type list 
box.

For information on using this dialog, see Using the Image File Open Dialog.

The folders in NetObjects Fusion 2.0\Parts\Design Parts contain many gif and jpg 
pictures to choose from.

You can also place images in bmp, pcx, and pct formats. When you select one of these formats, 
NetObjects Fusion offers to convert the image to gif or jpg format. 

· If you choose GIF, NetObjects Fusion dithers the image to 256-colors. 

· If you choose JPEG, NetObjects Fusion retains the color information of the original file.

· If you do not convert the image, most browsers will not be able to display it.

After you choose, NetObjects Fusion converts the picture and saves it to the Assets folder within
your site’s folder. The original picture is not changed.

2. Select the image file you want from your hard disk, CD-ROM, or LAN, then click Open.

The image you selected appears in the bounding box, which automatically adjusts to fit the image
size.

If you cancel the Image File Open dialog, NetObjects Fusion places a large X in the bounding 
box, to indicate no picture is selected for that picture element. 

Double-click the picture element, or select it and click Browse... in the Picture properties palette, 
to re-open the dialog and select a picture.



About Changing Picture Settings
The Settings section of the Picture properties tab offers several ways to situate a picture inside its 
bounding box. The default setting is Normal, which means that the picture retains its original size and is 
centered within the box. You can change the alignment, force the picture to stretch to the size of its 
bounding box, or tile the picture across the bounding box area.

For information on using other settings in the Picture properties tab, see Setting the Transparency, and 
Adding Text to a Picture.



Changing Picture Settings
1. In Page view, select the picture you want to modify.

The Picture properties tab appears, showing the name of the selected picture in the File field: 

2. Select the setting you want:

· To maintain the picture’s aspect ratio but change its alignment within the bounding box, 
click the Align... button, then select a setting from the Vertical and Horizontal sections of 
the Alignment dialog.

· To crop the picture, select Normal and drag the lower-right handle of the bounding box 
until just the part of the image you want appears.

· To stretch the picture across the bounding box area, select Stretch.

· To tile the picture over the bounding box area, select Tile.

3. To show existing hotspots, select the Show Hotspots check box. For information on hotspots, see 
Creating an Imagemap.

4. To rotate the picture 90 degrees, click an arrow in the Rotate box.

5. To specify text to display when a browser cannot display the picture, type the text in the AltTab 
field. 



Setting the Transparency
When you place a GIF image on a page, you can select one of its colors and make every pixel of that 
color transparent. Browsers will display all pixels in the image except pixels marked transparent. Although
only part of the image becomes transparent, a GIF with a transparent color is called a transparent GIF. 
You can use transparent GIFs to achieve a natural image shape rather than a rectangular one, or to 
silhouette an image against the page background.

Keep in mind that only pixels of exactly the same color will be selected to be transparent. If the image 
background color is dithered, it may contain a mixture of different shades to approximate a color. An 
image without dithering in the background works best.

Note: Transparency only works with GIFs. You cannot set a transparency for a JPEG or other image file 
format.



Setting the Transparent Color
1. In Page view, in the Tools palette, click the Picture tool, then click the Transparency Color tool in 

the secondary palette.

2. With the eyedrop pointer, click a point in an image that contains the color you want to make 
transparent. The picture becomes selected.

The Transparency section of the Picture properties tab displays the color you selected, the Use 
Current Color box is checked, and the color appears transparent in the layout.



Moving, Cropping, and Copying Pictures
You can move and copy picture elements. You can crop an image to keep only a portion of it visible on 
the page.

· To move a picture element, drag it.

· To change the size of a bounding box, drag one of its handles. This does not affect the 
size of the image.

· To crop a picture, select the picture you want to crop, then drag the lower-right bounding 
box handle until you see only the portion of the image you want to display.

· To return a bounding box to the picture’s original size, select the picture, then choose 
Size to Image from the Page menu.

· To copy a picture, hold down the Control (Ctrl) key while you drag the picture to a new 
location. The original will remain in place. 

You can also use the Cut, Copy, and Paste commands in the Edit menu to move and copy 
pictures.

For information about aligning, stretching, tiling, and rotating pictures, see Changing Picture Settings. To 
learn how to align a selected group of pictures, and how to make a selected group’s bounding boxes all 
the same height or width, See Arranging and Sizing Elements.



Adding Text to a Picture
You can add text to a picture and format its font, size, and alignment. The text you add becomes part of a 
new image file when the page containing the picture is published.

1. In Page view, using the Selection tool, drag a selection box or click a picture to select it.

2. In the Picture properties tab, select the Text in Element check box.

The “Your text here” label appears on the selected picture, centered vertically and horizontally.

3. Click Settings....

The Text in Element Settings dialog appears.

4. Replace “Your text here” with the text you want to appear on the picture. 

5. Select the Left, Center, or Right Relative Alignment icon to align the text. 

This alignment is relative to the Vertical and Horizontal Position you select for the text. For 
example, if you type two lines of text and click the Center icon, the two lines will be center 
justified. If you select the Left Horizontal and Top Vertical Positions, the lines will be centered over
each other, and will appear in the top left corner of the picture.

6. If you want to change the font, next to Font click Set... to set the font, font style, and size in the 
Font dialog. 

7. Change the font color, if you like, by clicking Color... and selecting from the Color dialog.

8. You can set where to place the text on the picture.

· In Horizontal Position, select Left, Center, or Right.

· In Vertical Position, select Top, Center, or Bottom.

9. In the Orientation section, you can set the rotation angle of the text.

· Zero degrees represents no rotation. Drag the slider to rotate the text.

· Select the Right angles check box to constrain the text to right angles only; deselect it to 
rotate text to any angle.

10. When you finish adjusting the text, click Close.



Using the Drawing Tools
In addition to inserting existing images, NetObjects Fusion makes it possible to draw and edit lines and 
shapes directly on the page.

You can draw rectangles, rounded rectangles, ellipses, polygons, and lines. You can also create a line 
that is generated by an HTML tag, called an HTML rule. 

You can select, move, resize, cut, copy, and paste drawing elements the same way you manage other 
NetObjects Fusion elements.



Drawing Shapes
You can draw rectangles, rounded rectangles, ellipses, and polygons. You can also select colors for these
shapes and their borders. When the pages containing the shapes are published, NetObjects Fusion 
generates each shape as a GIF file.

1. In Page view, select the Draw tool.

2. Select one of the secondary tools: Rectangle, Rounded Rectangle, Ellipse, or Polygon, 
depending on the shape you want to draw.

3. Drag an area to draw the shape.

· To help you draw a circle or square, select Show Grid in the View properties tab.

· To draw a polygon, click to set the start point, click to set subsequent points, and double-
click to end the figure.

· When you draw a rounded rectangle, NetObjects Fusion supplies one extra handle inside
the object. You can use this handle to edit the degree of curve on the corners.

The properties tab for the selected shape appears: 

4. Change the color of the shape by clicking Color... in the Fill section of the tab.

The default color for all shapes is white.

5. Select the width and color of the border.

You can make the border the same color as the shape to render the border invisible.

6. Add an alt tag, if you wish, as a text title to be displayed when browsers do not display the shape 
itself.

7. If you like, you can link the shape by clicking Link.

Links and the Link dialog are described in About Creating Links.

8. If you want to adjust the shape or size of the drawing, drag its handles.

· To vary the curve of a rounded rectangle, select it, place the pointer over the inside 
corner handle until it changes to a double-sided arrow, then drag toward the inside until 
you have the desired curve.

· To edit the lines of a polygon, select it, place the pointer over any handle until you see the
double-sided arrow, then drag the handle until the lines are the way you want.



About Drawing Lines
You can use the Line tool to draw lines in the default line style selected in Style view, and lines with 
various head and tail styles. You can also set line width and color.

You can use the Rule tool to add HTML rules. HTML rules are fixed width, horizontal only, and appear to 
have beveled edges when displayed by the browser. When you create an HTML rule, NetObjects Fusion 
uses an HTML <HR> tag in the page.



Drawing an HTML Rule
1. In Page view, click the Draw tool, then select the Rule tool.

2. Drag a horizontal line.

The HTML rule appears.

3. Set HTML rule properties, if you wish.

· You cannot change the width of an HTML rule.

· Select Default Line Style to instead use the line picture from the current SiteStyle.



Drawing a Line
1. In Page view, click the Draw tool, then select the Line tool.

2. Drag from one point to another to set the position, length, and orientation of the line.

The point where you press the mouse button becomes the head of the line. The point where you 
release the mouse button becomes the tail of the line, even when you drag from right to left.

To constrain the line to vertical or horizontal, hold down the Shift key while dragging.

The line appears on the page, with its endpoints selected.

3. In the Line tab of the Properties palette, select a line width and color for the line.

4. In the Style section, set line head and tail styles.

· Select a head style from the Head list. You can choose Line, Point, Arrow, Diamond, 
Circle, or Square. You can also select a color for the line head. 

· Select a tail style and color from the Tail list. To omit a tail style, select Line. 

· Select Head/Tail share style to automatically give the same ending style to both ends of 
the line.

· Select Line shares single color to convert the head and tail to the line color.

· Select Outline style to outline the head and tail with the line color.



Editing Lines
By dragging, you can change the shape and size of the head and tail styles, which you cannot do in the 
Line tab of the Properties palette.

In Page view, select the line. 

Selection handles appear at the head, middle, and tail.

When you place the pointer over a selection handle, it changes to a crosshair.

· To make the line longer or shorter, or change its angle, drag an end handle. 

· To make the line thicker or thinner, drag a side handle.

· To change the shape of the end style, drag one of the endstyle handles.



Adding Text to a Shape
You can add text to a shape and format its font, color, size, and alignment. When pages containing this 
text are published, the text is rasterized and saved in the shape’s GIF file.

1. In Page view, draw a shape and select it.

2. In the properties tab for the shape you selected, click the Text in Element check box.

The “Your text here” label appears in the shape.

3. Click Settings....

The Text in Element Settings dialog appears.

4. Enter text in the text field, and set any of the other options you wish.

When you type or select an option in the dialog, the result appears immediately in the selected 
object.

For information about the options and settings in this dialog, see Adding Text to a Picture.

5. When you finish, click Close.



About Creating Links
You can link page elements to any other point on the Web, including points within your site. You can link 
segments of text, drawn shapes, whole pictures, or areas of pictures in the form of an imagemap. You can
also create anchors—markers at a specific location on a page—to aid navigation in long pages.

The navigation controls described in Working with MasterBorders are page-based, automated linking 
mechanisms. The linking techniques described here are ways of manually linking other content elements 
such as text, pictures, and drawn shapes, both within the site and outside it. As you organize your site, 
you’re likely to create multiple links to the same location from different parts of your site. The Assets view, 
described in About Assets View, provides centralized control over these links for efficient link updating.

The properties tab for all linkable elements contains a Link button in the lower left-hand corner. The Link 
button opens the Link dialog, where you specify the destination of a link. There are three types of links, 
and each has its own tab in the Link dialog:

· Internal Link, which links to a page or anchor inside the site.

· Smart Link, which links to a relative position in the site, such as previous page or next page.

· External Link, which links to a page in another site by a variety of methods: via URL (Universal 
Resource Locator), FTP (File Transfer Protocol), and others.

If Show Element Icons is turned on in the View properties tab, NetObjects Fusion displays the Link or 
Anchor icon when you create a link or anchor.

You can follow an existing link to its target page or anchor. To do this, either right-click a linked element 
then select Follow Link from the pop-up menu that appears, or select the element and choose Follow Link
from the Edit menu. To follow a text link, first click the text so the text cursor is visible.

To edit a link, select the linked text or object, click the Link... button in the properties tab, then change the 
link in the Link dialog that appears. To remove a link, select it and click Unlink in the Link dialog.



Creating an Internal Link
Internal links lead to pages or anchors within your site. If the page moves to a different place in your site 
structure or the page name changes, the link follows it. The Assets view shows you the internal links in 
your site and lets you track them as they are automatically updated.

1. In Page view, select an item to link.

· If you are linking text, select the text you want the browser to highlight with the link color.

· If you are linking a picture or other element, click to select it.

2. In the properties tab for that element, click Link....

The Link dialog appears, with the Internal Link tab selected by default. 

· The Page section lists all the pages in the current site. 

· The Anchor section lists all the anchors on the page selected in the Page Name section. 
To learn how to create an anchor, see Adding an Anchor.

3. In the Page section, select the target or destination page for the link. 

· Scroll the list, or type the first few letters of the page name to automatically select the first
page name starting with those letters.

· To select the current page, select the Current Page button.

· If you are linking to an anchor on a page, first select the page, then select the anchor 
name in the Anchor section.

4. Click Link.

NetObjects Fusion creates the link.



Adding an Anchor
An anchor is a marker on a page. Anchors are useful on long pages, so that your site visitors can go 
directly to a particular part of the page, instead of scrolling and searching for information.

You can place an anchor anywhere in a text element or table, or on a picture or drawn shape. You can 
link to an anchor from anywhere. When the site visitor clicks the link, the browser displays the page 
containing the anchor, beginning at the location of the anchor.

1. In Page view, click to place the text cursor within a line of text, or select an image or drawn shape.

2. In the properties tab for the selected element, click the Anchor... button.

The Add Anchor dialog appears. The Anchors on Page section shows any existing anchors on the
selected page.

3. Type a name for the anchor in the Name field. The name cannot contain spaces.

4. Click OK.

If Show Element Icons is turned on the View properties tab, the Anchor icon appears at the 
anchor location on the page.

To edit an anchor, click the Anchor icon and change its name in the Change Anchor dialog that 
appears. To delete an anchor, select it and click Remove in the Change Anchor dialog.



Creating a Smart Link
Smart links lead to a page in your site based on its relative position in the structure, not its name. These 
links automatically adjust when you change your site structure. For example, if your smart link leads to the
parent of the current page, and you later move the current page to a different parent, NetObjects Fusion 
updates the link to point to the new parent.

1. In Page view, select an item to link.

2. In the properties tab for that element, click Link....

The Link dialog appears.

3. Click the Smart Link tab.

4. Select the type of link you want:

· Select Home to link to your Home page.

· Link to the parent of the current page by selecting Up.

· Next Stacked Page links to the next page in a stack.

· Previous Stacked Page links to the previous page in a stack.

· Select Next Page to link to the sibling to the right of this page in your site structure.

· Previous Page links the sibling to the left of the current page in your site structure.

5. Click Link.

For detailed information about stacked pages, see About Data Publishing.



Creating an External Link
External links are Universal Resource Locators (URLs) that point to other pages and items in other sites 
on the Web. A valid URL includes the protocol, host name (or DNS), pathname, and sometimes a 
filename, such as http://www.netobjects.com/products/fusion.html.

1. In Page view, select an item to link.

2. In the properties tab for that element, click Link.

The Link dialog appears.

3. Click the External Link tab.

The External Link tab shows a list of URLs used within the current site.

4. Select an Internet protocol from the URL drop-down list.

5. For the selected protocol, either enter a new URL or select an existing link from the list. 

When the site visitor clicks the selected element, this link target will be displayed.

6. Enter a name for this link target in the Asset Name field. 

This name is for your reference, and appears in the list of links in Assets view, allowing you to 
quickly identify and sort link destinations. It is not added to HTML generated when your site is 
staged or published. 

You can also select a link target from the list of assets. When you select an asset from the list, its 
URL and name appear in the URL and Asset Name fields. You can modify the name and URL if 
you like.

7. Click Link.



Creating an Imagemap
An imagemap allows you to specify different links for different areas of a picture. You create an imagemap
by drawing hotspots on a picture. You can link as many hotspots as you like in a single image, but the 
hotspots cannot overlap or extend beyond the edge of the picture. Because the imagemaps you create 
with the following procedure do not require a CGI script running on the server, they are called client-side 
imagemaps.

To create a client-side imagemap
1. In Page view, select a picture on a page.

2. Select the Picture tool to bring up its secondary tools.

3. Select one of the hotspot tools, depending on whether you want to create a rectangular, circular, 
or polygon hotspot.

4. Draw a hotspot on the image.

If you are using the Polygon Hotspot tool, you must single-click to establish each vertex of the 
polygon, then double-click to complete the hotspot shape.

The Link dialog appears.

5. In the Link dialog, select the type of link by clicking one of the tabs.

6. Select a destination for the link or type a URL. For more information refer to the preceding 
sections.

7. Create more hotspots, if you like, using the same tools and the Link dialog.

Note: Once a picture is imagemapped, it can be moved anywhere on the page and even copied 
and pasted elsewhere in the site.

To edit an existing hotspot, select it. The Hot Spot properties tab appears.

· To edit the link, click Link.... The Link dialog appears, displaying the tab for the type of link. Change the 
link destination or click Unlink to remove the link.

· To make the hotspot an anchor, click Anchor.... and type a name in the Add Anchor dialog that appears.



About Style View
The Style view is where you view, apply, edit, and create the look and feel of your entire site. SiteStyles™ 
are sets of thematic elements that are included with NetObjects Fusion. Some style elements are 
graphical; others affect the text colors in your Web pages. 

NetObjects Fusion 2.0 comes with a gallery of brand-new, professionally designed SiteStyles that take 
advantage of GIF transparency to blend seamlessly with any background color you choose. Use these 
new SiteStyles as they are, edit them, or create your own styles to give your site a distinctive look.



Using Styles
SiteStyles include backgrounds, banners, buttons, data list icons, linked text colors, and lines. When you 
select a name in the Gallery list, NetObjects Fusion displays the elements of that style in the Elements 
window:

When you apply a SiteStyle to your site, NetObjects Fusion automatically distributes its elements 
throughout your site. For example, it replaces all your navigation buttons with the new button style 
specified, while maintaining the relevant links. Take advantage of this power by experimenting with 
SiteStyles, exploring how different styles complement your content. Trying a SiteStyle takes only a few 
clicks in the Style Gallery.

NetObjects Fusion comes with a large selection of styles. You can download new styles as they become 
available at www.netobjects.com.



Applying a SiteStyle
1. In Style view, select a SiteStyle from the Gallery list.

The elements of the selected style appear in the Elements window.

2. Click Set Style to apply the current style to your site.

The name above the Gallery list changes to the one you selected to indicate the style has been 
applied. The next time you open the Page view, you will see the new style elements in place on 
each page.



About Editing Styles
NetObjects Fusion allows you to edit any element of a style to customize it. When you create a style of 
your own, you need to define it by assigning attributes to each element. The Elements view is where you 
edit existing style elements or create a custom SiteStyle from scratch.

NetObjects Fusion allows you to edit any element of a style to customize it. When you create a style of 
your own, you must define it by assigning attributes to each element. Use the Elements view to edit 
existing style elements or create a custom SiteStyle from scratch. You cannot edit styles in the other 
views, Page view for instance.

When you select a new image for a style element, NetObjects Fusion automatically copies it into that 
element’s folder for the SiteStyle assigned to that site. If you’re editing an existing SiteStyle, the new 
image file replaces the one previously assigned to that element. It copies the new image to the folder, but 
doesn’t overwrite the old image file unless the new and the old files have identical names. NetObjects 
Fusion applies the new image to every site using that SiteStyle.

For example, suppose you want to modify the SiteStyle Nippon, to replace the butterfly on the highlighted 
primary button with a bumblebee. First you must create the bumblebee button image in an image editing 
application. You can give the new image file any name you like. Then, in Elements view, you edit the 
highlighted primary button style by selecting the image file that contains the bumblebee. The image file 
you select is copied to the Primary Buttons Highlighted folder in NetObjects Fusion 2.0\Styles\
Nippon. If the new image file has the same name as the original file, the original will be overwritten. 
Thereafter, every site created on your machine that uses Nippon will use this file to display the bumblebee
on all highlighted primary buttons.

This applies to all style elements that can be based on images: Background, Banner, Primary Button, 
Secondary Button, Line Picture, and Data List Icon.



Editing SiteStyles
1. In Style view, display the elements of the SiteStyle you want to edit.

To do this, you can either

· Click the style’s name in the styles list, then click the Elements button on the secondary 
control bar.

· Double-click the style’s name.

The Elements list appears on the left, displaying the standard list of style elements under the 
selected style name. The Edit button also appears:

2. To open an element for editing:

· In the element list, select the style element you want to change and click Edit.

· Double-click the style element in the element list.

A dialog box appears. Each style element has a different dialog box for modifying it. Each is 
explained individually later in this section.

3. In the dialog, select new attributes for the style element.

For graphical style elements, you can select a new image file instead of the default file. 

4. When you’re finished modifying the element, click OK.



Editing a Background
1. In Style view, double-click Background in the Elements list. 

The Background Style dialog box appears.

2. Select a background option:

· Select None to use a grey background, which is part of a browser default.

· Select Color to enable a solid-color background such as white, the default. Choose a 
different color by clicking the Color... button and selecting from the Color dialog.

· Select Picture to use an image file as a background, which browsers will tile across the 
area of each page. Click Browse... to choose an image file from your hard disk, CD-ROM,
or LAN.

3. Click OK.



Editing a Banner
1. In Style view, double-click Banner in the Elements list.

The Banner dialog box appears.

2. Click Browse... to choose an image file from your hard disk, CD-ROM, or LAN.

3. To change the appearance of text, click Text Settings... and set text options as described in 
Editing Text Settings.

4. Click OK.



Editing Text Settings
1. From the Banner or Button dialog, click Text Settings... to set options for the banner or button 

titles.

The Text Settings dialog appears.

2. Select the Left, Center, or Right Relative Alignment icon to align the text. 

3. If you want to change the font, next to Font click Set... to set the font, font style, and size in the 
Font dialog. 

4. Change the font color, if you like, by clicking Color... and selecting from the Color dialog box.

5. You can set where to place the text on the picture.

· In Horizontal Position, select Left, Center, or Right.

· In Vertical Position, select Top, Center, or Bottom.

6. In the Orientation section, you can set the rotation angle of the text.

· Zero degrees represents no rotation. Drag the slider to rotate the text.

· Select the Right angles check box to constrain the text to right angles only; deselect it to 
rotate text to any angle.

7. When you finish adjusting the text, click OK.

NetObjects Fusion copies the selected file to the appropriate SiteStyle folder and displays the 
new banner in the Elements window.

Each SiteStyle includes a primary button and a secondary button. The navigation controls that appear 
throughout your site can be configured to display one or the other. For example, top-level pages can 
display the primary button set while lower-level pages display the secondary set.

Each button has two states you can edit: regular and highlighted. Button highlighting is used in 
navigational button bars to show which page a visitor is currently viewing. You can turn highlighting on 
and off in the Nav. Bar properties tab found in the Page view. Highlighting is turned on by default.



Editing a Primary Button
1. In Style view, double-click Primary Button in the Elements list.

The Primary Button dialog box appears.

2. To select a different primary button image:

· Choose a regular button image by clicking the first Browse button and choosing an image
file from your hard disk, CD-ROM, or LAN.

· Choose a highlighted button image by clicking the second Browse button and choosing 
an image file from your hard disk, CD-ROM, or LAN.

3. To set different text options:

· Choose options for regular button text by clicking the first Text Settings button. 

· Choose options for highlighted button text by clicking the second Text Settings button.

The Text Settings dialog appears, where you can set text options as described in Editing a 
Banner.



Editing a Secondary Button
1. In Style view, double-click Secondary Button in the Elements list.

The Secondary Button dialog box appears.

2. To select a different secondary button image:

· Choose a regular button image by clicking the first Browse button and choosing an image
file from your hard disk, CD-ROM, or LAN.

· Choose a highlighted button image by clicking the second Browse button and choosing 
an image file from your hard disk, CD-ROM, or LAN.

3. To set different text options:

· Choose options for regular button text by clicking the first Text Settings button. 

· Choose options for a highlighted button text by clicking the second Text Settings button.

The Text Settings dialog appears, where you can set text options. 

4. When finished, click OK in the Text Settings dialog and then click OK in the Secondary Button 
dialog.

A variety of narrow, horizontal, and page-wide images can serve as line pictures to separate Web 
pages into sections. A number of line picture images are included in NetObjects Fusion styles. 
You insert Line pictures in the Page view using the Draw tool.



Editing a Line Picture
1. In Style view, double-click Line Picture in the Elements list.

The Image File Open dialog box appears.

2. Select an image file from your hard disk, CD-ROM, or LAN.

3. Click Open.

Data list icons appear when you use a data object to create a data list in the Page view.



Editing a Data List Icon
1. In Style view, double-click Data List Icon in the Elements list.

The Image File Open dialog box appears.

2. Select an image file from your hard disk, CD-ROM, or LAN.

3. Click Open.

You can configure the normal text color for a SiteStyle to use a default color other than basic black.



Editing the Normal Text Color
1. In Style view, double-click Normal Text Color in the Elements list.

The Color dialog box appears.

2. Select one of the basic colors, or click Define Custom Colors... to define a unique color.

3. Click OK.

Link colors show site visitors where links are located, and browsers keep track of which links have already
been followed. Regular links are links the site visitor has not yet followed. Set a regular link color that is 
different from the color you plan to use in ordinary text.



Editing the Regular Link Color
1. In Style view, double-click Regular Link Color in the Elements list.

The Color dialog box appears.

2. Select one of the basic colors, or define a unique color.

3. Click OK.

Visited links show site visitors where they have already been. By assigning them a different color than 
that of the regular links, you let site visitors know at a glance that the link is a familiar one. If color 
consistency is more important to you than this detail, you can assign identical colors to regular and visited
links.



Editing the Visited Link Color
1. In Style view, double-click Visited Link Color in the Elements list.

The Color dialog box appears.

2. Select one of the basic colors, or define a unique color.

3. Click OK.



About Importing SiteStyles
NetObjects Fusion provides many pre-built SiteStyles, and NetObjects is creating more. You can 
download new SiteStyles as they become available from www.netobjects.com. After you download a 
new style, you must import it to use it with your current site.

Note: The SiteStyles available in the Style Gallery are specific to your .nod file. This means the imported 
style appears in the current site but will not appear in other sites you have already created. It can appear 
in new sites you create based on the default Blank Site template if you update it as follows: make a 
backup of the default Blank Site.nft that resides in your AutoSites folder, open a new blank site 
named Blank Site, import the SiteStyle(s) you want, export the site as a template, and replace the default 
Blank Site template with the Blank Site.nft you created. You can follow a similar procedure to add 
styles to any template. When you insert a template, any new styles it contains are added the active site’s 
Style Gallery.



Importing a SiteStyle
1. In the Style view, choose Import Style... from the File menu.

The Open File dialog box appears.

2. Open the NetObjects Fusion 2.0\Styles folder, then the folder of the SiteStyle you want to
import and select its .ssf file.

3. Click OK.

NetObjects Fusion adds its name to the Gallery list.

A style folder can exist anywhere and still be imported. It doesn’t have to be in the NetObjects 
Fusion Styles folder. For example, it might reside externally, such as on a server, and be 
downloaded to your local drive. The Import Style command makes a complete copy of an 
imported style’s folder in the appropriate place.



Importing All Available SiteStyles
· In Style view, choose Update Styles from the Edit menu.

NetObjects Fusion updates the Style Gallery of the active site to include all SiteStyles currently 
found in the Styles folder. 



About SiteStyles
You can create original styles of your own to give your site a unique look. Simply collect image files for 
your banner, buttons, lines, icons, or backgrounds, and integrate them in the Style view.

Each SiteStyle has its own folder inside the Styles folder. When you create a new SiteStyle, NetObjects 
Fusion creates a folder for the style as well as subfolders to contain image files for elements based on 
images, such as the background, banners and buttons. As you define each style element, NetObjects 
Fusion copies its image file to the appropriate subfolders.

SiteStyles give you control over the appearance of text on navigational aids throughout a site. One of a 
web page designer’s challenges is to design attractive pages that load quickly. Text blocks load quickly, 
but because your visitor’s browser and platform control the font and size in which text is displayed, you 
cannot rely on text blocks to establish visual themes for your pages.

With SiteStyles, you can choose any font on your system for banners and buttons. At publish time, 
NetObjects Fusion dynamically generates bitmapped image files for these banners and buttons using the 
font you specified for each element. This means all your site visitors will see the fonts you selected, 
regardless of their browser or fonts installed on their systems. 

SiteStyles are tightly integrated with automated navigation and linking. To display banners and buttons in 
Page view, NetObjects Fusion overlays text on an image. It draws the text from either the referenced 
page’s name on the Page properties tab or the name specified in the Custom name dialog. It gives the 
text the font style, size, and color you assigned in the Elements mode of the Style view. It combines this 
text with the image file for that element of the SiteStyle.

When you preview, stage, or publish the site, NetObjects Fusion creates a new .gif file for each new 
button and banner in the site. It puts these new .gif files in the auto_generated_images folder of the 
Preview, Stage, or Publish assets folders.



Creating SiteStyles
1. In Style view, in the control bar, click the New Style button.

The Request dialog box appears.

2. Enter a new style name.

3. Click OK.

NetObjects Fusion displays a new Elements screen that includes the list of basic style elements. 
It gives this list your new style name. It also creates a new folder for your style within the 
NetObjects Fusion 2.0\Styles folder.

4. Define each style element by editing it as described in Editing Styles.

5. Click Set Style.

All your custom SiteStyle images and settings are applied to your site automatically. For even 
more flexibility—for example, to use more than one banner image in your site or to use a different 
image for each button in a navigation bar—use the Button and Banner properties tabs in Page 
view as described in Using Navigation Button Bars and Using Banners.



Removing Styles
Removing styles from within NetObjects Fusion does not delete the .ssf files and associated images. The 
removal process removes the style only from the Style Gallery list of the active .nod file. 

1. In Style view, in the Style Gallery list, select the style you want to remove.

2. Remove the style by one of these methods:

· Choose Remove Style from the Edit menu.

· Press the Delete key.

3. Click Yes in the warning dialog.

The style disappears from the Style Gallery list of your particular site. It remains in the 
NetObjects Fusion 2.0\Styles folder.



About Assets View
NetObjects Fusion performs many housekeeping tasks for you behind the scenes, including keeping 
records of all the files, links, data objects, and variables used in your site. 

The Assets view gives you a way to see and manage the critical assets associated with your Web site 
and navigate to the pages on which they appear. It lets you delete unused assets and verify the location 
of assets that are in use. 

Because NetObjects Fusion uses aliases for files and external links, you can globally replace a file that 
appears on several pages (such as a picture, an applet, or an external link) by replacing it once in the 
Assets view. When you have inserted a variable in different text blocks on different pages, you can edit 
the value of the variable in Assets view and all instances of the variable throughout your site will be 
updated automatically.



Viewing Assets
When you open the Assets view, you can choose which kind of asset to see by clicking one of the four 
buttons in the secondary control bar. You can sort the list by clicking a column heading, and you can 
change the width of any column by dragging the column divider to the left or right.

For each file in your site, the Assets view lists:

· name, type, in use, location, size, date, verify status

For each link used in your site, the Assets view lists:

· name, link to, type, verify status

For each data object used in your site, the Assets view lists its name.

For each variable, the Assets view lists:

· name, type, contents



Managing Files
In Assets view, when you click the Files button, the Assets view displays a list of all the files associated 
with your site, both external files and those generated by NetObjects Fusion.

File types include:

· HTML

· images

· sound 

· video

· applets/plug-ins

Image files that you place on stacked pages to populate an internal data object do not appear in the 
Assets view. You can manage such files directly on the stacked pages. For complete information about 
data objects and stacked pages, see the topics beginning with About Data Publishing.



Asset Management Tips
You might have a particular image file, such as BuiltByNOF.gif, located in several different Assets folders. 
This means you might end up using the identical file from different locations: for example, on one page, 
you use a BuiltByNOF.gif located in your site’s Assets folder, and on another page, you use a 
BuiltByNOF.gif located in the original template’s Assets folder. When you stage or publish the page, 
NetObjects Fusion automatically creates a duplicate folder for each instance of a BuiltByNOF.gif that has 
a different path. To avoid this duplication, use only one instance of a file throughout your site. The Assets 
view makes checking and correcting this problem an easy task.

The verification feature can only check links for which you have direct read access. It might not be able to 
verify destinations that are on the other side of a firewall or a proxy server.

When you stage or publish your site, NetObjects Fusion copies the assets listed in the Assets view to the 
target server. If you subsequently delete assets and update the site, NetObjects Fusion does not remove 
the no-longer-used asset files from the server folders. You must use an FTP utility program to remove any
stale asset files from your server.



Editing Files
NetObjects Fusion lets you give assets custom names that are easy to keep track of. For example, you 
can identify an asset by its function rather than just by its filename. You might need an image asset that 
points to the right. You can name this asset “Point Right,” use an image file of an arrow, and place it on 
several pages. If you later want to change the image to that of a pointing finger, you just edit the file asset 
so that Point Right uses the pointing finger image file. NetObjects Fusion automatically changes the 
image on all the pages that include the Point Right image asset.

You can edit the name of any file, and you can substitute one file for another. You can delete a selected 
file asset or add a new one. With a single command, you can delete all the files that are no longer used in
your site. In addition, the File dialog displays a list of all the pages in the site on which a file is used. This 
lets you display a relevant page immediately. 



Editing File Information
1. Double-click the file in the Assets list.

NetObjects Fusion displays the File dialog box, showing the list of pages that use the file.

2. To substitute a new file, click BrowseÉ to choose the new file.

The Image File Open dialog appears. Select a new file from the Folders tab or an existing asset 
from the Image Assets tab. 

NetObjects Fusion replaces the old file on every page on which it appears.

3. To change the name NetObjects Fusion uses for this asset, change the name in the Name field.



Displaying a Page on Which a File Is Used
1. In Assets view, open the File dialog box.

2. Select the page you want to see in the list of pages.

3. Click the Go To button.

NetObjects Fusion displays the Page view of the page you selected.



Adding a File
1. In Assets view, choose New File Asset... from the Edit menu or press Ins.

2. In the File dialog that appears, click Browse... and select your file.

NetObjects Fusion gives the asset the same name as the file. 

3. Edit the asset name, then click OK.

If your new asset is an image file, the asset appears on the Image Asset tab of the Image File 
Open dialog the next time you place or change an image.



Deleting a File
1. In Assets view, select the unused file to delete and choose Delete File Asset from the Edit menu 

or press Delete.

You cannot delete a file that is in use.

2. In the dialog that appears, click Yes to confirm the deletion.

NetObjects Fusion removes the selected file. You cannot undo this operation, but you can use the
New File Asset command to restore the file asset.



Deleting All Unused Files
1. In Assets view, choose Delete All Unused File Assets from the Assets menu.

2. In the dialog that appears, click Yes to confirm the deletion.

NetObjects Fusion removes all the file assets whose In Use indicator is not Yes. You cannot undo 
this operation, but you can use New File Asset commands to restore any file assets. 



Verifying All File Locations
Verification determines whether all file assets are in their expected directories and lets you reset their 
paths if necessary.

1. In Assets view, choose Verify All File Assets from the Assets menu.

NetObjects Fusion verifies and reports the path status of all files. 

· When a file’s path information is correct, Assets view lists the date and time found in the 
Verify Status column.

· When a file’s pathing information is incorrect and the file or folder cannot be found, 
verification presents the Verifying Files Used by File Assets dialog.

2. Resolve the paths of any lost files or folders.

· To specify a new path, click Browse... and locate the file or folder. 

· To skip this lost item and continue verification, click Skip. Verification gives this file Not 
Found status and goes on to verify any subsequent files or folders.

· To stop the verification process, click Cancel. The verification status of the file currently 
being verified is not updated, nor is the status of any subsequent files.

3. When verification is complete, click OK in the confirmation box that appears.



Managing Links
When you click the Links button in the secondary control bar, the Assets view displays a list of all the links
used in your site—external links, page links, and smart links. 

· An external link is a link to a file or address that is outside of your Web site’s file structure. This could 
be a mail address, the URL for another Web site, or a file located elsewhere on the server. 

· An internal link is a link within your site from one page to another. An anchor is an internal link attached 
to a specific location on a page. 

· A structural (Smart) link is a link to a page in a specific hierarchical relation to a particular page: for 
example, to its parent page. 

If you move a page with a Smart link, the link automatically changes to link to the page in the same 
relation: for example, to its new parent page

Links between entries in a data list and their associated stacked pages do not appear in the Assets view. 
You can manage such links directly on the data list pages. For complete information about data lists, see 
the topics beginning with About Data Publishing.



Editing Links in Assets View
In Assets view, you can edit the name and destination of any link. You can change an external link if its 
URL changes. In addition, the Links dialog box shows you the list of pages in the site on which each link 
is used.

External links and mailto addresses that exist on several pages in your site can be updated centrally.



Updating an External Link
1. In Assets view, double-click the external link you want to update.

2. In the Links dialog box, change the name in the Name field.

3. Change the URL in the Link To field and click OK.



Displaying a Page on Which a Link Is Used
1. Double-click the link in the Assets view.

NetObjects Fusion displays the Links dialog box, showing the list of pages that use the link.

2. Select the page you want to see in the list of pages.

3. Click the Go To button.

NetObjects Fusion displays the Page view of the page you selected.



Adding a Link
1. In Assets view, choose New Link... from the Edit menu or press Insert.

2. In the Link dialog that appears, enter a name and destination for your link and click OK.



Deleting a Link
1. In Assets view, select the unused link you want to delete and choose Delete Link from the Edit 

menu or press Delete.

2. In the dialog that appears, click Yes to confirm the deletion.

NetObjects Fusion removes the link. You cannot undo this operation, but you can always use the 
Add Link command to restore it.



Verifying All Links
Verification determines whether all link destinations can be located.

1. In Assets view, choose Verify All Links from the Assets menu.

NetObjects Fusion displays a progress bar as it verifies and reports the status of all link 
destinations. It accesses the Internet via the default connection of your browser to verify external 
link references.

· When a link’s destination can be found, Assets view lists the date and time validated in 
the Verify Status column.

· When a link’s destination cannot be found, the Verify Status column describes the 
problem.

When verification is complete, the status bar disappears.

2. Resolve the destinations of any broken links by double-clicking the link and editing it as described
in the previous section.



Managing Data Objects
Data objects are collections of fields of data. You can use a data object to publish data without using CGI 
scripts or database programming. For complete details about data objects, including how to create them 
in Assets view, see the topics beginning with About Data Publishing.

When you click the Data Objects button in the secondary control bar, the Assets view displays a list of all 
the data objects used in your site.



Editing Data Objects
You can edit the name and field names of an internal data object as well as add new fields. Assets view 
can display these values for an external data object and you can change field types, but you cannot edit 
field names or add new fields.

1. Double-click the data object in the Assets view.

NetObjects Fusion displays the Data Object dialog box for that data object.

If this is an internal data object, you can edit it as described in the following steps.

2. Change the name of the data object by highlighting it and retyping.

3. To display the Data Field dialog box, double-click the field in the list of fields.

4. Edit the field name in the Data Field dialog box.

5. To add another data field, click the + button.



Deleting a Data Object
1. In Assets view, select the unused data object you want to delete and choose Delete Data Object 

from the Edit menu or press Delete.

You cannot delete a data object that is in use.

2. In the dialog that appears, click Yes to confirm the deletion.

NetObjects Fusion removes the data object. You cannot undo this operation, but you can always 
use the Add Data Object command to restore it. To learn how to use the Add Data Object 
command, see the topics beginning with About Data Publishing.



Managing Variables
Text variables make it easy to update text that appears throughout your site. NetObjects Fusion provides 
standard variables, such as the date and time the site was created or last modified. You can also create 
your own variables. In Assets view, you can edit, create and delete user-defined variables. See Inserting 
Variables to learn how to place variables.



Editing Variables
1. Double-click the variable in the Assets view.

The Edit Variable dialog appears.

2. Edit the name and value of the variable and click OK.

If you edit the value of the variable, NetObjects Fusion updates all text blocks containing that 
variable with the new value.



Adding Variables
1. In Assets view, choose New User Defined Variable... from the Edit menu or press Insert.

2. In the New Variable dialog, enter a name and value for your variable and click OK.



Deleting Variables
1. In Assets view, select the unused variable you want to delete and choose Delete Variable from 

the Edit menu or press Delete.

Do not delete a variable that is in use.

2. In the dialog that appears, click Yes to confirm the deletion.

NetObjects Fusion removes the selected file. You cannot undo this operation, but you can use the
New Variable command to restore the variable.



About Publish View
When you have completed your site, you are ready to publish it as a series of HTML pages and 
associated assets. Publishing is similar to previewing. Previewing is when you click the Preview button in 
the control bar to test how your site looks using your local browser. During publishing, NetObjects Fusion 
takes the site file (.nod) and creates the following on a server that you specify:

· a home page in HTML format

· a folder containing all the other HTML pages

· a folder containing all the associated assets (i.e., pictures, applets, auto-generated images)

NetObjects Fusion 2.0 offers improved publishing speed. It uses faster, optimized table generation with 
HTML 3.2 validation when creating HTML files. Also, it includes comments in the HTML files only if you 
select the Comments option.

NetObjects Fusion allows for two types of publishing: test staging and final Web server publishing. You 
can stage or publish your site with a single click. NetObjects Fusion generates the HTML and associated 
files, places them in an organized folder structure, and uploads the finished site to any Web server using 
a built-in File Transfer Protocol (FTP) client. 

Note: NetObjects Fusion HTML works with any Web server. No special Web server extensions are 
required.

Configuring your Publish settings is simple, and NetObjects Fusion saves your settings for future use. 
Your configuration shows NetObjects Fusion where your servers are and how you want to publish your 
site. Once you set these parameters, a single click tells NetObjects Fusion to produce a complete site in 
HTML and post it to your server by means of File Transfer Protocol (FTP).

In Publish view:

· Click Settings... to configure staging, publication, and site versions.

· Click Stage to test your site on a local or remote server.

· Click Publish to publish your site on a local or remote server.



About Staging
Before you make your site available to your final audience, it is a good idea to test it on your hard disk, a 
LAN server, or a “closed” Web server. This is called staging. Staging is similar to previewing, except that 
you can stage your site on a remote server—not just on your local hard disk. Staging is also different from
previewing, because it collects all the assets required for your site and places them in the final folder 
structure.

By staging your site and exploring its structure, you verify that the design is sound. When you stage your 
site on a remote server, you can make it available for others for review without revealing it to everyone. To
protect the raw site from premature access by others, you need to choose a staging server that is 
inaccessible to your final audience.

If you plan to publish your site on the Internet, your staging server might reside behind your organization’s
firewall. If your site is destined for a Local Area Network (LAN), or intranet, choose a host server or base 
folder with restricted access. You can also stage your site on your local hard disk. 

You can stage your site with a single click. NetObjects Fusion first generates the HTML and associated 
files and places them in an organized folder structure specified in the local setting. It then uploads the 
finished site to the server by means of FTP if remote staging is selected.

If your Web server is not responding, hold down the Control key while clicking the Stage button. This will 
start the FTP client application that is built into NetObjects Fusion without re-generating all the HTML and 
assets.



Configuring for Staging
1. Click the Publish button from within the Control bar.

2. Click Settings....

The Configure Publish dialog box appears and the Stage tab appears by default.

3. Choose whether you want to stage the site to a local or remote location.

· For local staging, use the default path Net Objects Fusion 2.0\User Sites\
mysite\Publish, or click Browse… to choose a folder on your hard disk or LAN, then 
click OK. 

Note: Do NOT locally stage to the root of your hard disk or the root of your original site name 
folder. It’s best to first go to the Explorer and make a separate, empty folder on your hard disk just
for local staging.

· For remote staging, click the Remote radio button, click Configure..., then fill in the fields 
in the Remote dialog box and click OK.

Note: This information is specific to your Web server. Contact your Internet Service Provider (ISP)
or Web server administrator for the precise information to enter in these fields. For guidance on 
the questions you need to ask, see About Your ISP Account .

4. In the Configure Publish dialog box, select the file options that suit your staging server platform:

· The name of your Home page determines the URL of your site. On some servers, you 
can publish the Home page as Index to allow the URL to end with a hostname or folder 
name such as http://www.netobjects.com. If you use the current page name 
instead, it will have a URL like www.netobjects.com/mypage.html.

· Select .htm or .html as your filename extension. Typically, .html is used for Macintosh
and UNIX servers, and .htm for Windows servers.



· The Replace spaces and special characters with underscores option is selected by 
default. When this option is selected, all spaces and non-alphanumeric characters except
periods (.), hyphens (-) and underscores (_) in the assets' filenames are automatically 
converted to underscores (_) when staged. It is recommended that this option remains 
selected.

5. When your configuration is complete, click OK.

NetObjects Fusion saves your staging configuration. You do not need to reconfigure for the 
current site unless your staging server changes. With your configuration in place, you can stage 
your site with a single click.



Staging a Site
1. Open the completed site file in NetObjects Fusion.

2. Switch to the Publish view.

3. Click the Stage button in the Publish view window.

NetObjects Fusion generates the HTML and associated files, places them in an organized folder 
structure, and uploads the finished site to your staging server by means of FTP. The root level of 
the publish site will contain the index.html (or other home page) file, an HTML folder, and an 
Assets folder. Modified sites might have multiple index pages and other folders.

4. When the Staging is Complete message appears, click OK and test your site by using your 
browser.

5. If you need to make edits, open the site file (.nod) in NetObjects Fusion, and make your 
changes(s).

6. Go to the Publish view and click Stage again. 



About Publishing
When your design is complete and you have verified that everything in your site functions properly, you 
are ready to publish it. Publishing creates all of your HTML and associated files, places them in an 
organized folder structure, and uploads them to your live Web server.

If you want to publish your site to an intranet, be sure to choose a Web server that resides behind your 
firewall. This protects the private content of your site from the prying eyes of external users. 

You can publish your site with a single click. NetObjects Fusion generates the HTML and associated files,
places them in an organized folder structure, and uploads the finished site to any Web server by means of
FTP.

No special Web server extensions are required for the HTML generated by NetObjects Fusion.

If your Web server is not responding, hold down the Control key while clicking the Publish button. This will
start the FTP client application that is built into NetObjects Fusion without re-generating all the HTML and 
assets.



Configuring for Publication
1. Click the Publish button in the Control bar.

2. Click Settings....

The Configure Publish dialog box appears.

3. Click the top of the Publish tab.

The Publish tab appears.

4. Choose whether you want to publish the site to a local or remote location.

· To publish your site locally, click Browse... and choose a folder on your hard disk, or your 
LAN.

Once you find the folder to locally publish to in the Select Folder dialog box, click OK.

Note: Do NOT locally publish to the root of your hard disk or the root of your original site name 
folder. It’s best to first go to the Explorer and make a separate folder on your hard disk just for 
local publishing.

· For remote publication, click the Remote radio button, click Configure..., then fill in the 
fields in the Remote dialog box and click OK.

Note: This information is specific to your Web server. Contact your Internet Service Provider (ISP)
or Web server administrator for the precise information to enter in these fields. For guidance on 
the questions you need to ask, see About Your ISP Account .

5. In the Configure Publish dialog box, select the file options that suit your server platform:

· The name of your Home page determines the URL of your site. On some servers, you 
can publish the Home page as Index to allow the URL to end with a hostname or folder 
name such as www.netobjects.com. If you use the current page name instead, it will 
have a URL like www.netobjects.com/mypage.html.



· Select .htm or .html as your filename extension. Typically, .html is used for Macintosh
and UNIX servers, and .htm for Windows servers.

· The Replace spaces and special characters with underscores option is selected by 
default. When this option is selected, all spaces and non-alphanumeric characters except
periods (.), hyphens (-) and underscores (_) in the assets' filenames are automatically 
converted to underscores (_) when published. It is recommended that this option remains
selected.

7. When your configuration is complete, click OK.

As with the staging configuration, you only have to enter these parameters once unless your publication 
server changes. With the configuration in place, you can publish your entire site with a single click.

Note: An FTP client might not be able to communicate with a Web server that is behind a firewall. If so, 
first publish your site to a local folder other than NetObjects Fusion\User Sites\your site 
name\Preview. Then, transfer all of the locally published site files (including any CGI files) to the Web 
server using an FTP utility. Be careful to transfer all files and to duplicate the folder structure precisely. .



Publishing a Site
1. Open the completed site file in NetObjects Fusion.

2. Switch to the Publish view.

3. Click the Publish button in the Publish view window.

NetObjects Fusion generates the HTML and associated files, places them in an organized folder 
structure, and uploads the finished site to your server by means of FTP. 

4. When your site is in place, access it with your Web server.

The URL of your home page is the Remote Host and Base Directory as listed in the Remote 
dialog (for example, www.domain.com/username/index.htm).



Using Site Publishing Options
NetObjects Fusion lets you automatically create alternative versions of your site, called modified sites, 
that are optimized for different browsers and viewing preferences. You can have NetObjects Fusion 
generate a site map in either NetObjects Fusion or Apple HotSauceª format, and you can specify whether 
you want published HTML files to include comments.

NetObjects Fusion offers other options for the site publishing process. If you wish, publication can include 
a site map in either NetObjects Fusion or Apple HotSauce™ format. You can also specify whether you 
want published HTML files to include comments.



Creating Modified Sites
1. In the Publish view, click Settings....

The Configure Publish dialog box appears.

2. Click Modify.

The Modify tab appears.

3. Click one or more of the modified site types:

· Text Only is for browsers that cannot display images, and for site visitors who prefer not 
to download image files.

· Grayscale creates a 256-shade grayscale version of your site.

· Low Bandwidth creates copies of your image files at half their original resolution, to 
optimize download time over slow connections or during periods of heavy network traffic.

4. Click OK.

When you publish your site, NetObjects Fusion generates separate file sets for each site version, 
including your site as you originally created it:

· HTML for a Text Only site will exist in the text_only_html folder.

· HTML for a Grayscale site will exist in the greyscale_html folder.

· HTML for a Low Bandwidth site will exist in the low_bandwidth_html folder.

You can create an initial page (screen door) that lets viewers choose which modified site they wish to 
view. On this first page, you will include manual links to the modified sites which have unique URLs.



Making a Screen Door
1. Publish the Home Page of the unmodified site with any name EXCEPT index.html.

On the Publish tab, set the Publish Home Page As option to any name but Index. The names of 
your modified versions will be based on this name.

2. Create a new blank site.

This one-page site will be your screen door. Design this page as an introduction to your site.

3. On the screen door, add external links to other published versions. 

These links must reference complete URLs. For example, if your screen door is located at 
http://www.gumball.com/maryanne and you named the Home page of the unmodified site 
home:

· Unmodified version: http://www.gumball.com/maryanne/home.html
· Text only version: http://www.gumball.com/maryanne/home_text_only.html
· Low bandwidth version: 

http://www.gumball.com/maryanne/home_low_bandwidth.html
4. Publish the Home page of your screen door site as index.html.

On the Publish tab of the Configure Publish dialog, set the Publish Home Page As option to 
Index. Because of this name, the browser will automatically open the screen door home page, 
which then presents the links to your visitors. 



Setting Publishing Options
1. In the Publish view, click Settings....

The Configure Publish dialog box appears.

2. Click Modify.

The Modify tab appears.

3. To include site maps, select the kinds you want.

To learn how to create site maps, see Inserting Shockwave Files and Other Plug-Ins and Adding 
a Site Map.

4. Select the Generate HTML comments option to include comments in the HTML files NetObjects 
Fusion creates for each page. 

The comments identify the beginning and ending of each page’s head and body, as well as 
content elements.

5. Do not set the Skip high ASCII character set conversion option unless you are working with 
special characters and are familiar with all their related coding issues and trade-offs.



Publishing with Internet Service Providers
To share your site with the world, you must publish it to a Web server. A Web server is a system that 
stores and sends files and is connected to the Internet.Web servers are expensive, so many Web 
publishers rent server space from an Internet Service Provider (ISP). The following section will help you 
get the information you need to let NetObjects Fusion communicate with your ISP’s server. 



About Your ISP Account 
To complete the Configure Publish dialog and publish your site to an ISP, you must know the answers to 
the following questions. Your ISP’s site for support pages should provide all this information. 

1. Who is your service provider? There are hundreds to choose from (see 
http://home.netscape.com/assist/isp/ispdir.html). Each offers a range of services;
typically, you sign up for an account. A minimum account gives you an Internet access 
connection, while a higher-level account—the kind you need—includes server space for your 
Web site. Most ISPs provide space for you on their server for no extra charge. However, there 
might be size restrictions with the free space and a requirement that all your files be in one single 
folder rather than a folder structure. NetObjects Fusion output requires a folder structure.

2. What is the name of your server? Usually your server name is the URL of your service provider 
without the http:// prefix. Most Web servers begin with www. So, the name of your server 
probably looks like this: www.yourISP.com. Some ISPs require that you store your files on 
another server. Check with your ISP for the preferred server name. 

My server name:                                                                                                                                                                                              

3. What is your username and password? You choose these or your ISP assigns them when you 
open your ISP account. 

My username:                                                                            password:                                                                                  

4. How much server space comes with your account? The ISP’s description of your account should 
tell you the maximum space you can use. Before you publish, you should stage your site, check 
its size (the size of the generated /Publish folder), and confirm that it takes less space than the 
maximum allowed by your ISP. 

Note:    If you have been working on your site for a while, unused files might exist that are not 
needed in the final version of the site. Drag the folder set in the local Stage or Publish settings to the 
recycle bin before publishing your final site. This will ensure that only the necessary files are used.

5. In which folder of your ISP’s server are you to store your site files? NetObjects Fusion needs to 
know the path to this folder. Almost all ISPs store sites in personal folders. The ISP usually names
your personal folder with your username. The folder name becomes part of the URL for your site. 
The URL for a site stored in your personal folder might look like this: 
http://www.yourISP.com/~username. 

In many cases, the ISP stores your Web site in a symbolically linked folder within your personal 
folder, often called public_html or html. Such a folder is like an alias and does not become 
part of your URL, but it is part of the path. 

Path to my site folder:                                                                                                                                              

6. What HTML filename extension does your ISP use? Web servers typically use .html. Due to 
DOS filename limitations, some HTML files end in .htm. Some ISPs map one to the other and 
some do not care. If it does matter, you must tell NetObjects Fusion which one to use. 

My ISP’s preferred extension:                                                                                                                                     

7. How will you manage files stored in your site’s folder? In almost all cases, you can let NetObjects 
Fusion manage your site files for you. However, if you make certain significant changes to your 
site, such as changing the name of the .nod file, or to remove your site or unused portions from 
the server, you must use an FTP client utility to view and delete the files and folders. See 
Publishing Special Files.

8. What is your ISP's preferred FTP port number? When it contacts your ISP to publish your site, 
NetObjects Fusion uses a standard FTP port number—21—to establish the connection. However,
your ISP might support several FTP port numbers in addition to the standard, and one of the other
numbers might offer better performance. 



My ISP’s preferred FTP port number:                                        



Publish Configuration Example
The following is an example of the settings you would make when publishing to an ISP. UUNET has been 
chosen to illustrate how easy it is to remotely publish with NetObjects Fusion.

Remote Host. UUNET’s server name is www.uu.net.

Base Directory. UUNET users store their sites in a folder called html within their personal folder.

CGI Directory. UUNET allows users to store CGI scripts within their personal folders. When this field is 
filled in as shown above, NetObjects Fusion creates a cgi-bin folder within the folder. Therefore, the 
URL used to call CGI scripts in the Web pages of this site must be: 

http://www.uu.net/~username/cgi-bin/
For more information about publishing to UUNET, go to http://www.uu.net/web.htm and click the 
Frequently Asked Questions link.



Publishing Special Files
NetObjects Fusion does not manage all of the files that you might use with very complex sites. The 
following list discusses some of these exceptions:

Pages not generated by NetObjects Fusion. You might want to link a page in your site that, due to it’s 
complexity or special design, you don’t want to recreate in NetObjects Fusion. You bring this type of page 
into your site as an external .html file. See Using External HTML Files.

Java Helper Files. Some Java applets use external files not included with NetObjects Fusion. Add these 
files through the List option in the Java Applet Files dialog. See Inserting a Java Applet.

Files called by JavaScript. Some JavaScripts write raw HTML code. This code might call for another 
HTML page or an image file. Because the script itself is not generated by NetObjects Fusion, any file 
called in the script is not managed by NetObjects Fusion. Add the file to the Publish folder so it will be 
automatically uploaded. Make sure that the JavaScript points to the correct file location. 



About Data Publishing
NetObjects Fusion makes it easy to publish listings of information such as employee directories, product 
and service catalogs, and event schedules. You can enter, manage, and store this information as records 
either in an external application such as a database or spreadsheet, or in your NetObjects Fusion site file.

To publish the data, you specify its source and create a master layout for data-based pages. Then 
NetObjects Fusion uses your layout to create a separate page for each record, and automatically 
provides your site visitor with buttons to navigate between them. 

NetObjects Fusion’s data publishing capabilities let you store text and images in a database internal to 
your site, or, if you are working on the Windows platform, import data from external sources, such as 
Microsoft Excel, Access, and ODBC databases. In both cases, NetObjects Fusion publishes your data in 
standard HTML pages. This makes it easy to add listings, such as product and service catalogs, 
employee directories, and event schedules to your site.

Each record in your database is published on a stacked page. Each stacked page corresponds to a row in
a data list. A data list appears on the parent of the stacked pages, and like a table of contents, acts as an 
index for your stacked pages. Data objects are collections of data fields. For example, to publish a 
product catalog, you would use a product data object with the following data fields: name, price, and 
photo. The actual data for the fields could be entered manually in NetObjects Fusion or drawn from an 
external desktop database or ODBC database connection.

You can publish data from internal and external sources. NetObjects Fusion lets you present your data to 
the site visitor in a data list and a series of associated stacked pages. Once you’ve chosen a source, 
NetObjects Fusion automatically creates the appropriate number of stacked pages. Each stacked page 
corresponds to a record in the data source. 

For example, suppose you publish a shirt catalog on the Web. Each row in the shirt data list lets the site 
visitor navigate to the stacked page that contains the corresponding shirt.

At the heart of data publishing is the data object, which is simply a collection of data fields. You use a data 
object to define what information you want to publish. To create your shirts catalog, your first step is to 
create a shirts data object. A data object can be defined once and used in different filtered data lists. For 
example, using the shirts data object, you can create one data list of all the shirts in your database. With 
the same data object, you can create another data list of just button-down shirts. And with the same data 
object, you can create still another data list of all the shirts on sale (and so on).

If the data object is created from an external source (for example, a Microsoft Access Database), and the 
source is updated, a site containing this data object will be updated when you publish again. For example,
suppose your shirts data object references 50 records originally and the external database is updated 
with 25 new records. After republishing, the data object references 75 records, the shirt data list contains 
75 rows and there are 75 stacked pages.

After you create a data list on a page, NetObjects Fusion generates a stacked page as its child. When 
you create the layout of the first stacked page, the remaining stacked pages automatically inherit the 
same layout.

In the Site view, the page icon for the data list page and the page icon for its child stacked pages appear 
as shown in the picture.



A data list acts as an automatic table of contents for the stacked pages. Links between the data list icons 
and the stacked pages are automatically created.



Publishing Data
In general, when you work with data publishing, you follow a three-step process:

1. Create a data object.

When you create a data object, you identify the fields you want to use in your site. When you 
store records internally, you must specify the data fields you want to store. When you store 
records externally, NetObjects Fusion assumes you want to use all fields available in the source. 

2. Create a data list.

When you create a data list, you prepare a display of the data in a row-and-column format. The 
display serves as a table of contents, typically summarizing the data that appears in the stacked 
pages. You select the fields you want to display as column headers in the list.

Each row of data that appears in the data list represents information available on a single stacked
page. The field data from either the internal or external source populates the data list when you 
publish.

3. Create a set of stacked pages.

When you create a data list, NetObjects Fusion automatically creates the first of your stacked 
pages, where you create the layout to be used for all the pages in the stack.

When you design a stacked page, you create or identify the field data you want to display on the 
page.

· If you are storing data internally, you enter the field data on the stacked page itself.

· If you are using an external source, the field data is drawn from the external database, 
spreadsheet, or ASCII text file.



Creating a Data Object
You can create two types of data objects:

1. External data objects: These objects import text fields from a data field created in a program other
than NetObjects Fusion. External data sources include external databases, spreadsheets, and 
ASCII text files.

2. Internal data objects: These objects are simple text, formatted text, and picture data fields within 
your NetObjects Fusion site file.



Creating a Data Object from Page View
1. In the Page view, click the Data List tool.

If you plan to store data internally, use the default secondary Data List tool. If you plan to publish 
data from an external source, you can use a shortcut: select the New External Data Object 
secondary tool and proceed as described in Creating a Data Object for External Data.

2. Draw an area on the page.

NetObjects Fusion displays the Data Publishing dialog box. From this dialog box, you can select 
an already existing data object, or you can create a new one. Instructions for using the Data 
Publishing dialog box can be found in Creating a Data List .

3. To create a new data object, click the New... button.

NetObjects Fusion displays the Data Object dialog box.

4. Choose whether to create an internal or external data object.

· To create an internal data object, verify that the Internal radio button is selected and 
proceed as described in Creating a Data Object for Internal Data.

· To create an external data object, select the External radio button, click the Source 
button, and proceed as described in Creating a Data Object for External Data.

5. When you have finished creating the data object, click OK.

NetObjects Fusion displays the data list placeholder showing the column headings and the Data 
List icon for the first row. You can now proceed to format the data list as described in Creating a 
Data List , and lay out your stacked pages as described in Creating Stacked Pages.



Creating a Data Object from Assets View
1. To display the list of data objects in the Assets view, click the Data Objects button in the 

secondary control bar.

2. Click the New Object button in the control bar.

NetObjects Fusion displays the Data Object dialog box.

3. Choose whether to create an internal or external data object.

· To create an internal data object, verify that the Internal radio button is selected and 
proceed as described in the next section, Creating a Data Object for Internal Data.

· To create an external data object, select the External radio button, click the Source 
button, and proceed as described in Creating a Data Object for External Data.

4. When you have finished creating the data object, click OK.

The data object is added to the list of data objects in the Assets view. The next time you create a 
data list, the data object will appear in the list of data objects in the Data Publishing dialog.



Creating a Data Object for Internal Data
Internal data is information you enter directly into a stacked page, either by typing text or numbers, or by 
placing a picture. You create a data object in the Page view or in the Assets view. If you create a data 
object in the Page view, you can continue immediately to create stacked pages to contain the data. If you 
create a data object in the Assets view, you must return to the Page view to create stacked pages.

To create a data object for internal data
1. Create a data object.

For instructions about creating a data object from the Page view or the Assets view, see Creating 
a Data Object from Page View and Creating a Data Object from Assets View.

NetObjects Fusion displays the Data Object dialog box.

2. In the Data Object dialog box, verify that the Internal radio button is selected, then enter a name 
for the data object and any comments.

NetObjects Fusion uses the data object name to identify the data object later, when you create a 
data list and in the Assets view list of data objects.

Now you can add fields to this object. The fields will contain data when you create stacked pages.

3. Click the “+” button to add a field.

NetObjects Fusion displays the Data Field dialog box.

4. To specify a field, type its name and select the data type for the field, then click OK.

Internal data fields can store formatted text, plain text, and image files:

· Simple text fields: These fields can only contain characters with the same formatting 
characteristics.

· Formatted text fields: These fields can contain characters with individual formatting. 

· Image file fields: These fields can contain an image in one of these formats: GIF, JPEG, 
BMP, PCX, or PICT. 

5. Add all the fields you want to use in the data object.

6. When you have finished, click OK.

For information about editing a data object, refer to Editing Data Objects.



Creating a Data Object for External Data
You can create an external data object only with the Windows version of NetObjects Fusion 2.0. External 
data exists in a local desktop databases or in SQL data sources. To make this data available to your site, 
choose an appropriate driver. NetObjects Fusion uses two types of drivers to access data:

· Index Sequential Access Method (ISAM) drivers: These draw data from desktop databases, such 
as Microsoft Access, Paradox, dBase, Microsoft Pro, Microsoft Excel, or delimited text files. ISAM 
drivers are automatically installed with most desktop databases.

· Open Data Base Connectivity (ODBC) drivers: These draw data from Structured Query Language 
(SQL) data sources, such as Oracle data files. Before you can choose an ODBC data source, you 
must specifically create it by binding your data file to a driver. You can do this in the Windows ODBC 
Control Panel or from within NetObjects Fusion. If you use MS Office or MS Office Professional for 
Windows 95, you might already have a set of ODBC drivers installed on your system. If you do not use
those products, you must obtain the drivers elsewhere. Contact Microsoft for more information.

Which driver to use? If your system includes both types of drivers for your application, we recommend 
using the ISAM driver. This is because an ISAM driver is faster, and it takes fewer steps to select an ISAM
driver.

NetObjects Fusion automatically gives you access to all the fields available in the external file. By default, 
it imports all external fields as simple text. You can change the field type to Image and import pictures 
referenced in the external file as image file paths.



Creating a Data Object from a Desktop Database
1. Create an external data object by one of these methods:

· In Page view, click the Data List tool, click the secondary External Data List tool, and then
draw a rectangle on the page.

· In Page view, click the Data List tool, click the default secondary Data List tool, and then 
draw a rectangle on the page. NetObjects Fusion displays the Data Publishing dialog. 
Click the New... button. Click the External radio button in the Data Object dialog, and then
click the Source button.

· In the Assets view, click the Data Objects button in the secondary control bar, and then 
click the New Object button in the control bar. Click the External radio button in the Data 
Object dialog, and then click the Source button.

NetObjects Fusion displays the Data Source Type dialog.

2. In the Type panel, select the data file type from the pull-down menu of desktop database types. 
Microsoft Access is the first item in the list.

NetObjects Fusion always provides access to Access 3.0 database files. Additional data types are
available if ISAM drivers have been installed. ISAM drivers are automatically installed when you 
install Microsoft FoxPro, Microsoft Visual FoxPro, Paradox, Microsoft Excel, or dBASE.

3. Click the Browse button, locate the database, and open it.

If the file is a multiple-file database or a spreadsheet with multiple tabs, NetObjects Fusion 
displays the Select dialog box.

4. Choose the file or tab you want to use and click OK.

NetObjects Fusion displays the Data Publishing dialog with your new data object selected. There 
you can see that the data object contains all fields present in the external source, and that it has 
taken the name of the file or tab you selected. 

5. Continue with the steps in Creating a Data List .



Creating a Data Object from an SQL Data Source
1. Create an external data object by one of these methods:

· In the Page view, click the Data List tool, click the secondary External Data List tool, and 
then draw a rectangle on the page.

· In the Page view, click the Data List tool, click the default secondary Data List tool, and 
then draw a rectangle on the page. NetObjects Fusion displays the Data Publishing 
dialog. Click the New... button. NetObjects Fusion displays the Data Object dialog box. 
Click the External radio button and then click the Source button.

· In the Assets view, click the Data Objects button in the secondary control bar, and then 
click the New Object button in the control bar. NetObjects Fusion displays the Data 
Object dialog box. Click the External radio button and then click the Source button.

NetObjects Fusion displays the Data Source Type dialog box.

2. In the Type panel, click the ODBC button, and then the Select button.

The SQL Data Sources dialog box appears.

This dialog displays all the ODBC data sources stored on your computer. You can select a 
database that you have created, (continue with step 3) or you can create a new one (continue 
with step 4).

3. To select an ODBC source on your system, click the source in the list box and then click OK. 
NetObjects Fusion displays the Select Database dialog box. Select the database and click OK.

4. To create a new data source, enter a name and click New...

NetObjects Fusion displays the Add Data Source dialog box. You can also access this dialog from
the ODBC control panel. Click the Help button to display Microsoft ODBC help for more 
information.

5. Select the driver type in the list and then click OK. 

The driver type must be the same as the type of data file. 

The system displays a dialog box for the selected driver. For example, if you selected a SQL 
database driver, the system displays the ODBC SQL Server Setup dialog box. Enter the 
requested information and click OK to close the dialog.

NetObjects Fusion redisplays the Data Sources dialog.

6. Select your new data source and click OK.

7. Click the Select Directory button to select the data file and then click OK.

If the file is a multiple-file database, NetObjects Fusion displays the Select dialog so that you can 
select a file. Then, it creates the data object, gives it the name of the selected file or tab, and 
imports its fields as simple text fields, which present all characters with the same formatting. To 
import images, see the next procedure.

If you started in Page view, the Data Publishing dialog displays your new data object, and you can
continue with the steps in Creating a Data List .



Importing Images from an External Data Source
1. In your database application, add a field and enter your images.

· If you plan to reference the images by path, create a simple text field and in each record 
enter the full path to each image, for example c:\my documents\images\
photo.gif. You must use this method to import images via Microsoft Excel or Access.

2. In NetObjects Fusion, create an external data object as described in the procedures above and 
link it to the table that contains your image field.

3. Switch to Assets view, click the Data Objects button, then double-click the data object you created
to open it for editing.

4. In the Data Objects dialog that appears, double-click the name of the field that contains your 
images.

5. In the Data Field dialog that appears, select the Image File option.

6. Close both dialogs and switch to Page view.

· If you have not yet created your data list and stacked pages, do so as described in 
Creating a Data List .

· If you have already created your data list and placed the image field on your stacked 
pages either manually or by selecting the Display All Fields option in the Data Publishing 
dialog when you created the data list, go to a stacked page, delete the placed image field,
then place it again using the Data Field tool as described in Creating the First Stacked 
Page.

Each image from the external data file appears on the appropriate stacked page.



Creating a Data List 
Once you have created a data object, you can create a data list on any page. The data list, in turn, allows 
you to create stacked pages, one page for each row in the list. When you have finished, NetObjects 
Fusion automatically adds data list icons to the first column in the data list. The data list thus acts as a 
table of contents—each row contains data for, and is linked to, a single stacked page.

This procedure assumes you have already created a data object. If not, see Creating a Data Object for 
Internal Data or Creating a Data Object for External Data in Windows for details on creating data objects.

To create a data list
1. In the Page view, display the page on which you want to place the data list. 

2. Click the Data List tool and verify that the standard secondary Data List tool is selected.

3. Draw a rectangle in the page body.

The Data Publishing dialog box appears. It displays the available data objects and the fields of 
the selected data object. 

4. Select the data object you want to use for this data list.

The fields that data object contains appear.

5. Choose a field to sort by.

Records in your data list will appear in ascending order by that field.

6. If you wish, click Set... to select a filter.

By default, NetObjects Fusion displays all available records in the data list and on stacked pages.
A filter selects a subset of the available records to display. You can create selection criteria that 
isolates exactly the records you want to appear in your data list.

When you click Set..., NetObjects Fusion displays the Query dialog box.

7. Enter your selection criteria and click OK.

NetObjects Fusion returns you to the Data Publishing dialog.

8. In the Data List area, enter a name for the data list.

9. In the Fields list, select fields to include in the data list by clicking the check box to the left of the 
field name.

As a shortcut, you can click the Add All button, which marks all fields for display. Typically, 
however, you display only a subset of fields in the data list and display all fields on stacked pages.

10. To link a field to its stacked page, select the field and click the Link/Unlink button.

A data list automatically includes a navigation button at the left of each row that links to the 
record’s stacked page. When you link a field, your site visitor can click either the button or the 
linked field to jump to the record’s stacked page.

11. To change the order in which fields appear left to right in the data list, select the field you want to 
appear first and click the up-arrow button until it appears at the top of the field list.

Continue to select fields and press the up- and down-arrow buttons until the list is in the order you
want.

12. If you wish, set options for the creation of stacked pages.

· When you select the Display all fields option, NetObjects Fusion automatically places all 
fields available in the data object in a simple layout when it creates the first stacked page.
This shortcut can save you the effort of placing fields individually as described in Creating
the First Stacked Page.



· When you select the Add navigation buttons option, NetObjects Fusion automatically 
places relative navigation buttons in a simple layout when it creates the first stacked 
page. This shortcut can save you the effort of creating these buttons as described in 
Creating Navigation Buttons for Stacked Pages.

13. Click OK.

NetObjects Fusion displays the data list placeholder, which presents as column heads the names 
of the fields you selected for display and a data list button at the left of the first row. This is 
enough information for you to use the Properties palette to specify the appearance of your data 
list. NetObjects Fusion populates the data list only when you preview or publish the page. Data 
never appears in the data list in Page view.

14. Click the data list to see the Data List tab in the Properties palette.

Adjust the settings on the Data List tab to change the bullet type, background color, border size, 
and spacing of the data. You can also mouse over the column heading borders and drag them to 
set column width.

When you are satisfied with the appearance of your data list, go on to creating a layout for your 
stacked pages as described in the next section.



Creating Stacked Pages
Stacked pages are individual pages that correspond to the rows of data in a data list. When first created, 
there is only one stacked page, on which you create the design for all of the subsequent pages in the 
stack. Each subsequent stacked page starts with the same layout as the first stacked page. If you later 
rearrange and modify the layout on any stacked page, the new layout applies to all the stacked pages.

Stacked pages also correspond to records in a database. When you store information internally in 
NetObjects Fusion, each stacked page lets you enter data into the fields of the data object. If you are 
drawing information from an external data file, each stacked page displays information from a single 
record.

Note:  You can add or delete stacked pages for internal data as described in Creating Text and Stacked 
Pages for Internal Data. However, to add or delete records for external data, make the changes in your 
external database or spreadsheet application and then republish your site.



Creating the First Stacked Page
The first stacked page determines the initial layout for all the stacked pages. When data fields and non-
data elements (text, pictures, or other assets) are added to the layout of the first stacked page, they are 
repeated across all the stacked pages.

To design stacked pages
Unless you selected the Display All Fields option when you created your data list, NetObjects Fusion 
displays a blank page. You can add text and graphic elements to this page, just like any other page. The 
key items to be added, however, are the data fields you have defined in the data object and have included
in the data list that has spawned this set of stacked pages.

1. Click the Data Field tool and draw a rectangle in the body of the stacked page.

NetObjects Fusion displays the Data Field dialog box, so that you can choose which field you 
want to display in the area you have drawn. The fields available are those in the data object you 
have used for the data list.

2. Select a field and then click OK.

· If you are using external data, NetObjects Fusion displays simple text field data from the 
first record in the data file. To import images, see Importing images from an external data 
source. 

· If you are using internal data and selected an image file field, NetObjects Fusion displays 
the Open file dialog box. Select the file, and then click OK.

· If you are using internal data and selected a simple or formatted internal text field, 
NetObjects Fusion displays a blank field. See Adding Text and Stacked Pages for Internal
Data for details.

3. Add additional data fields, until you have placed as many as you want. Add text blocks to label 
your fields, lines and other graphics until you are satisfied with your layout.

4. If your stacked pages reference external data, you can use the Display Next and Display Previous
Stacked Page buttons (left and right arrows) on the secondary control bar to scroll though all 
pages in the stack.



Creating Additional Stacked Pages for Internal Data
For internal data you enter into NetObjects Fusion, you create a stacked page for each record you want to
create. Each additional stacked page has the same layout of data fields and non-data elements you have 
placed on the first stacked page.

Once you have created the first stacked page, you can add additional stacked pages. You can create as 
many new stacked pages as you want. Each stacked page creates a row in the data list on the data list 
page, so it is a good idea to create the same number of stacked pages as the number of items you want 
to display. You can add and delete stacked pages for internal data whenever you want.

Note: You cannot add or delete stacked pages associated with an external data object. To add or delete 
records when data is stored externally, you must use your external database or spreadsheet application 
and republish your site.



Creating Additional Stacked Pages
1. On the first stacked page, click the Add New Stacked Page button in the secondary control bar.

NetObjects Fusion displays a duplicate stacked page with blank data fields.

2. Enter information in the data fields.

For example you would enter the second product name in the Name field, its price in the Price 
field.

To display an Open file dialog box to find an image file, double-click the Picture data field.

When data has been added to the stacked pages, the data list can display it. Preview the data list
page to see how it will look in your browser.



Creating Navigation Buttons for Stacked Pages
NetObjects Fusion lets you create relative next and previous buttons to facilitate navigation between the 
stacked pages. Unless you choose a stacked page creation option when creating your data list, you 
create navigation aids by drawing or importing buttons and assigning these buttons to SmartLinks.



Adding Navigation Buttons to a Stacked Page
1. In Page view, draw a shape using the Draw tool, or import an image using the Picture tool.

The Parts\Design Parts\Navigation Buttons folder contains pictures that are specially 
designed for page links.

2. Select the shape or picture.

3. Click Link in the Properties palette.

4. Click the Smart Link tab.

5. Select Next Stacked Page and click Link.



Using the NetObjects Web Site
The NetObjects Web site, located at www.netobjects.com, is the primary communication channel 
between NetObjects and its user community. Frequent visits to the site will ensure that you stay on top of 
the most current product information while becoming familiar with the ongoing development of NetObjects
Fusion.

An ever-changing testament to the power of NetObjects Fusion, the Web site is built and continuously 
updated with the application. As you browse the site, notice how it takes advantage of the ability of 
NetObjects Fusion to integrate navigational elements with custom navigational needs and interface 
design.

Currently, the NetObjects Web site provides information and services in seven different areas. Over time, 
more and more information will be available. The following is an overview of what you will find.

About NetObjects

Products

Support

Downloadable software

Customer gallery



About NetObjects
Learn about the NetObjects company, its management team, and job opportunities. NetObjects is working
with a growing number of key companies in the computing and Internet world. The results of these 
partnerships are important to users of NetObjects Fusion, and this and other corporate information is 
continually updated and presented on the Web site. NetObjects press releases appear first on-line, and a 
comprehensive index of articles and reviews can help you learn what other people think of NetObjects 
Fusion.



Products
These pages describe product features, list comparative analyses, and answer frequently asked 
questions about NetObjects Fusion. Free, downloadable extras such as styles, templates, and other 
design parts are available.

NetObjects also posts “pre-release” versions of both Macintosh and Windows applications as soon as the 
software is stable enough to allow users to work with new features and provide feedback and bug reports.

How to find this information: Go to the Products page at 
http://www.netobjects.com/html/products.html and click on the Features option.



Support
NetObjects posts comprehensive usage notes on key product features and functionality. Usage notes 
provide in-depth technical tips, tricks, and solutions for high-end Web site development. NetObjects 
develops these usage notes in response to user feedback and to augment the information provided in the 
user manuals. On-line documentation includes a browser version of the NetObjects Fusion Getting 
Started manual and downloadable text and Adobe Acrobat™ versions of all manuals.

You can join discussions between other NetObjects Fusion users and the NetObjects Support team via 
the various news groups on the Web site. To help us design and ship the best products, we also give you 
the opportunity to electronically report any bugs that you find in NetObjects Fusion.



Downloadable Software
NetObjects posts fully-functional, time-limited “trial” versions of its software. Users can build sites using 
trial software and can expect full compatibility with the shipping version of the product. 

How to find this information: Click on any of the Download buttons located at the top left of every page on 
the Web site.



Customer Gallery 
NetObjects continually updates its showcase of NetObjects Fusion users. Read in-depth profiles of 
people from all walks of life who are using NetObjects Fusion to create Web sites that support their 
personal, social, or business objectives. You can also review a growing index of sites created with 
NetObjects Fusion to get an idea of what other people are doing with the software.

How to find this information: Go the Community page at 
http://www.netobjects.com/html/community.html and click on the desired options.



Adding Rich and Interactive Media
To help you give your Web site increased impact, NetObjects Fusion provides tools that make it easy to 
add rich and interactive media to your pages. You can use tools on the Tools palette or drag-and-drop to 
add elements such as:

· sounds

· video

· QuickTime movies

· Java applets

· Shockwave files

· ActiveX controls



About Sound Files
Sound files are digital audio files that a browser can play on a properly-configured system. Before you 
add sound to your pages, determine whether you and your visitors can hear it. For a site visitor to hear 
sounds on a Windows system, the visitor’s computer must have a sound board and speakers installed. 
On any system, the visitor’s browser must be capable of playing sounds, either through a built-in player or
a helper application. 

Typically, visitors must download these from the sound technology developers and install them in their 
browsers, but most popular browsers have sound file players built in. For example, Live Audio technology 
is built into Netscape Navigator. Some sound formats also require support from the Web server. To 
preview and test sounds, your system must also be appropriately configured. 

Once your system is properly configured, NetObjects Fusion makes it easy to add popular audio file 
formats to your pages. The list below describes the formats it supports, as well as each formats 
requirements:

· RealAudio™ (.RA, .RAM)

· Windows audio (.WAV)

· .AIFF
· .MIDI
· .AU
NetObjects Fusion also lets you add a background sound that plays when a visitor views your page. 
Background sounds are added on the Layout properties tab. For information on inserting a background 
sound, see Adding Background Sounds.

Because importing a sound file uses the <EMBED> tag of standard HTML, you can use the Sound tool to 
offer your site visitors other file types. For example, after you select the Sound tool and drag an area on 
your page, choose a file format such as Adobe Acrobat PDF, text document, or spreadsheet. When site 
visitors click the document’s icon, the file either displays in their browser or downloads to their system. 

Because an audio file has no visual element, NetObjects Fusion represents the audio file with a graphic, 
usually an icon or an inline player control bar recognizable by the browser. When a site visitor clicks the 
icon or the play button on the inline player control bar, the browser either plays the sound file or opens a 
helper application to play it.



Inserting Sound Files
1. In Page view, click the Rich Media tool.

2. In the secondary palette click the Sound tool

3. Draw a box for the icon.

The Open dialog appears.

4. Select a sound file from your hard disk, CD-ROM, or LAN. 

5. Click Open.

The default sound icon appears on your page, and the Sound tab is displayed in the Properties 
palette.

The Filename field displays the name of the selected sound file.

6. Click Browse... to change your sound file selection, if necessary.

7. In the Display section, set the display options for this sound:

· To change the sound icon, select Icon and click one of the three standard sound icons.

· To select another image file as an icon representing the sound, select File, then click 
Browse....

· To use the standard audio player for your particular browser, click Inline.

8. To enter text for the browser to display when it cannot play a sound, type the text to display in the 
Alt tag field.

Note: For your site visitors to hear sounds, they not only need a sound board and speakers, but 
also the browser plug-in for the specified sound file format.



About Video Files
Video files are digital movies and animations that can be played on-line. Most require helper applications 
(or browser plug-ins). If you include video files in your site, be sure to provide a link to a download site for 
a plug-in that can play your files. However, the latest browsers have video players built in (i.e., Live Video 
and QuickTime in Netscape Navigator 3.0).

Video files can be displayed as part of a Web page. Placeholder icons represent the video files, and site 
visitors can click the icons to launch a separate browser window to play them. Videos can also be 
displayed inline on the page itself. In this case, the first frame of the video is displayed on the Web page.

NetObjects Fusion supports popular video file formats, including:

· QuickTime™ media (.MOV)

· Moving Pictures Experts Group (.MPG, .MPEG)

· Microsoft Audio Video Interleaved (.AVI)

· Vivo Active Producer (.VIV)



Inserting Video Files
1. In Page view, click the Rich Media tool.

2. In the secondary tool palette, click the Video tool.

3. Draw a bounding box on your page for the video placeholder. 

The Open dialog appears. 

4. Select a video file from your hard disk, CD-ROM, or LAN. 

5. Click Open.

The video icon appears on your page and the Properties palette displays the Video tab:

6. Click Browse... to change your video file selection, if necessary.

7. Select the display option for this video using the radio buttons in the display section:

· Select Icon and click one of three standard icons.

· Select File, then click Browse... to choose another image file to use as an icon.

· Click Inline to display the first frame of the video inside the browser window.

8. To provide text for the browser to display when it cannot play the video, use the AltTag field.

Note: For your site visitors to view video files such as MPEG and streaming formats, they will 
need the browser plug-in for the specified video format.



About Java Applets
Java applets are an efficient way to add interest and motion such as scrolling messages and color cycling
buttons to your site.

Java applets are platform-independent applications with compact file sizes and a wide range of 
capabilities. Usually, applets run on the client platform, which means that site visitors download them and 
run them inside their browser windows. Most browsers are Java-compatible.

NetObjects Fusion embeds the Java applet file on your page. If the applet conforms to a certain standard,
NetObjects Fusion can display the applet’s parameters on the Java Applet properties tab. For Java 
applets written this way, it is easy to edit the applet’s variables without leaving NetObjects Fusion.

Visit the NetObjects Fusion Web site to learn the details of using Java applets, and the standard that 
allows NetObjects Fusion to display parameters.



Inserting Java Applets
1. In Page view, click the Java tool.

2. Drag a bounding box to specify the size of the applet interface.

The Open dialog appears.

3. Select an applet from your hard disk, CD-ROM, or LAN.

The file extension is .class.

You can use the led_clock.class Java applet in the NetObjects Fusion 2.0\Parts\
Plug-in Parts\Java Applets folder as an example. This applet provides a digital clock using 
LED style characters. 

The Java applet placeholder image appears on your page and the Java Applet tab is displayed in 
the Properties palette.

4. Set the parameters for this applet.

· If the parameters for this applet are registered in the Parameters section of the Java 
Applet tab, you can edit them by double-clicking each one and entering values in the 
Enter Value dialog.

· To get helpful hints on how to change parameters, read the text that appears in the 
parameter information section of the Java Applet tab.

· To remove a parameter, select it and click the minus sign (–). The selected parameter is 
deleted immediately. There is no confirmation dialog for removing parameters.

· To add a parameter, click the plus sign (+) and enter a name and value in the dialog that 
appears.

Typically you can add more instances of a parameter that already exists. For example, if 
text1 and text2 already exist, the applet will probably recognize a text3 parameter 
you create. If you add a parameter the applet does not recognize, it will be ignored.

· To change the order of the parameters, use the arrow buttons. The selected parameter 
moves up or down in the list.

· To change the applet file, double-click the Java Applet element, and select a different
.class file in the Open dialog that appears.

· To add another applet to the Class list, click List.... In the Java Applet Files dialog, click 
Add.... then select another .class file. The selected Java applet appears in the Class 
list. To delete an applet from the Class list, click List, select the applet, then click Delete.

5. To provide text for the browser to display if it cannot launch the applet, use the AltTag field.



Inserting Shockwave Files and Other Plug-Ins
Because the Web is evolving rapidly, leading manufacturers have made their browsers “open.” Thanks to 
this open architecture, you can add the latest functionality to your site without requiring your site visitors to
use a custom viewing application. Examples of these “plug-ins” are Shockwave and HotSauce. 



About Shockwave
NetObjects Fusion supports Shockwave file formats. These files can be passive or interactive animations.
They can also contain sound. 

Any Shockwave files you embed appear inline on the Web page itself. In fact, you can use the 
Shockwave tool to place any plug-in. However, no matter what kind of plug-in you place, Page view 
always displays the Macromedia placeholder.

The NetObjects Fusion 2.0\Parts\Plug-in Parts\Shockwave folder contains ready-to-use 
Shockwave files that you can include in your site. NetObjects Fusion supports various Shockwave 
formats, including:

· Shockwave for Director 4.0 and 5.0 (.DCR)

· Director (.DIR)

· Protected Director (.DXR)

· Shockwave Audio (.SWA)

Note: For your site visitors to view your Shockwave files, they need to install the Shockwave plug-in for 
their particular browser. These plug-ins are available from the Macromedia Web site at: 
http://www.macromedia.com.



Inserting Shockwave Files
1. In Page view, select the Shockwave tool.

2. Draw an area the same size as the file’s stage.

The stage is the space in which the animation will appear. Check the stage size of the file before 
you draw the box. If you draw a box whose dimensions are different from the stage dimensions of
the module, you can resize the final animation display.

The Open dialog appears. 

3. Select a Shockwave file from your hard disk, CD-ROM, or LAN. 

4. Click Open.

The Shockwave placeholder image appears on your page and the Shockwave tab is displayed in 
the Properties palette.

5. Click Browse... to change your Shockwave file selection.

6. To provide text for the browser to display if it cannot play the animation, use the AltTag field.



Using HotSauce Meta-Content Format
Browsers that support Apple’s HotSauce Meta-Content Format can display a 3D representation of the 
pages in your site. To display the visual site, the browser uses a file with extension .mcf in the site’s root 
directory. NetObjects Fusion can generate this .mcf file when you preview, stage, or publish your site. 
This MCF file allows browsers that support HotSauce to provide 3D-style navigation of your entire site. 
Much like SiteMapper, the advanced navigation application included in NetObjects Components, 
HotSauce can make a large site easier to navigate.
Note: To use HotSauce, you need to have the HotSauce plug-in installed for your browser. This Netscape
plug-in is available from the Apple HotSauce site: http://hotsauce.apple.com. HotSauce is 
emerging technology and as of this writing, the plug-in is available for Netscape 2.0 and greater, Internet 
Explorer, and Cyberdog. HotSauce support will be built into Netscape 4.0. 



Inserting HotSauce MCF as a Custom Window
1. In Publish view, click Settings..., then click the Modify tab in the Configure Publish dialog.

2. In the Site Map section, select Generate HotSauce Site Map.

3. Preview your site so NetObjects Fusion can generate the requested mcf file.

4. In Page view, go to the Home page in NetObjects Fusion.

HotSauce needs to be at the top level of your site structure.

5. Click the Rich Media tool, then select the Shockwave tool in the secondary tools palette.

6. Drag an area on your home page for the HotSauce navigation window.

An Open dialog appears.

7. Choose All Files in the List Files of Type drop-down menu.

8. In the folder User Sites\your site folder\Preview select yoursite.mcf.

9. Click Open.

10. A Macromedia placeholder appears on your page.

Although this placeholder says “Made with Macromedia” it is actually a placeholder for your .mcf 
file. 

11. Preview your site again.

12. If your browser supports HotSauce, the HotSauce navigation window appears inline on your 
page.

13. Click in the window and drag your mouse to start navigating throughout the site.

14. Investigate other options by clicking on the menu in the upper left hand corner of the HotSauce 
navigation window.



Using HotSauce MCF as an External Link
1. Preview your site.

2. Go to your Home page in NetObjects Fusion.

HotSauce needs to be at the top level of your site structure.

3. In Page view, select the element you want to link.

4. Click Link in the lower left corner of the Picture Properties tab.

5. Click the External Link tab.

6. Enter a URL in the URL field.
· To test the link in preview, enter file: //hard_disk_name/ NetObjects Fusion 2.0/User 

Sites/my_site/Preview/my_site.mcf.

· To test the link in stage or publish, enter http://www.domain.com/ 
my_folder/my_site/Preview/my_site.mcf.

7. Click Link.

8. Preview your site again.

9. Click this link.

A second browser session will be launched containing nothing but the HotSauce navigation 
window.

10. Click in this browser and drag your mouse to start navigating throughout the site.

11. Investigate other options by clicking on the menu in the upper left hand corner of the HotSauce 
navigation window.



About ActiveX Controls
ActiveX controls are supported by Microsoft Internet Explorer version 3.0 and later, and allow you to add 
custom capabilities such as audio and movie players, calendars, custom buttons, and forms to your Web 
pages. You can view documents such as Microsoft Office files right in Internet Explorer, without launching 
the associated program. Your site visitors will need to use Internet Explorer 3.0 or later to view content 
created with ActiveX controls.

ActiveX requires that you install Microsoft ActiveX controls on your system. ActiveX controls can be 
obtained from the Microsoft Web site. Or, check www.netobjects.com for links to archives of free, ready-
to-use ActiveX controls. 



Inserting ActiveX Controls
1. In Page view, click the ActiveX tool.

2. Draw a bounding box for the control.

3. The Insert ActiveX Control dialog appears, listing the ActiveX controls currently installed on your 
system. The bottom section shows the filename of the selected control. ActiveX control files have 
an ocx extension.

Select the Set Codebase check box to display the file name of the control in the Codebase field of
the ActiveX properties tab.

4. Click OK.

The Properties palette displays the ActiveX tab for the selected object.

The ActiveX tab displays the parameters for the selected control. 

5. To change a parameter, select it in the ActiveX tab, then edit it in the text field at the top of the tab.

· To accept the text, click the check mark. 

· To cancel the edit, click the X.

· To display more options or the Open dialog, click the Browse icon with three dots when it 
appears next to the text field.

Click Properties... to open a Control Properties dialog where you can edit other parameters for the
selected control. 



About Forms
Forms are an advanced interactive Web element supported by nearly every browser. They allow a site 
visitor to send data to your server, either as a request for more data or as a submission to your server. 
Forms are typically controlled on the Web server by Common Gateway Interface (CGI) scripts. In order to 
use a form element with NetObjects Fusion, you must have a CGI script that tells your server what to do 
with the data it receives. 

CGI scripts run on a Web server as extensions to the server. Not all Web administrators allow their 
customers to install CGI scripts on their servers. Some provide standard CGI scripts for all their 
customers to use. A few do not support CGI at all. For detailed information on CGI support for your server,
please consult your Web server administrator or Internet Service Provider (ISP). 



Choosing Form Elements
Forms can include a variety of form elements: buttons, check boxes, radio buttons, combo boxes, or text 
boxes where site visitors can type information. Site visitors can enter text and select items, then click a 
Submit button to send the data to your server for processing.

Each page can contain one form. Your form can include a variety of elements:

· Buttons, check boxes, radio buttons, and combo boxes to select information. 

· Text boxes where site visitors type information.

· A Submit button to send the form data to the server.

· A Reset button to clear any information a site visitor has entered. 

For more information on buttons see Creating Form Buttons.

Each form element has its own properties tab, where you can configure its actions and attributes.

Browsers display form elements differently, so check your form on all the browsers and platforms you 
want to support to be sure the elements appear correctly. For example, early versions of popular 
browsers use characters to size the width of form elements, while later versions use pixels to size the 
width of form elements. 

The HTML to present forms with a large number of small elements can get very large. You can minimize 
the size of the HTML file NetObjects Fusion generates by:

· Choosing the Rows option for Table Structure in the Layout tab for the form.

· Using the Align Elements option from the Page menu to align form elements.



Naming Form Elements
You set the names for the form elements in the Properties palette for each element. Each CGI script has 
its own element naming conventions. In general, the names cannot include spaces or punctuation. Check 
the documentation for your CGI script for naming conventions.



About Form Buttons
Buttons perform actions when clicked. A NetObjects Fusion button can either submit form data or reset a 
form by clearing any information a site visitor has entered. Every form must have a Submit button to send 
the form data to your server. Generally, every form should also have a Reset button to clear any 
information a site visitor has entered.

NetObjects Fusion provides two methods to create the Submit button:

· The AutoForm tool. Use this method to automatically use the Forms-Handler CGI script provided with 
NetObjects Fusion. 

· The Button tool. Use this method if your form will use either your own CGI script or a CGI script from a
third party.

To learn more about the AutoForm tool, see About the AutoForm Submit Button and related topics.



About the AutoForm Submit Button
The NetObjects Fusion AutoForm component makes it easier to create a working Submit button for a form
when you use the Forms-Handler.cgi script provided with NetObjects Fusion. See About Forms for 
more information on forms.

The NetObjects AutoForm component creates a Submit button that automatically accesses the 
NetObjects Forms-Handler.cgi script, and allows you to edit all required parameters in the Properties 
palette. This is much easier than adding hidden fields and editing Forms-Handler.cgi. 

Before you can successfully test or deploy a form that uses an AutoForm submit button, you must 
configure your server as described in the AutoForm usage note available at 
www.netobjects.com/support.



Adding an AutoForm Submit Button
1. In Page view, display the page containing your form.

2. Click the NetObjects Components tool.

3. In the secondary tool palette, click the AutoForm tool.

4. Drag a rectangle where you want to place the Submit button.

A Submit button appears on the page, and the Component tab of the Properties palette shows all 
the parameters you must set for this button. 

5. To set a parameter, click the parameter, enter the value in the Form Handler text box. Then, for 
Windows, click the check mark or the X mark. For Macintosh, click OK or Cancel.

· Button Name. Name that appears on Submit button. Default is Submit. The button 
adjusts to the text length.

· Success URL. Published URL of success page, for example, 
http://www.myserver.com/formstest/html/success.html. The browser will 
display this page if submission is successful. You must create this page in your site 
before selecting it here. To select the page, click Success URL, and then click the Browse
(...) button display a list of pages in your site, or simply double-click the Success URL 
property to display the Link dialog. In the dialog, select the success page, then click Link 
to return to the Component tab.

· Error URL. Published URL of error page, for example, 
http://www.myserver.com/formstest/html/success.html. The browser 
displays this page if submission fails, usually caused when the site visitor does not fill in a
required field. See Required field # below. You must create this page in your site before 
selecting it here. To select the page, click Error URL, and then click the Browse (...) 
button display a list of pages in your site. Click the error page, and then click Link to 
return to the Component tab.

· Output File. Name of text file on the Web server to which Forms-Handler.cgi will 
write all data submitted through your form. Use any filename that is valid for your server. 
Do not enter path information. NetObjects Fusion automatically creates these folders to 
contain your data:
- For Windows platform servers, this directory is c:\webdata. Make sure this 

directory is created for Forms-Handler.cgi to work correctly.

- For Unix platform servers, this directory is
path_to_yoursite/assets/webdata, for example
/usr/john/public_html/cool/assets/webdata.

· Publish to. Style of script for the platform of the server to which you are publishing. 
Script styles are described in the AutoForm usage note. Double-click to select Unix or 
Windows. If you set this parameter to Unix, you must set the Perl path.

· Perl Path for Unix. Path to Perl application on server, required for Forms-
Handler.cgi. Consult your Internet Service Provider. Required when the “publish to” 
parameter is set to Unix.

· Required field #. This is the true or false setting that specifies whether the visitor must fill
in the selected field. Field names only appear in the AutoForm properties list after you 
correctly name the form elements, and then click the Submit button again. Element 
naming conventions for AutoForm are described in Naming Form Elements.



Creating Form Buttons
1. In Page view, select the Forms tool.

2. Select the Button secondary tool.

3. Draw a button box.

The Button properties tab appears.

4. Enter the name of the button in the Name field. 

Use the name referenced by the CGI script you intend to use. The name you enter cannot include
spaces or punctuation.

5. To label the button, enter text for the label in the Text section.

6. Select the button type, either Submit or Reset.

7. To use a custom image as your button, select the button, then click Browse.…

8. Choose an image file from your hard disk, CD-ROM, or LAN.

9. If your CGI script requires hidden fields, specify them in the Hidden Field. 



Creating Check Boxes
Use check boxes to let site visitors select one or more items from a group of items, or to toggle a single 
item. Check boxes can be either checked or unchecked, and any number of check boxes in a group can 
be checked at the same time. Site visitors can also choose not to select any check box items.

1. In Page view, select the Forms tool.

2. Select the Check Box secondary tool. 

3. Draw a region for the check box.

The Check Box properties tab appears.

4. Enter the name of this check box.

Check the documentation for your CGI script for naming conventions. 

5. Enter a label for this check box. 

This label appears to the right of the check box, and describes the option.

6. Optionally, enter a value for the check box. 

The value will be passed to the CGI script that processes this form. 

7. Enter the default state of the check box.

A check box can be checked or unchecked by default, but the site visitor can click to change it.



Creating Radio Buttons
Radio buttons work like check boxes, except that only one radio button in a group can be selected at a 
time. When a site visitor clicks one radio button, all others in the group are deselected. Since radio 
buttons let site visitors choose only one item from a group, you create group names and assign each 
radio button to a group.

1. In Page view, select the Form tool.

2. Select the Radio Button secondary tool.

3. Create a radio button region.

The Radio Button properties tab appears.

4. In the Group Name field, enter the name of the group for this radio button.

Check the documentation for your CGI script for naming conventions. 

5. Enter a button label in the Button field.

6. In the Value Sent field, enter the value to be sent to your server when the radio button is selected.

7. Set the default state of the button.

One radio button in each group can be selected by default, but a site visitor can select a different 
radio button.

If you later add radio buttons using an existing group name, NetObjects Fusion automatically 
groups the new radio buttons with the existing group.



About Single-Line Text Fields
Text boxes let site visitors enter text data with many possible values, such as names or addresses. 

Single-line text boxes can be as long as you like, but only one line high. For text information that might be 
longer than one line, use the multiple-line text box described in Creating Multiple Line Text Fields.

For data types that have a limited number of possible values, use other form elements such as radio 
buttons or list boxes, which let site visitors select from values available and prevent them from entering 
invalid data.



Creating a Single-Line Text Field
1. In Page view, select the Form tool.

2. Select the Edit Field secondary tool.

3. Draw a form text box.

The Single Line properties tab appears.

4. Enter the name of this text box in the Name field.

Check the documentation for your CGI script for naming conventions. 

5. In the Text field, enter default text, if necessary.

The default text appears in the text box and will be sent back to your server as form data unless a
site visitor changes it.

6. Set the visible length of the box.

This is the number of characters that can be displayed at once in the text box, therefore it is the 
width of the text box itself, measured in characters.

7. Set the maximum length for text in this box.

The maximum length is the total number of characters site visitors can enter. If you enter more 
than the visible length, most browsers will scroll the text box so that the cursor is always visible.

8. If the text box is for sensitive information like a password or credit card number, select Password 
format.

When this option is selected, browsers will not display the entered characters. The site visitor will 
see placeholder characters instead, such as bullets or asterisks. This prevents others from 
obtaining sensitive information by looking over a site visitor’s shoulder or reading an unattended 
screen.

9. To label the text field, use the Text tool to insert text near it on the page.



Creating Multiple Line Text Fields
Multiple-line text boxes can hold more than one line of text. Their properties are just like those of single-
line text boxes.

1. In Page view, select the Form tool.

2. Select the Multi-Line secondary tool.

3. Draw a multiple-line text box.

The Multi-Line properties tab appears.

4. Enter the name of this text box in the Name field.

Check the documentation for your CGI script for naming conventions. 

5. Enter default text, if necessary.

The default text appears in the text box and will be sent back to your server as form data unless 
the site visitor changes it.

6. Set the visible length.

The visible length is the width of the text box in characters.

7. Set the visible height.

The visible height is the height of the text box in characters, or text lines.

8. To label the text field, use the Text tool to insert text beside it on the page.



About Combo Boxes
Use combo boxes to display options too large for a radio box or a check box group. Combo boxes can be 
displayed in two different ways:

· As a scrolling rectangular list, where site visitors click an item to select it.

· As a drop-down menu, where only one item from the list is displayed. This can be expanded into a full 
list by clicking on it. Like radio buttons, drop-down lists can have only one selection at a time.



Creating a Combo Box
1. In Page view, select the Form tool.

2. Select the Combo Box secondary tool.

3. Draw a list box area.

The Combo Box properties tab appears.

4. Enter the name of the combo box. 

Check the documentation for your CGI script for naming conventions. 

5. Click the Dropdown List or List Box option, depending on how you want to display this list box.

6. Set the visible height of the list box.

This option only applies when the List Box option is selected.

7. In the Elements section of the Combo Box properties tab, add or remove list items:

· To add a list item, click the plus sign (+) and enter text.

· To remove a list item, select it and click the minus sign (–).

· To reorder the list, select a list item and use the arrow buttons.

8. If you want to allow site visitors to select more than one item, check Allow Multiple Selections.

This option only applies when the List Box option is selected.



About Hidden Fields
A CGI script might require that you specify several client-side parameters, such as the name of the output
file on your Web server that will contain all the data submitted through your form. You can create these 
fields and enter their values using the Hidden Fields dialog for any form element. These fields apply to the
entire form, so you add them to one form element only. After you fill in the Hidden Fields dialog once, the 
settings appear in the Forms Settings dialog for any element on the form.

Every form requires a Submit button, and NetObjects Fusion provides an automatic Submit button you 
can use on your form. The automatic Submit button is available through the AutoForm NetObjects 
Components tool. The AutoForm Submit button automatically accesses Forms-Handler.cgi, and you 
can edit each required client-side and server-side parameter on the AutoForm Component properties tab. 
Therefore, we recommend that you use the AutoForm tool to create an automatic Submit button. For 
information on the NetObjects Component AutoForm tool, see Adding an AutoForm Submit Button.

For more information on hidden fields, please see Defining Hidden Fields.



Defining Hidden Fields
1. In Page view, select any form element on the form.

2. In the properties tab for the selected element, click the Hidden Fields... button.

The Hidden Fields dialog appears.

· To add a field, click the Plus (+) button, then enter the name and value in the Enter Value 
dialog.

· To remove a field select it, then click the Minus (-) button.

· To move a field up or down in the list, select it, then click the up- or down-arrow.

3. Click OK.



About CGI Scripts
Unless you are using the AutoForm component, you must assign a CGI script to the form. You do this 
through the Form Settings dialog for any form element. The form settings apply to the entire form, so you 
add the script to only one form element. After you fill in the Forms Settings dialog once, the settings 
appear in the Forms Settings dialog for any element on the form.    See Assigning a CGI Script to a Form.



Assigning a CGI Script to a Form
1. In Page view, select the form element.

2. In the Properties tab for the selected element, click the Settings... button.

The Form Settings dialog appears.

3. In the Form Name field, enter a name for this form. 

This is an arbitrary name you assign to the form. It is helpful, for example, if you are writing or 
using a Java applet that references the form.

4. In the Settings section, click Browse… and select a CGI script for the File field.

When you publish your site, NetObjects Fusion uses this path as the source from which to copy 
the script to your server. 

5. In the Action field, enter the URL where your CGI script will reside on your server, for example:
http://www.host.com/myaccount/fusionproject/assets/cgi-bin/myscript.cgi
This URL is the destination on your server for the CGI script file you assigned to your form in Step
4, above. 

The Action setting determines the action of your form’s Submit button. When a visitor clicks 
Submit, the visitor’s browser looks up the URL you specify in the Action setting and executes the 
CGI script it finds there. 

6. In the Settings section, select the Post button.



Using NetObjects Components
NetObjects Fusion Components are pre-built mini applications that add sophisticated and interactive 
functionality to your Web site. You can easily add NetObjects Components to your Web pages without 
custom programming or scripting.

NetObjects Fusion provides the following seven NetObjects Components:

· Rotating Picture, a Java applet that displays images of your choice in a continuous loop. You might 
use this to display rotating advertisement banners.

· Picture Loader, a Java-based applet that loads an image dynamically at browser request from a URL. 
For example, you can display an image from another Web site.

· Time Based Picture, a Java-based applet that displays an image of your choice for a specified period 
of time. You might show different advertisements at different times.

· DynaButtons, Java-based buttons that display primary buttons in a highlighted and non-highlighted 
state, responding to visitor actions like clicking or running the mouse pointer over the button. 
DynaButtons are often used for navigation.

· Ticker Tape, a Java-based applet that gives your Web site visitors a scrolling LED ticker tape 
message. This scrolling can highlight important messages.

· SiteMapper, an advanced Java-based applet that lets you create a map of your site at the click of a 
button. Visitors can use the map to help navigate through the site.

· Message Board, a fully functional threaded message board that lets your customers, vendors, and 
employees interact on your site.

· AutoForm, a FormHandler CGI script that lets visitors to your site send feedback using your Web-
based forms. For more information, see Adding an AutoForm Submit Button.

In addition, NetObjects Fusion gives you access to many more components. Check 
www.netobjects.com regularly for information on new NetObjects Components as they become 
available. Java developers can use the NetObjects Component Development Kit (CDK), available for free 
from NetObjects, to create additional components for incorporation into Web sites. Download the CDK 
from www.netobjects.com/developer/index.html. 

A few of the NetObjects Components require some setup on the server side. Server-side setup is covered
in usage notes at www.netobjects.com/support.



Placing a NetObjects Component
The Tools palette gives you access to the basic set of NetObjects Components. When you select the NFX
Components tool in the primary palette, the six secondary tools in the secondary palette appear. 

Select the NFX Component tool in the secondary palette to bring up the Installed Components dialog, 
which includes the Rotating Picture, Picture Loader, and Time Based Picture components, as well as any 
other components that have been added.

The methods for placing a component and setting its parameters are the same for each component, as 
described in the following steps.

1. In Page view, click the NetObjects Components tool.

2. Select a tool from the secondary palette.

3. Drag a place for the object on your page. 

A placeholder for the object appears, and the Properties palette displays the tab for the selected 
NetObjects Component.

You can use the following methods to edit all NetObjects Components parameters in the Component tab 
for the selected component.

· To edit a parameter, select it, then change it in the text edit field for that component or select a value 
from the drop-down list.

· To enter the edit, click elsewhere, press Enter, or click the Check Mark.

· To cancel the edit, click the X.

· To browse for a file, click the Browse icon that appears when a file or URL field is selected.

· Double-click a parameter to display an appropriate dialog, such as the Image File Open dialog for 
selecting image files, or the Link dialog for specifying URLs.

For information on the Image File Open dialog, see Using the Image File Open Dialog. For more 
information on the Link dialog, see About Creating Links.

Test your components by previewing, staging, or publishing your site. Be aware that if you are using a 
NetObjects Component that requires setup on the server side, such as Message Board or AutoForm, you 
must complete the setup before you can test it.



Adding Rotating Pictures
You can use the NetObjects Fusion Rotating Picture component to display different pictures in succession
in the same place on the page. You specify the image to display, and the number of seconds to pause 
before displaying the next picture in the sequence. You can also assign a link to each picture.

1. In Page view, display the page where you want to place the rotating pictures.

2. Click the NetObjects Components tool, then click NetObjects Components in the secondary tool 
palette. 

3. Draw a rectangle where you want to place the picture.

The Installed Components dialog appears, showing the list of available NetObjects Fusion 
Components.

4. Select Rotating Picture, then click OK.

The placeholder image for rotating pictures appears on your page, and the Properties palette 
displays the Component tab. 

5. Set the Rotating Picture Component parameters:

· Pause Time (Seconds). Set the number of seconds to pause between pictures. For 
example, change this number to 5 to display each picture for 5 seconds.

· Number of Images. Set the number of images to display. The number of parameters 
adjusts automatically.

· Image 1. Double-click to select the first image from the Image File Open dialog.

· URL for Image 1. Double-click to select a link from the Link dialog.

· Image 2. Double-click to select the second image from the Image File Open dialog.

· URL for Image 2. Double-click to select a link from the Link dialog.



Loading External Pictures
Use the NetObjects Picture Loader Component to load an image from an external source, such as 
another Web site. 

When you place the component, a placeholder image appears on your page.

1. In Page view, display the page where you want to place the external picture.

2. Click the NetObjects Components tool, then click NetObjects Components in the secondary tool 
palette. 

3. Drag a rectangle on the page the size of the picture you want to display. The image will 
automatically adjust to the size of this rectangle.

The Installed Components dialog appears, showing the list of available NetObjects Fusion 
Components.

4. Select Picture Loader, then click OK.

The picture placeholder appears on your page, and the Properties palette displays the 
Component tab. 

5. Set the Picture Loader Component parameter:

Image URL. Type the complete URL for the picture, such as 
http://www.netobjects.com/assets/images/picture.gif.

You do not need to add any other tags. NetObjects Fusion generates all the required HTML code.

6. Click the check mark to confirm your URL selection.



Adding Time Based Pictures
You can use the NetObjects Fusion Time Based Picture component to display different pictures in the 
same page location at different hours of the day. You can also assign a link to each picture. You specify 
the image to display and the time to display it, and the browser automatically changes the picture at the 
specified time.

1. In Page view, display the page where you want to place the time based picture.

2. Click the NetObjects Components tool, then click NetObjects Components in the secondary tool 
palette. 

3. Drag a box where you want to place the picture.

The Installed Components dialog appears, showing the list of available NetObjects Fusion 
Components.

4. Select Time Based Picture, then click OK.

The placeholder image for time based pictures appears on your page, and the Properties palette 
displays the Component tab.

5. Set the Time Based Picture Component parameters:

· Number of Images. Set the number of images to display. When you change this setting, 
the number of parameters adjusts automatically.

· Image 1. Double-click to select the first image from the Image File Open dialog.

· URL for Image 1. Double-click to select a link from the Link dialog.

· Start Time for Image 1. This value is always zero, representing 12:00 midnight. Image 1 
is always displayed starting at midnight.

· Image 2. Double-click to select the first image from the Image File Open dialog.

· URL for Image 2. Double-click to select a link from the Link dialog.

· Start Time for Image 2. Click on the Start Time for Image parameter and use the pull-
down menu to select the display time for Image 2. Double-click the parameter to cycle 
through the hours.

 



Adding DynaButtons
You can place DynaButtons anywhere on the page. You can assign up to 20 buttons to a DynaButton bar,
and you can also assign sub-buttons to each DynaButton.

When published, each button appears in the browser in the button style selected for the site, and displays
the name of the page to which it is linked. When a visitor passes the mouse pointer over a DynaButton, it 
appears to be depressed. When a site visitor clicks a DynaButton containing sub-buttons, its sub-buttons 
appear; otherwise the browser opens the button’s URL.

1. In Page view, display the page where you want to place the DynaButton.

2. Click the NetObjects Components tool, then click the DynaButtons secondary tool.

3. Drag a rectangle for the DynaButton.

A button placeholder labeled DynaButton appears on your page and the Properties palette 
displays the Component tab.

4. Set the parameters for the DynaButtons component:

· Orientation. Select Horizontal or Vertical.

· Number of Buttons. Set the number of DynaButtons for this button bar. When you 
change this setting, the number of parameters adjusts automatically.

When you increase the number of buttons, the DynaButton image on the page also 
enlarges.

· Button 1. Double-click to display the Link dialog and select a link target for this button.

· Use Sub-Buttons 1. Select Yes or No. Selecting Yes activates the following parameters.

- Number Sub-Buttons. Set the number of sub-buttons. The number of parameters 
automatically adjusts.

- Sub-Button 1,1. Double-click to display the Link dialog and select a link target for 
this button.

- Sub-Button 1,2. Double-click to display the Link dialog and select a link target for 
this button.



Adding a Ticker Tape Display
You can add a scrolling ticker tape message to your Web page by simply adding the NetObjects Ticker 
Tape component. 

1. In Page view, display the page where you want to place the ticker tape message.

2. Click the NetObjects Components tool, then click the Ticker Tape secondary tool.

3. Drag a rectangle where you want to place the Ticker Tape component. Make the rectangle the 
size you want for the message background.

The ticker tape placeholder appears on your page, and the Properties palette displays the 
Component tab.

4. Set the Ticker Tape properties:

· Number of Messages. Set the number of messages to display in the ticker tape box. 
When you change this setting, the number of parameters automatically adjusts.

· Text for Message 1. Enter the text for the first message.

· URL for Message 1. Double-click to select a link for this message.

· Text for Message 2. Enter the text for the second message, if any. Add periods or other 
characters to the beginning of the second message, or to the end of the first message, to 
separate the messages. Spaces are ignored.

· URL for Message 2. Double-click to select a link for this message.

· Speed. Set the speed for the messages. The default is 12. Higher numbers are faster.

· Frame Color. Select from the list to set the border color of the ticker tape display. The 
default is light gray. Double-click to cycle through the colors.

· Background Color. Set the background color for the ticker tape display. The default is 
black. Double-click to cycle through the colors.

· LED Color. Set the LED color for the ticker tape text. The default is green. Double-click 
to cycle through the colors.



About SiteMapper
SiteMapper is a Java-based navigation application that provides an interactive map for your site visitors. 
When visitors invoke SiteMapper, an additional browser window appears containing a site structure map 
similar to the one you see in the Site view. This allows visitors to jump directly from page to page 
independently of your page navigation controls. If your site is particularly large, SiteMapper can simplify 
site navigation. Visitors can also view the site map in an outline view, as well as search for pages.



Adding a Site Map
1. In Page view, display the home page for the site where you want to include the SiteMapper 

component.

2. Click the NetObjects Components tool, then click the SiteMapper secondary tool.

3. Drag a rectangle for the SiteMapper button.

The button appears on your page, and the Properties palette displays the Component tab.

4. If you like, change the image on the SiteMapper button.

To change the image, double-click it’s name, or click the Browse icon, then select another image 
file from the Image File Open dialog. For information on using this dialog, see Using the Image 
File Open Dialog.



About Message Boards
You can create a Message Board for your site just by adding the NetObjects Fusion Message Board 
component to one of your pages.

 When your site visitors click the Message Board button, the browser opens a new browser window 
displaying the message board.

Visitors can use this message board to read messages organized by Thread, Subject, Author, or Time, 
expand or collapse the view, post new messages, and reply to messages. 

You can have only one Message Board per site. For the Message Board to run properly, your Web server 
must be able to run CGI scripts, and the site visitor’s browser must support the Netscape JavaScript 
standard. Before you can test the Message Board, you must complete the server-side setup described in 
usage notes at www.netobjects.com/support.



Adding a Message Board
1. In Page view, display the page where you want to place the Message Board button.

2. Click the NetObjects Components tool, then click the Message Board secondary tool.

3. Drag a rectangle for the Message Board button. 

The button appears on your page, and the Properties palette displays the Component tab. 

4. Set parameters for the Message Board.

· Subdirectory. Name of Message Board directory on server. Default is bbs. Change this 
name if you want to place the Message Board in a different directory.

· Page Title. Name that appears in the title bar of the browser’s Message Board window. 

· Publish to. Select the platform of your server, Windows, Macintosh, or Unix. 

On Macintosh, Message Board must be published to a Webstar 2.0 Web server, running 
on a PowerPC computer.

· Perl Path for Unix. This is the path to the Perl 5 interpreter on the Unix server, and you 
need it only when publishing to a Unix server. Obtain it from your Internet Service 
Provider. (Or, you can type which perl from a Unix command prompt.)



Adding a NetObjects Component Application
You can add NetObjects mini-applications to the list of installed components.

To learn where to get more NetObjects Components, visit www.netobjects.com.

1. In Page view, click the NetObjects Components tool, then click NetObjects Components in the 
secondary tool palette. 

2. Click anywhere on the page.

The Installed Components dialog appears, showing the list of available NetObjects Fusion 
Components.

3. Click Add....

The Install Components dialog appears.

4. Select a component with the extension .nfx or .class, then click Open.

The new component now appears in the list.

5. Select the component and click OK.

The new component appears on your page.



Advanced Scripting
NetObjects Fusion is extensible, which means that it can support HTML tags and scripts not specifically 
handled by the Tools palette. You can use NetObjects Fusion client-side scripting to insert HTML, Visual 
Basic scripts, and JavaScript™ scripts. This type of scripting reduces the strain on your Web server 
(server side) because all the code is executed on the computer of your site visitor (client side).

To use the advanced scripting feature, you must be familiar with HTML and the scripts you intend to use. 
Consult www.netobjects.com for usage notes on scripts.

NetObjects Fusion offers two kinds of scripting:

· Layout scripts 

· Element scripts 

For both types of scripts, you can add variables; cut, copy, or paste variables from other scripts; and, 
insert an existing text file containing scripts.    



About Layout Scripts
A layout script inserts information in three locations of the page’s final HTML file. Use layout scripts to add
meta-information to a page, define script functions that will be referenced in the body of the page, or 
include other scripts that run when the document loads.

NetObjects Fusion provides three ways to attach scripts to your pages:

· Layout scripts: When you attach a script to the layout page, the script applies to the current page only.

· Master scripts: When you attach a script to a MasterBorder, the script applies to all the pages with that 
MasterBorder style. For details on the MasterBorder feature, see Managing MasterBorders and 
Optimizing Layouts.

· Frame scripts: When you attach a script to an AutoFrame, NetObjects Fusion places the script in the 
content page for that AutoFrame. If you convert the AutoFrame back to a MasterBorder, any script 
attached to the AutoFrame is deleted. See Using AutoFrames for details on AutoFrames.

The procedure, described below, for adding the three types of scripts is the same. The only difference is 
where and how you access the Layout Script dialog.



Using a Layout Script
1. In Page view, open the Layout Script dialog using one of these methods:

· Layout scripts: Choose Layout Script… from the Page menu, or choose Layout Script… 
from the pop-up menu in the layout area.

· Master scripts: Choose Master Script… from the pop-up menu in the MasterBorder 
area, or click the Script... button on the MasterBorders tab.

· Frame scripts: Choose Frame Script... from the pop-up menu in the AutoFrame area, or 
click the Script... button on the Frame tab. .

The Layout Script dialog appears.

2. In the dialog, click the field in which you want to place your HTML code.

· When you place HTML code in the Inside Head Tag field, NetObjects Fusion adds as a 
new line between the <HEAD> tag and the </HEAD> tag. Use this field only to add 
complete and valid tags into the <HEAD> area.

· When you place HTML code in the Inside Body Tag field, NetObjects fusion adds it inside 
the <BODY> tag, just before the closing bracket. Use this field only to add attributes for 
the <BODY> area.

· When you place HTML code in the Beginning of Body field, NetObjects fusion adds it on 
a new line just after the <BODY> tag. Use this field to enter complete tags and scripts.

3. Place your HTML or script in the selected field by one of these methods:

· Key-enter HTML or script text.

· Click Insert and select an HTML or script file (ASCII text format) from your hard disk, CD-
ROM, or LAN.

· Paste in HTML or script text you’ve copied to the Clipboard from another application.

HTML code gets inserted exactly as typed. This means that in the <BODY> section, scripts must 
include the <SCRIPT> and </SCRIPT> tags. If it is unclear how the code is being inserted, try 
previewing the site and looking at the source.

You can also use the Cut, Copy, Paste, and Undo buttons or their standard keyboard equivalents 
to edit text in any field.

4. Click the Variable... button to insert a variable.

To learn how, see Inserting Variables.

5. Click OK.



About Element Scripts
Element scripts control individual content elements by placing HTML or scripting information in the 
<BODY> region of the final HTML file. You can use element scripts with any content elements, whether 
they are located in the MasterBorders or Layout area of a page. Element scripts can contain HTML code 
for an element, or scripting information that controls the element. For example, you can add HTML tags or
options not directly supported, or call a JavaScript routine.

A common use for the Before and After scripts is to link an image to a JavaScript. In the Before Script, 
one would start the link:

<A HREF=”#” ONCLICK=”MYSCRIPT”>
In the After Script, one would close the link: </A>.

To add HTML elements not directly supported by NetObjects Fusion, create an empty text element and 
enter HTML in the Before Element scripting field.



Using an Element Script
1. In Page view, select the content element to which you want to apply a script.

2. Open the Element Script dialog by one of these methods:

· Click Script, in the properties tab for the selected element.

· Right-click the element and choose Element Script... from the pop-up menu.

· Choose Element Script from the Page menu.

The Element Script dialog appears.

3. In the dialog, click the field in which you want to place your HTML code.

· When you place HTML code in the Before Element Tag field, NetObjects Fusion adds it 
on the line before the opening tag for the element. Typically you use this field to add 
opening tags for HTML that will affect the element, or to add complete scripts.

· When you place HTML code in the Inside Element Tag field, NetObjects fusion adds it 
just before the closing bracket of the element’s opening tag. Use this field only to add 
attributes for the element.

· When you place HTML code in the After Element Tag field, NetObjects fusion adds it on a
new line just after the element’s closing tag. Typically you use this field to enter closing 
tags to match any opening tags you entered in the first scripting field.

4. Place your HTML or script in the selected field by one of these methods:

· Enter HTML or script text.

· Click Insert and select an HTML or script file (ASCII text format) from your hard disk, CD-
ROM, or LAN.

· Paste in HTML or script text you have copied to the Clipboard from another application.

HTML code gets inserted exactly as typed. This means that you must always include the 
appropriate opening and closing tag pairs. If it is unclear how the code is being inserted, try 
previewing the site and looking at the source.

You can also use the Cut, Copy, Paste, and Undo buttons or their standard keyboard equivalents 
to edit text in any field.

5. Click the Variable... button to insert a variable.

To learn how, see Inserting Variables.

6. Click OK.



Using Scripts for Dynamic Data Publishing
A common use of element scripts is to link databases to Web pages for dynamic publishing. Many 
vendors offer database-to-Web scripting products such as Netscape LiveWire, Bluestone Sapphire/Web, 
Tango from EveryWare, and Cold Fusion from Allaire. 

Each scripting product offers different features and capabilities, but all the products work essentially the 
same way. They use proprietary scripting languages and a server-side scripting engine to link your Web 
page to a database when requested by a browser. 

To incorporate dynamic publishing: 

1. Draw an empty Form Edit Field for each database field to be displayed dynamically. 

These form fields translate into simple HTML table cells at publish time. 

2. Attach an element script to each form field by clicking Script in the properties tab of the field.

Enter the script in the Inside Element Tag field of the Element Script dialog. Once the site is 
staged or published to a server that supports the scripting engine, the database fills each element
with content. When a browser requests a page containing a database-scripted HTML table, the 
server-side scripting engine fills the proper table cell with nested HTML or data from the 
database. 

The text block is constrained on the top, left and right, so if the database provides more 
information than the text block can contain, the text block grows down. 



Important Note on Adding JavaScript
The JavaScript methods document.write() and document.writeln() will not work in Netscape 
browsers when your pages are generated with a nested table structure. (NetObjects Fusion 2.0.x offers 
Table Structure options in Layout and Frame properties – see Choosing a Preferred Table Structure for 
more information.)    To disable nested table structure generation, simply add a special comment to your 
Layout or MasterBorder script before your JavaScript.    In a layout script, the comment <!--
NOSMARTTABLES--> will disable the nested table structure generation for that page; in a master script, it
will disable nested table generation for all pages using that MasterBorder.    The comment is available in a
text file called comment.txt, located in the /NetObjects System folder in NetObjects Fusion 2.0.x. 

To ensure that your JavaScript will work inside NetObjects Fusion table structures, please follow this 
procedure:

1. Right-click on the MasterBorder or Layout you wish to add JavaScript to

2. Choose Master Script or Layout Script from the pop-up menu

3. Click in the BEGINNING OF BODY field in the Script dialog box

4. Click the Insert button at the top of the dialog box

5. Select    comment.txt from the /NetObjects System folder

6. Click OK

Alternatively, you may simply type <!--NOSMARTTABLES--> to accomplish steps 4-6

7. Add your document.write() or other JavaScript after this comment

8. Click OK



Using Scripted Frames
A frame is an area of a page that contains content independent from the rest of the page. When a site 
visitor scrolls another part of the page, the frame content does not move. Frames are a popular device to 
help visitors navigate a site. For example, many sites use two frames: one to display menu pages and 
another to present links to other areas and pages within the site. 

NetObjects Fusion 2.0 supports two ways to create frames:

· AutoFrames

· Scripted frames

Use NetObjects Fusion AutoFrames feature to add frames to MasterBorders with a single click, and then 
add navigation controls, banners, text, graphics, and links. This is the easiest and most convenient way to
create frames.

Using NetObjects Fusion’s scripting interface, you can manually code frames using the HTML page 
description language. This method requires knowledge of HTML codes and the NetObjects Fusion script 
interface, and is no more complicated than creating frames in an HTML editor. This section gives an 
overview and example of how you can script a simple frame. 

With frames, content can appear in several different rectangles that divide the browser’s window into a 
patchwork of individual pages. The frames form a top-level page called a frameset (in HTML). 

Within a frameset, each frame has characteristics of a page. When viewing a frameset, a site visitor can 
drag frame borders and scroll frame contents to view information. Clicking on a link within a frame can 
bring up new information within the frame or in a different frame. Or, clicking a link can bring up an entirely
different page to replace the frameset.



About Framesets
To define a frameset, first, add the frameset page, which serves as the top-level page and contain the 
frames. You can add the frameset page anywhere, but make sure its location makes sense within the 
organization of your site. What makes sense probably depends on how you want your site visitor to enter 
the frameset. For example, if you want the visitor to enter the frameset using standard NetObjects Fusion 
navigation aids, add your frameset page as a sibling of the other pages on the navigation bar. 



Defining Framesets
1. Create and name your page in the Site view.

2. Double-click the page to open it in the Page view. 

3. Choose Layout Script from the Page menu. 

4. In the Inside Head Tag field, enter the HTML that defines the page as a frameset and the names 
of the frames it contains.

The src attribute of the <frame> tag instructs the browser where to find the frame’s content: an 
HTML page file. 

The source file names must match names of the pages that hold your content. After creating the 
content pages, you can determine their exact names by previewing your site and checking their 
names in your browser’s view of the HTML source. If the source file names you specify do not 
exactly match the page names NetObjects Fusion creates for your content pages, you might 
encounter difficulties when staging or publishing your site.

You can enter the source for your frames as a relative path (./menu.html) because NetObjects 
Fusion puts all pages except the Home page in the same HTML folder. This means the source 
document for each frame is always in the same directory as the page defining the frameset. If the 
Home page is the frameset, refer to the sub-pages as ./html/page.html.

5. Click OK.

All elements placed on a frameset page, including the banner and navigation bars, are completely
covered by the frames. This limits a visitor’s ability to navigate out of the frameset page.



Creating Frame Content 
Once you have defined your frameset, create the content for each of your frames.

1. Add a page to your site and lay out its content. Consider these issues during your design:

· If you want the frameset to be the only way a site visitor can access the pages in the 
frames, organize the content pages as children of your frameset page.

· This simplifies managing NetObjects Fusion’s automatic navigation links, whether your 
design uses them or not.

· Within a frame-content page, create links to other pages. To learn how to control where 
the linked information appears.

· Plan your links. Include links only to those pages designed to be displayed in your frame. 
If you don’t want your frames to show banners and navigation bars, create a new 
MasterBorder for those frame content pages and remove their banners and navigation 
bars.

2. Click Preview in the control bar to preview your site in your browser.

3. Check the behavior of all links. 

The frameset previewed below uses the example HTML shown in the previous section. The 
designer laid out content pages and implemented links so that when the site visitor clicks on a 
thumbnail picture in the bottom menu frame, the top main frame displays the full-size image.



Creating Targeted Links
When a site visitor clicks a link within a frame, the linked information can appear in one of three places:

· The current frame 

· The frame specified as the default for viewing all links launched from a frame-content page

· A frame identified for viewing this link

Unless you specify otherwise, when a site visitor clicks a link, the linked page appears in the frame where 
the visitor clicked the link. You can choose between two kinds of targeted links to override this, both 
described in the following sections.

Default Target Frame 

Specific Link Target 



Default Target Frame
To create a frameset with one frame displaying content and the other presenting navigation links, specify 
the display frame as the default for viewing all links launched from the navigation frame. 

To do this, place a <base> tag in the Layout Script in the Inside Head Tag field of the navigation frame’s 
content page. For example, inserting the following (in the Inside Head Tag field of the page) displays the 
linked information in the main frame when a site visitor clicks a link in the menu frame.
<base target="main">
This displays the linked information in the main frame when a site visitor clicks a link in the menu frame.



Specific Link Target
Use the External Link tab in the Link dialog to set a target frame for a specific link. You can also use the 
External Link tab to create a link to a page internal to your site as described below.

1. Select the object or text to be linked.

2. Click the Link button at the bottom of the Properties palette.

The Link dialog appears.

3. Click the External Link tab.

4. In the URL field, delete http://, and then specify the page to link to and the name of the frame that 
should display it; for example:

page.html"target="name 
In the above statement, page.html is the path to your document. If the link is to a page within your
site, use a relative path. Instead of name, type in the name of the frame, where the linked frame 
should appear.    If you are using AutoFrames see Defining a Frameset Using an AutoFrame for 
information on AutoFrame naming conventions.

Do not type quote marks at the beginning and end of text in the URL edit box. NetObjects Fusion 
automatically encloses the text with quotes.

To create a link that leaves the frameset and displays the linked page in the full browser window, 
follow the steps above but type the following in the URL edit box:

page.html"target="_top
5. Click Link to close the dialog and create the link.

You can use a specific link target in conjunction with the default target link because the specific 
will override the default. 



Supporting Non-Frame Browsers
If your browser does not support frames, you can create alternate content for the browser.

1. When defining the frameset, replace the closing </frameset> tag with the <noframes> tag.

2. In the page containing the frame content, design the page as you want it to appear in the browser
that does not support frames.

3. At the very bottom of your layout, create an empty text box. If you are using a MasterBorder, 
make sure you place the text box below all MasterBorder content.

4. Right-click the text box and choose Element Script... from the popup menu. 

5. Enter the following script in the After Element field:
</td></tr></table></noframes></frameset>

6. This leaves some unorthodox HTML at the bottom of your document, so be sure to test the page 
with the browsers you want to support before publishing.



Behind the Scenes with AutoFrames
If you have been creating frames using HTML tags in NetObjects Fusion’s scripting interface or in an 
HTML editor, you might want to know how an AutoFrame differs from a scripted frame at the HTML level 
before you choose to use an AutoFrame. This section describes the differences, and tells how to add links
to AutoFrames.

When you create a scripted frame, you first create a page that defines the frameset. Then, you create 
content pages that appear within the frames. Within the content pages, you can set up targeted links that 
specify which frame will display the target of links launched from that content page. For example, in the 
content page for a frame that presents navigation aids, you would use a <base> tag to specify a different 
(and probably larger) frame as the default for displaying the targets of any links launched from the 
navigation frame.

Defining a Frameset Using an AutoFrame 

AutoFrames and Links 

Creating a Link to be Displayed in a Frame 

Displaying the Linked Page in the Full Browser Window 

Creating a Link to a New Browser Window 



Defining a Frameset Using an AutoFrame
1. Choose the MasterBorder style that will define your frameset.

If you are starting a new blank site and want all pages to share the same frameset, simply modify 
the Default MasterBorder style. If you want your site to present multiple framesets, you must 
create a new MasterBorder style for each frameset.

2. Convert at least one MasterBorder margin to an AutoFrame by clicking the appropriate button on 
the MasterBorders tab of the Properties palette. 

3. Use margin settings to specify the width of your frames.

If you selected the Auto-resize margins option in the Page tab of the Preferences dialog, drag the 
margin borders to size the AutoFrame. 

4. Specify the content for each frame.

You can do this more efficiently for an AutoFrame than for a scripted frame because you don’t 
have to create a separate content page. Just place the elements in the applicable frame in the 
MasterBorder. 

Behind the scenes, NetObjects Fusion sets up the frameset with the specified AutoFrame and a body 
frame with the same name as the MasterBorder. When you create additional NetObjects Fusion pages 
and assign them the MasterBorders with AutoFrames, each page is a new content page for the body 
frame. 

The source for each AutoFrame has a fixed name, regardless of the Frame name specified in the Frame 
tab of the Properties palette.    The following table shows the attributes inside the Frame tag defining the 
names and source filenames for the five possible frames generated by AutoFrames (the Layout region is 
effectively a frame), for a home page "index.html".    This frame naming convention is true for all 
AutoFrames.

Left Frame NAME="left"      SRC="./left_index.html"
Right Frame NAME="right"    SRC="./right_index.html"
Top Frame NAME="header" SRC="./header_index.html"
Bottom Frame NAME="footer" SRC="./footer_index.html"
Layout Frame NAME="body"      SRC="./body_index.html"

Note: This method of naming framesets is new to NetObjects Fusion 2.0.2.    Targeted frame links created 
in earlier versions of NetObjects Fusion 2.0 may no longer work when the site is upgraded to NetObjects 
Fusion 2.0.2.    All broken links will need to be updated.



AutoFrames and Links
When you click a link in an AutoFrame, the browser either refreshes the Body frame or the entire page, 
depending on the number of AutoFrames and the content of the page:

· The browser refreshes only the Body frame if the link references a NetObjects Fusion page that shares
the same MasterBorder as the current page and the following conditions are met:

- The shared MasterBorder includes one AutoFrame, and the AutoFrame does not contain any 
dynamic content, such as a banner or navigation bars.

- The shared MasterBorder includes two parallel AutoFrames (top and bottom or left and right) and the
AutoFrames do not contain any dynamic content, such as a banner or navigation bars.

· The browser refreshes the entire page if:

- The shared MasterBorder includes perpendicular AutoFrames.

- The shared MasterBorder includes three or four AutoFrames.

Note: If the link references a page that does not share the MasterBorder, or references an external HTML 
page, the browser exits the frameset and displays the target page in the full browser window. 

If you are accustomed to scripting frames, you might want to create a second content page to be 
displayed within the navigation frame or create a button that displays a different navigation bar within an 
AutoFrame. Even though each AutoFrame permits only one content page, you can workaround this using 
these options:

· Create a second MasterBorder identical to the first except for the content, then link your button to a 
page with the second MasterBorder. 

· Link the frame to be updated.



Creating a Link to be Displayed in a Frame
1. In your AutoFrame, add the picture or text to be linked. 

2. Click the Link... button on the element tab on the Properties palette.

3. Select the External Link tab.

4. In the URL edit box, enter the location to link to and the name of the frame the link will open. For 
example:
www.netobjects.com"target="body
· Use a relative path if the link is to a page within your site.

· Use the name of the AutoFrame (see table in Defining a Frameset Using an AutoFrame) 
to open the link in an AutoFrame.    If you want the link to open in the body frame, for 
example, the target would be body.

The target name is case sensitive. Do not type quote marks at the beginning or end of text in the 
URL edit box. NetObjects Fusion automatically encloses the text with quotes.

5. Press the Link button to close the dialog and create the link.

6. Preview your page and test the link.



Displaying the Linked Page in the Full Browser Window
1. In your AutoFrame, add the picture or text to be linked. 

2. Click the Link... button on the element tab on the Properties palette.

3. Select the External Link tab.

4. In the URL edit box, enter the location to link to and the name of the frame the link will open. For 
example:

page.html"target="_top



Creating a Link to a New Browser Window
1. In your AutoFrame, add the picture or text to be linked. 

2. Click the Link... button on the element tab on the Properties palette.

3. Select the External Link tab.

4. In the URL edit box, make sure http:// is selected, and then enter:

www.domain.com"target="nameofwindow
In the above statement, nameofwindow is the name of the browser window. This name must not 
match an existing frame name. The browser will first look for a frame with the specified name, if it 
finds none, it will then open a new instance of itself and display the target in it.

5. Press the Link button to close the dialog and create the link.

6. Preview your page and test the link.



Please select an individual button, option or control and right-click “What’s This” to view context-sensitive help for that control.



 New Site. Opens the New Site dialog, where you name and select a location for your new web site. You have the option to base
your site on an AutoSite™ or other NetObjects Fusion template, or from a pre-existing web site, either local or remote, which is 
imported into the NetObjects Fusion format. 



 Open Site. Opens a standard Windows file Open dialog box to let you locate and open an existing NetObjects Fusion web site 
(.nod) file. 



 Save Site. Saves the current site to disk in NetObjects Fusion format, as a .nod file.



 Save As. Opens a dialog that lets you choose a new name and/or location for the current site.



 Import Section. Opens the Import Section dialog box to let you import templates (such as NetObjects' pre-defined Page 
templates) or web sites (local or remote) into the current site (in Site view). 



 Export Template. Opens the Select Folder dialog box which lets you save the current NetObjects Fusion web site as a template
(.nft) file so that it can be imported into another NetObjects Fusion web site (necessary when developing across platforms).



 Export Page. Opens a save dialog that lets you save the current page as an HTML file.



 Import Section (in Site view).    Opens the Import Section dialog box to let you import templates (such as NetObjects' pre-
defined Page templates) or web sites (local or remote) into the current site. 
Import Page (in Page view).    Imports an existing document, which may be HTML (*.htm or *.html), Text (*.txt) or Rich Text 
Format (*.rtf) files. 
Import Style (in Style view).    Opens a standard Windows file Open dialog box to let you locate NetObjects Fusion SiteStyles 
(Style.ssf files) to add to your SiteStyle list (Style Gallery in Style View).    



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Exit. Closes (and saves) the current site and exits NetObjects Fusion.



 Undo. Undoes the last command or action (displayed with the menu item) to the previous state.    Multiple levels are possible. 



 Cut. Cuts the selected element from the page and places it on the Windows clipboard. The element is then available for pasting 
to the same page or another page in your site until it is replaced on the clipboard by another Cut or Copy operation.



 Copy. Copies the selected element and places it on the Windows clipboard. The element is then available for pasting to the 
same page or another page in your site until it is replaced on the clipboard by another Copy or Cut operation.



 Paste. Pastes the contents of the Windows clipboard onto the current page.



 Paste Special. Opens a window that lets you paste, link or embed special types of elements from the Windows clipboard. 
These special OLE (Object Linking and Embedding) elements are from other OLE-capable Windows applications, and are 
placed on the clipboard by copying them from the other application.



 Delete (element). Lets you delete an element from your site. What gets deleted depends on which view you're in:
Delete Page. Removes the selected page or    pages from the site structure when in Site view.
Delete Element. Removes the selected object or objects from the page when in Page view.
Delete File Asset. Removed the selected file when in File Assets view.
Delete Link. Removes the selected link when in Link Assets view.
Delete Data Object. Removes the selected data object when in Data Object Assets view.
Delete Variable. Removes the selected variable when in Variable Assets view.



 Select All. Selects all objects in the header, body, or footer of a page in Page view.



 Find. Searches for specified text on a page.



 Replace. Searches for and replaces specified text or formatting in the active document.



 Delete (element). Lets you delete an element from your site. What gets deleted depends on which view you're in:
Delete Page. Removes a page from the site structure.
Remove Style. Removes the currently selected style when in Style view.



 Options. 



 Preferences. Opens the Preferences dialog box which has two tabs, General and Page.    General preferences include selecting
a default browser and external HTML editor; Page preferences include setting the default page size and other page-level options.



 Duplicate Layout. Makes a copy of a page’s layout and lists it in the Layout dropdown list.



 Properties Palette. Toggles between viewing and hiding the floating Properties palette box.



 Tools Palette. Toggles between viewing and hiding the floating Tools Palette.



 Align Elements: Left. If more than one object is selected, this command aligns the objects to the left edge of the last object 
selected. For example, if you select three objects and then choose this item, the first two objects selected are repositioned so the
left edges of their bounding boxes line up with the third object's left edge.



 Align Elements: Right. If more than one object is selected, this command aligns the objects to the right edge of the last object 
selected. For example, if you select three objects and then choose this item, the first two objects selected are repositioned so the
right edges of their bounding boxes line up with the third object's right edge.



 Align Elements: Top. If more than one object is selected, this command aligns the objects to the top edge of the last object 
selected. For example, if you select three objects and then choose this item, the first two objects selected are repositioned so the
top edges of their bounding boxes line up with the third object's top edge.



 Align Elements: Bottom. If more than one object is selected, this command aligns the objects to the bottom edge of the last 
object selected. For example, if you select three objects and then choose this item, the first two objects selected are repositioned
so the bottom edges of their bounding boxes line up with the third object's bottom edge.



 Align Elements: Center Vertically. If more than one object is selected, this command centers the objects in relation to the 
horizontal position of the last object selected. For example, if you select three objects and then choose this item, the first two 
objects selected are horizontally repositioned so they are centered in relation to the third object.



 Align Elements: Center Horizontally. If more than one object is selected, this command centers the objects in relation to the 
vertical position of the last object selected. For example, if you select three objects and then choose this item, the first two 
objects selected are vertically repositioned so they are centered in relation to the third object.



 Size Elements: Width. If more than one object is selected, this command resizes the objects to match the width of the last 
object selected. For example, if you select three objects and then choose this item, the first two objects selected are resized 
(equidistant from the outer edges inward) to match the width of the third object.



 Size Elements: Height. If more than one object is selected, this command resizes the objects to match the height of the last 
object selected. For example, if you select three objects and then choose this item, the first two objects selected are resized 
(equidistant from the top and bottom edges inward) to match the height of the third object.



 Size Elements: Both. If more than one object is selected, this command resizes the objects to match the height and width of 
the last object selected. For example, if you select three objects and then choose this item, the first two objects selected are 
resized (equidistant from all outer edges inward) to match the exact size of the third object.



 Element Script. Opens the Script dialog to let you enter or insert HTML tags or scripts that are inserted into the raw HTML 
source. 



 Layout Script. Opens the Script dialog to let you enter or insert scripts or HTML tags that are added to the HTML source of the 
page.



 Site. Takes you to the Site view where you build, organize and edit the structure of your site. As you drag pages and sections to 
new locations in your site, NetObjects Fusion updates all the links automatically.



 Style. Takes you to the Style view where you have centralized control over the look and feel of your site.



 Assets. Takes you to the Assets view that lists all the files, links, data objects and variables that are associated with your site. 
This view allows for site-wide asset management.



 Publish. Takes you to the Publish view where you configure your settings for staging or publishing your site to a local or remote 
web server.



 Next Page. Takes you to the page that appears to the right of the current page (on the same level) in the graphical site view.



 Previous Page. Takes you to the page that appears to the left of the current page (on the same level) in the graphical site view.



 Parent Page. Takes you to the page that appears above the current page in the graphical site view.



 First Child Page. Takes you to the page that appears below the current page (the next child level) in the graphical site view.



 New (element). Lets you add a new element to your site. What gets added depends on which view you're in:
New Page. Lets you add a new page to your site when you're in Site or Page view.
New Style. Lets you create a new style when you're in Style view.
New File Asset. Lets you import a new external file such as a picture or a Java applet, when you're in File Assets view.
New Link. Lets you add a new external link when you're in Link Assets view.
New Data Object. Lets you create a new data object when you're in Data Object Assets view.
New Variable. Lets you add or create a new variable when you're in Variable Assets view.



 Go To. Opens a dialog box that lets you perform a keyword search for items within the current view, such as an individual page 
in Site view or SiteStyles in Style view.



 Last. Lets you toggle between the current    view and the last one that was displayed.



 Recent. Opens a scrollable selection list of views and pages that have been displayed during the current NetObjects Fusion 
session.



 Help Topics. Opens the NetObjects Fusion Help Contents dialog. Launches your browser to view the table of contents for the 
online Getting Started Manual.    This document is in HTML format.



 About NetObjects Fusion. Opens the NetObjects Fusion version information box.



 Getting Started. Introduces you to the NetObjects Fusion Help system.    Links to the online Getting Started Manual and 
NetObjects web site by launching your browser.



 Preview. Creates HTML files and auto-generated images for every page in your site and places them in a Preview folder on 
your hard disk. Also opens your default browser to let you view either the entire site or the current page.



 Files. Shows you a list of files (such as pictures, audio, video, external HTML documents, Java applets, etc.) that are associated
with your site. You can use the list to manage these files and their associations.



 Data Objects. Shows you a list of data objects that are associated with your site. Data objects define data-based information 
from either internal or external sources You can use the list to remove the data object from your site or edit the data object 
definition.



 Text properties. 



 Layout properties. 



 Picture properties. 



 Links. Shows you a list of page, smart, and external links that are associated with your site, as well as the page or pages on 
which each link appears.



 Page. Takes you to the Page view where you lay out your pages and add content. Content includes: text, pictures, drawn 
shapes, tables, sound, video, Java applets, Active X controls, Shockwave files, data-based information and form elements.



 Style. Takes you to the Style view where you create, manage and browse the SiteStyles available for use within your site.



 Site Structure View. Switches you to a graphical view of your site. You can use this view to rename pages, add new pages and 
delete pages from your site. You can also expand and collapse the structure and color code individual pages.
Style Gallery.    Lists all the SiteStyles™ that can be applied to your site, along with a preview pane that lets you examine the 
various components that make up the style. To edit any style or component, click Components.



 Site Outline View. Switches you to a tree view of your site in which you can expand and collapse the structure at any level. You 
can also review site management information about each page, such as the names of child pages, page type, status, and 
comments.
Style Components. Opens a list of elements that make up the current style. You can select and Edit any of these components 
and immediately see the results in the preview pane. To switch back to the site selection list, click Style Gallery. 



 To view help on individual buttons, controls or elements, right-click on the item and choose "What's This" or "Help" from the pop-
up menu.



 To view help on individual buttons, controls or elements, right-click on the item and choose "What's This" or "Help" from the pop-
up menu.



 HID_NEWPUBLISHINGSET. 



 HID_POPUP_MENU. 



 HID_VIEW_AUTOSIZE. 



 HID_INDICATOR_DATE. 



 HID_INDICATOR_TIME. 



 Choose this option if you want a solid color background on this page.



 Click this button to go to the next page within this stacked page.



 Click this button to add a current page within this stacked page.



 Click this button to delete the current page within this stacked page.



 HID_SECTION. 



 HID_NEW2. 



 Settings... Opens a dialog that allows for configuring your settings for local or remote staging or publishing. Also allows for 
choosing modifiers: text only, greyscale, and low-bandwidth versions.



 Stage. Stages your site by writing HTML, assets and other files to your hard disk or a server that has restricted access.



 Publish. Publishes your final site by writing HTML, assets and other files to your hard disk or a web server.



 When checked, borders are displayed around objects such as text blocks, draw objects, data fields, and so on, in Page view.    
This option is also found on the View menu.



 HID_DRAW_SELECTION. 



 HID_DRAW_RECT. 



 HID_DRAW_ROUNDRECT. 



 HID_DRAW_LINE. 



 HID_DRAW_ELLIPSE. 



 HID_DRAW_TEXT. 



 HID_DRAW_PICTURE. 



 HID_DRAW_POLYGON. 



 HID_DRAW_OLE. 



 HID_DRAW_JAVA. 



 HID_DRAW_DBLIST. 



 HID_DRAW_DBFIELD. 



 HID_DRAW_FORMBUTTON. 



 HID_DRAW_FORMRADIO. 



 HID_DRAW_FORMCHECKBOX. 



 HID_DRAW_FORMEDIT. 



 HID_DRAW_FORMPSW. 



 HID_DRAW_FORMCOMBO. 



 HID_DRAW_FORMCLEAR. 



 HID_DRAW_ZOOMIN. 



 HID_DRAW_ZOOMOUT. 



 HID_DRAW_TABLE. 



 HID_DRAW_GRAPHIC. 



 HID_DRAW_HOTSPOTRECT. 



 HID_DRAW_HOTSPOTROUNDRECT. 



 HID_DRAW_BACKGROUNDPICKER. 



 HID_DRAW_SHOCKWAVE. 



 HID_DRAW_SOUND. 



 HID_DRAW_VIDEO. 



 HID_DRAW_ACTIVEX. 



 HID_DRAW_FORMMULTIEDIT. 



 HID_CANCEL_EDIT_CNTR. 



 HID_VIEW_GRID. 



 HID_VIEW_ZOOM_IN. 



 HID_VIEW_ZOOM_OUT. 



 HID_PAGE_NEWPAGE. 



 HID_PAGE_DELETEPAGE. 



 HID_OBJECT_LINECOLOR. 



 HID_VIEW_DIAGONAL. 



 HID_OBJECT_FILLCOLOR. 



 HID_VIEW_VERTICAL. 



 HID_OBJECT_MOVETOFRONT. 



 HID_OBJECT_MOVEFORWARD. 



 HID_INDEX. 



 HID_VIEW_PAPERCOLOR. 



 Click this button to go to the previous page within this stacked page.



 HID_NEW_CHILD. 



 HID_NEW_SIBLING. 



 HID_PREVIEW. 



 HID_OPEN_NODE. 



 HID_OBJECT_FONT. 



 HID_OBJECT_FILLCOLOR2. 



 HID_OBJECT_LINECOLOR2. 



 HID_OBJECT_FONT2. 



 HID_FONT_BOLD. 



 HID_FONT_ITALICS. 



 HID_FILE_SUMMARYINFO. 



 HID_FONT_UNDERLINE. 



 HID_FONT_TEXTCOLOR. 



 HID_STYLE_LEFT. 



 HID_STYLE_CENTER. 



 HID_STYLE_RIGHT. 



 HID_TEXT_BULLET. 



 HID_LAYOUT_FONT. 



 HID_LAYOUT_TITLE. 



 HID_LAYOUT_PICTURE. 



 HID_LAYOUT_COLOR. 



 HID_LAYOUT_FIXEDFONT. 



 HID_OBJECTDEFINITION. 



 HID_NEWPUBLISHSET. 



 HID_SETPUBLISHSET. 



 HID_PUBLISH_NEWPUBLISHSET. 



 HID_AlLIGNOBJECTS. 



 HID_ASSIGNLAYOUTS. 



 HID_ALIGN_HORIZONTAL. 



 HID_INSERTSECTION. 



 HIDM_BROWSER_OPTIONS. 



 Indents text within a text box.



 Unindents text within a text box.



 Counts words, lines, paragraphs and characters within a single text box or on the whole page.



 Provides a dialog box for you to select ASCII characters (such as © or ™) from a list and insert them into the selected text block.



 HID_FILE_DUMPHTML. 



 HID_DRAW_SELECT. 



 HID_DRAW_POLY. 



 HID_LAYOUT. 



 HID_OUTLINE. 



 HID_DELETE. 



 HID_TOP_LEVEL_MENUS. 



 HID_OBJECT_COMMENTS2. 



 This option allows you to set the start value of a numbered list when the selected text block uses the numbered list (also called 
ordered list) paragraph style. 



 HID_ADDSTYLETOLIST. 



 Help Overview. Explains how to get help with NetObjects Fusion by launching your browser and opening a locally installed 
HTML file.



 HID_INDICATOR_ZOOM. 



 HID_INDICATOR_POSITION. 



 HID_INDICATOR_CUROBJ. 



 HID_ERR_LAYOUTTOOSMALL. 



 Select object. Use this tool to select any page element in Page view or page symbol in Site view.



 Rectangle. Clicking on this object reveals the Rectangle tab of the Properties palette. Use the settings on this tab to modify the 
Rectangle’s attributes.



 Round Rectangle. Clicking on this object reveals the Round Rectangle tab of the Properties palette. Use the settings on this 
tab to modify the Round Rectangle’s attributes.



 Rule. Clicking on this object reveals the Rule tab of the Properties palette. Use the settings on this tab to modify the Rule’s 
attributes.



 Ellipse. Clicking on this object reveals the Ellipse tab of the Properties palette. Use the settings on this tab to modify the 
Ellipse’s attributes.



 Text. Clicking on this object reveals the Text tab of the Properties palette. You can format selected text using the Text Properties 
palette. To type in new text or change existing text, just click in the text box using the selection tool. To move or change the 
shape of the text box, make sure that you first click on the edge of the box using the selection tool.



 Picture. Clicking on this object reveals the Picture tab of the Properties palette. Use the settings on this tab to modify the 
Picture’s attributes 



 Polygon. Clicking on this object reveals the Polygon tab of the Properties palette. Use the settings on this tab to modify the 
Polygon’s attributes.



 Ole Object. Use the Ole Object Properties palette to modify attributes of this element.



 Java Applet or NetObjects Component. Clicking on this object reveals the Java Applet tab of the Properties palette (if a Java 
Applet) or the Component tab of the Properties palette (if a NetObjects Component). Use the settings on this tab to modify the 
Java Applet’s or Component's parameters.



 Data List. Clicking on this object reveals the Data List tab of the Properties palette. Use the settings on this tab to modify the 
Data List’s attributes.



 Data Field. Clicking on the edge of the red data field box reveals the Data Field tab of the Properties palette. Use the pull-down 
menu on this tab to select another data field.



 Forms Button. Clicking on this object reveals the Button tab of the Properties palette. Use the settings on this tab to modify the 
Button’s attributes.



 Forms Radio Button. Clicking on this object reveals the Radio Button tab of the Properties palette. Use the settings on this tab 
to modify the Radio Button’s attributes.



 Forms Checkbox. Clicking on this object reveals the Checkbox tab of the Properties palette. Use the settings on this tab to 
modify the Checkbox’s attributes.



 Forms Edit Field. Clicking on this object reveals the Single Line tab of the Properties palette. Use the settings on this tab to 
modify the Edit Field’s attributes.



 HID_PALETTE_FormPsw



 Forms Combo Box. Clicking on this object reveals the Combo Box tab of the Properties palette. Use the settings on this tab to 
modify the Combo Box’s attributes.



 Forms Button. Clicking on this object reveals the Button tab of the Properties palette. Use the settings on this tab to modify the 
Button’s attributes.



 Zoom in. .



 Zoom out.



 Table. Clicking on this object reveals the Table tab of the Properties palette. Use the settings on this tab to modify the table’s 
attributes. When you right-click on the table’s cells you can choose items that let you add or delete columns and rows or change 
the type of information in the current cell.



 Picture. Clicking on this object reveals the Picture tab of the Properties palette. Use the settings on this tab to modify the 
Picture’s attributes (Note: Banners are also considered Pictures). 



 Hot Spot (Rectangle). Use the Hot Spot properties palette to view or change the link attached to this hot spot.



 Hot Spot (Polygon). Use the Hot Spot properties palette to view or change the link attached to this hot spot.



 Hot Spot (Ellipse). Use the Hot Spot properties palette to view or change the link attached to this hot spot.



 Background Color Selector. Use the Background Properties palette to modify attributes of this element.



 Shockwave. Clicking on this object reveals the Shockwave tab of the Properties palette. Use the settings on this tab to modify 
the attributes of the Shockwave file.



 Sound. Clicking on this object reveals the Sound tab of the Properties palette. Use the settings on this tab to modify the Sound 
file’s attributes.



 Video. Clicking on this object reveals the Video tab of the Properties palette. Use the settings on this tab to modify the Video 
file’s attributes.



 ActiveX. Clicking on this object reveals the ActiveX tab of the Properties palette. Use the settings on this tab to modify the 
ActiveX control’s parameters.



 Forms Multi-Line. Clicking on this object reveals the Multi-Line tab of the Properties palette. Use the settings on this tab to 
modify the Multi-Line form attributes.



 Line. Clicking on this object reveals the Line tab of the Properties palette. Use the settings on this tab to modify the Line’s 
attributes.



 Settings… Opens a dialog that allows for configuring your settings for local or remote staging or publishing. Also allows for 
choosing modifiers: text only, greyscale, and low-bandwidth versions.



 HID_DELETE_ELEMENT .



 HID_DELETE_FILE_ASSET .



 HID_DELETE_LINK .



 HID_DELETE_PAGE .



 HID_EDIT_CLEAR_ITEMNAME .



 HID_EDIT_CLEAR_STYLE .



 HID_GOTO_PAGE .



 HID_IMPORT_ITEMNAME .



 HID_IMPORT_PAGE .



 HID_IMPORT_STYLE .



 HID_NEW_DATA_OBJECT .



 HID_NEW_FILE_ASSET .



 HID_NEW_ITEMNAME .



 HID_NEW_LINK .



 HID_NEW_PAGE .



 HID_NEW_STYLE .



 HID_NEXT_TAB .



 HID_PREVIOUS_TAB .



 Removes link previously associated with the selected text.



 Delete All Unused File Assets.    Scans and deletes all unused file assets found in the File Assets view.



 Vertical Navigation Bar.    Clicking on this object reveals the Nav Bar Properties palette. Use the settings on the property sheet 
to modify the vertical navigation bar’s attributes.    Click on individual buttons within the navigation bar to reveal the Button 
Properties palette.



 Follow Link.    Goes to the destination of the selected element's internal or structural link.



 HID_NEW_ASSET



 HID_DRAW_POPMENU



 HID_DEBUG_LINKASSETS



 HID_DRAW_VERTBANNER



 Insert HTML.  Opens the Insert HTML Tag dialog box where you may specify HTML tags or scripts to be inserted into the raw 
HTML source for the active text block, at the insertion point.    A small T icon will appear in the text block where the HTML was 
inserted if the Show links and anchors option is checked in the View properties palette.



 HID_VERIFY_ASSET



 Insert Variable.    Opens the Insert Variable dialog box where you may specify a Variable (either Date and Time, Site and 
General, or User defined) to be inserted into the active text block at the insertion point.    The variable will appear grey within your
text block. 



 HID_DRAW_COMPONENT



 HID_LAYOUT_EXTERNAL



 HID_PRINT_TO_FIT



 HID_DRAW_NAVBAR



 HID_DRAW_FORMTOOL



 HID_DRAW_ODBC



 HID_DRAW_ISAM



 Size Layout to Elements.    Choose this option to resize the current Layout to fit the elements within it.    Extra space to the right
or bottom of layout elements will be removed.    If elements within the MasterBorder extend beyond elements in the Layout, only 
the extra space beyond the MasterBorder elements will be subtracted from the current Layout size.    



 HID_DRAW_BBS



 HID_DELETE_ASSET



 Verify All File Assets.    Scans the File Assets view to verify which files are used in the current site, and whether any files in use
have incorrect path information.    The Verifying Files (or Folders) Used by File Assets dialog box opens if NetObjects Fusion 
finds any missing files.    See further help within that dialog box.
Verify All Links.    Verifies that all external links in Link Assets view are up to date and working properly (internally links are 
dynamically updated).    This action may take some time, depending on the number of external links and the speed of your 
internet connection.    The status of the URL is displayed in the Verify Status column.



 Layout Only.    Choose this option to display the current Layout without displaying the MasterBorder. 



 HID_EDIT_HTML



 Click here to close the Spelling dialog box and cancel your spell check session.



 HID_DRAW_VERTBAR



 Spell Check.    Choose this option to check the spelling of text within text objects on the current page. 



 HID_DRAW_ARROWLINE



 HID_FILE_INSTALLCOMPONENT



 HID_TEXT_UPDATEFIELD



 HID_FLUSH_REDO



 Save Site As.    Opens a standard Windows Save As dialog box.    Allows you to save a copy of the current site (a NetObjects 
Fusion .nod file) with a different name.



 HID_DRAW_BANNER



 When checked, small icons representing links, anchors, scripts or HTML tags (within text blocks) are displayed on elements in 
Page view.    This option is also found on the View menu.



 Click this button to delete the currently selected tag from the text.



 Variables. Shows you a list of User defined text variables that are used within your site, as well as the page or pages on which 
each variable appears.



 Banner. Clicking on a banner reveals the Banner Properties palette.    Use the settings on the property sheet to modify this 
Banner’s attributes.    



 Navigation Bar. Clicking on a banner reveals the Nav Bar Properties palette.    Use the settings on the property sheet to modify 
this Navigation Bar’s attributes.



 Vertical Banner. Clicking on a banner reveals the Banner Properties palette.    Use the settings on the property sheet to modify 
this vertical Banner’s attributes.



 HID_PALETTE_BBC



 HID_PALETTE_ImageText



 HID_PALETTE_BBSComp



 HID_PALETTE_SiteMapperComp



 HID_PALETTE_PopMenuComp



 HID_PALETTE_FormToolComp



 HID_PALETTE_BillBoardComp



 HID_PALETTE_ODBC_DBList



 HID_PALETTE_ISAM_DBList



 HID_PALETTE_TickerTape



 HID_PALETTE_MAXSHAPE



 HID_INDICATOR_EXT



 HID_INDICATOR_CAPS



 HID_INDICATOR_NUM



 HID_INDICATOR_SCRL



 HID_INDICATOR_OVR



 HID_INDICATOR_REC



 HID_INDICATOR_KANA



 HID_SEPARATOR



 HID_FILE_NEW



 HID_FILE_OPEN



 HID_FILE_CLOSE



 HID_FILE_SAVE



 HID_FILE_SAVE_AS



 HID_FILE_PAGE_SETUP



 Print Setup.        Open the standard Windows Print Setup dialog box, with the addition of a Print to fit checkbox option.



 Print.     Open the standard Windows Print dialog box, with the addition of a Print to file checkbox option.



 HID_FILE_PRINT_DIRECT



 Print Preview.    Displays a preview of the printed Site Structure.    The Site view will be replaced with the standard Print Preview
controls, which include Zoom In and Out, Print and other buttons.



 HID_FILE_UPDATE



 HID_FILE_SAVE_COPY_AS



 HID_FILE_SEND_MAIL



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name 
on the MRU list.



 HID_EDIT_CLEAR



 HID_EDIT_CLEAR_ALL



 HID_EDIT_COPY



 HID_EDIT_CUT



 HID_EDIT_FIND



 HID_EDIT_PASTE



 HID_EDIT_PASTE_LINK



 HID_EDIT_PASTE_SPECIAL



 HID_EDIT_REPEAT



 HID_EDIT_REPLACE



 HID_EDIT_SELECT_ALL



 HID_EDIT_UNDO



 Redo.    Redoes the previously undone action or command, which is displayed with the menu item. 



 HID_WINDOW_NEW



 HID_WINDOW_ARRANGE



 HID_WINDOW_CASCADE



 HID_WINDOW_TILE_HORZ



 HID_WINDOW_TILE_VERT



 HID_WINDOW_SPLIT



 HID_APP_ABOUT



 HID_APP_EXIT



 HID_HELP_INDEX



 HID_HELP_FINDER



 HID_HELP_USING



 HID_CONTEXT_HELP



 HID_HELP



 HID_DEFAULT_HELP



 HID_NEXT_PANE



 HID_PREV_PANE



 HID_FORMAT_FONT



 HID_OLE_INSERT_NEW



 HID_OLE_EDIT_LINKS



 HID_OLE_EDIT_CONVERT



 HID_OLE_EDIT_CHANGE_ICON



 HID_OLE_EDIT_PROPERTIES



 HID_OLE_VERB_FIRST



 HID_OLE_VERB_LAST



 HID_VIEW_TOOLBAR



 HID_VIEW_STATUS_BAR



 HID_RECORD_FIRST



 HID_RECORD_LAST



 HID_RECORD_NEXT



 HID_RECORD_PREV



 HID_APPLY_NOW



 HID_WIZBACK



 HID_WIZNEXT



 HID_WIZFINISH



 Size to Image.    Choose this option to resize the bounding box of the current image to fit the picture exactly.    Regardless of the 
current size of the picture bounding box, it will reset to the picture's original dimensions.



 Element Borders.    Toggles the display of borders around objects (such as text blocks, draw shapes, data fields, etc.) in Page 
view.    This option is also found on the View properties palette.



 Page Labels.    Toggles the display of small text labels and dividing lines for page areas such as MasterBorder, Layout and 
Frames.



 Element Icons. Toggles the display of small icons representing links, anchors, scripts or HTML tags (within text blocks) on 
elements in Page view.    This option is also found on the View properties palette.



 Update Styles List.    Updates your SiteStyle list (Style Gallery in Style view) by importing all styles found in your NetObjects 
Fusion\Styles folder and removing all those not found.    Styles found in the Styles folder but not found on your Styles list are 
imported, and styles found on your Styles list but not found in your Styles folder are removed from the list. 



 Select Overlapping Elements.    Identifies overlapping elements by selecting them.    A message box reporting the number of 
overlaps is displayed.    You may then correct any overlap by deselecting and individually repositioning elements.



 Merge Text Blocks.    Merges all selected text blocks into the first text block selected (you may use the mouse or keyboard to 
select multiple text blocks).    The combined text block maintains the same width as the first text block selected.



 Help Topics.    Opens the NetObjects Fusion Help system.    The Help window opens to the Contents tab, where you select a 
help topic to be displayed.    Use the Index or Find tab to search the help system for specific keywords or text.











Enter the point size for the line width or graphic element border. Each click on a spin button changes the current size by one 
point.



Reveals (if checked) or hides (if cleared) any hotspots that have been applied to the selected picture. Since hotspots normally 
aren't visible on a picture when viewed in a web browser, this feature is used for design purposes only.





Sets the page background color or design to match the current site style as shown in the Style view.



Choose this option if you want a solid color background on this page.



Choose this option if you want a graphic background on this page.



Opens a color dialog to let you choose a solid color background for this page.



Opens a standard Windows search dialog to let you locate a picture to use for the background on this page.







Check or uncheck this box to switch the page design grid on or off.







Displays the path and file name for the current picture. You can change the picture by typing in a new path and file name or by 
clicking the Browse button to locate a file on disk.



Displays the link assigned to the selected hotspot. You can edit this text directly to change the link, or press the Link button to 
help you specify a new link.



Lets you choose the type of template you wish to apply to the site.



Select the next data field to query on.    



Select the next data field to query on.    







Lists all available web browsers. Select the browser from this list that NetObjects Fusion will launch when you click the Preview 
button in the control bar. 





Opens the Add Browser dialog, which lets you specify a browser to add to the list.



Lets you remove the selected browser from the list.



Sets the web browser that NetObjects Fusion will launch when you click the Preview button in the control bar. The web browser 
documents are indicated in the browser selection list.



















Shows the current fill color for the selected graphic element. To change the color, click the Color button.



Opens a color selection dialog to let you change the fill color for the selected graphic element.



Opens a standard file Open dialog box to let you locate a file.



Displays the name of the currently selected proportional font used throughout your site.



Applies underline formatting to the selected text.



Applies strikeout formatting to the selected text.





Lists available point sizes for the selected text. The list also shows the corresponding HTML standard sizes. 





Opens the Link dialog to let you link to another page within your site or to another page or site on the Internet. The link is applied 
only to the selected text. If no text is selected, the button is disabled.



Enter the name of your new paragraph style here.







Opens a color selection dialog to let you change the background color in the selected text.















Displays the file name represented by the selected element. 



Click this button to open a file search dialog and locate a sound or video file to place on the page.



Click one of these buttons to place a supplied icon to represent your page.



Click this option to select from one of the supplied sound or video images. To choose an image, click its button.



Click this option to select a custom image or icon to represent the sound or video. To locate an image on your disk, click the File 
button.



Opens a file search dialog to let you locate an image or icon to represent the sound or video.



Displays the file name of a selected image or icon that represents the sound or video.







Choose a Layout for the current page from this dropdown list.    Choose Add… from the dropdown list to create a new page 
layout based on the current page.









Check this option if this name-value pair is to be selected by default.



Makes the edit box a password control. Any text entry is displayed as asterisks. 





Choose this option if you want to allow the user of the form to make multiple selections from the items in your list box.



Check this option to additionally publish or stage your site as a greyscale site.    All images (GIFs and JPEGs) are published or 
staged as two-color monochrome.



Check this option to additionally publish or stage your site as a low bandwidth site.    All GIFs are reduced to 4-bit color (16 color) 
and all JPEGs are reduced in file size by half (they are resized in your browser to their original dimensions).







Displays the name of the selected data list. If you are creating a new data list, enter a name here (the default is “Untitled”). This 
data list name is for internal reference only. Open the Data Publishing dialog box by either double-clicking on the Data List itself 
or by clicking the Define button in the Data List properties palette.





Enter the name for this new data object sourced with internal data.    This edit box is unused by data objects sourced with 
external data.



Displays the name and type of each data field within this data object. Double-click on a field to edit its name. Click on the add 
button (+) below to add data fields to this data object.    



Enter any comments for this object here (for internal purposes only).







Lets you change the name of the currently selected page.





Enter or select a column number to change its settings.    Use the dropdown list below to change the type of object contained 
within the specified column. Change settings for multiple columns by selecting columns here and changing their object types 
below 



Point size for the external border on the selected data list.



Select a method of comparison from this dropdown list for this relational query



Enter the value to be compared (according to the comparison method) in the specified data field.



Select a logical conjunction (“and” or “or”) to define the relational query.    Select “end” to end your query without specifying 
further conditions.





Enter the value to be compared (according to the comparison method) in the specified data field.





Enter the password for the username indicated above.



Enter your username for the web server you wish to publish or stage to in this edit box.



The location of the selected file is displayed here.























Identifier for the control.





Makes the default state of the control "not selected" or "unchecked."



Choose this option to have the selected radio button be selected by default when the form element is viewed within a browser.



Choose this option to have the selected radio button be unselected by default when the form element is viewed within a browser.



Click the up or down arrows to change the grid block width in increments of one unit.



Click the up or down arrows to change the layout height in increments of one unit.



Enter or select a column number to change its settings. Use the dropdown list below to change the type of object contained 
within the specified column. Change settings for multiple columns by selecting columns here and changing their object types 
below 



Lets you increase or decrease the point size for the outside border on the selected table or data list. Each click on a spin button 
changes the size by one point. For larger changes, type a new number into the field.



Lets you increase or decrease the margin, in points, between the cell contents and container edges. Each click on a spin button 
changes the size by one point. For larger changes, type a new number into the field



Lets you increase or decrease the amount of space (in points) between each column and between the outside border and the 
column containers. Each click on a spin button changes the size by one point. For larger changes, type a new number into the 
field.



Choose this option to select a image file to use as a bullet in the selected data list.    Click on the browse button to open a 
standard Image File Open dialog box.



Check this option to if you do not want to use bullets within the selected data list.



Indicates that the current page is not yet completed.



Choose this option to set the navigation button level to documents on the same level of the site hierarchy as the current page.







Moves the selected parameter or item up one position on the list.









Displays the graphic in its original size and shape within the picture container. The picture maintains its "natural" state even if you
change the size or shape of the container using the sizing handles.





If the selected picture container is enlarged beyond the size of the graphic it contains, this option creates multiple images of the 
graphic and tiles the images to fill the container.



Click the up or down arrows to change the layout width in increments of one unit.



Shows the color that will be applied to the selected text container background if you choose the background color option. To 
change the color, click the Color button. 











Enables or disables the snap to grid feature when checked or unchecked.    Grid height and width settings may be modified 
above.



Lets you change the measurement units used in determining the height and depth of the page as well as the grid size used to 
position objects on the page. Choose from centimeters, inches, points or pixels. Your choice is used in the Grid Size controls 
below as well as in the Layout and MasterBorder properties palettes.



Choose this option to use the primary button style as shown in the current style (Style view) for the selected navigation button.



Choose this option to use only text for the selected navigation button.



Choose this option to use the secondary button style as shown in the current style (Style view) for the selected navigation button.











Check this option to additionally publish or stage your site as a text only site. Non-text assets such as images or sound files will 
not be included in the published or staged site.





Displays the current page type (Normal or Stacked).







Shows the color of the background that is applied to the picture container if you select the Use Current Color option.



Area in which you can enter additional comments about the currently selected page.



Opens a color dialog to let you set the color of individual page icons in Site view for various purposes, such as indicating which 
pages have been assigned to a particular author.



Shows the color of the currently selected page icon. To change the color, click the Color button.



Opens a color dialog to let you set the color of the Site view background.



Opens a color dialog to let you set the color of the Site view background.





Outline View. Provides a drag and drop file tree view of your site in which you can expand and collapse the structure at any 
level. You can review site management information about each page, such as the names of child pages, page type, status, and 
comments.





These options let you control how a graphic is displayed within the selected picture bounding box.



These controls let you apply text to the selected picture or graphic container and choose the color, alignment and font for the 
applied text. 



Choose this option if you would prefer a solid color as a background for this style. Click on the Color button to select a new color.



Choose this option if you would prefer a picture as a background for this style. Click on the Browse button to browse for a picture.
A sample of how the tiled picture will appear as a background style is displayed on the right.



Click this button to open the standard Color dialog box, where you can select a color for the background style. 



Adds the current footer to the Footer list, making it available to all other pages in your site.



Adds a new MasterBorder to the MasterBorders list based on the current page’s MasterBorder, making it available to all other 
pages in your site.    Name and format the new MasterBorder from the MasterBorder properties palette.





Closes the dialog and saves any changes you made.



Displays the URL (internet address) for this external link.





Enter, edit or view the value displayed in this edit box.



Choose this option to make the control a dropdown type list box, which takes up less space on the form. The user opens the list 
by clicking a button.



You've selected a text buttonface.    Enter the text you would displayed on the button, and specify whether it is a Submit or Reset 
button.



Displays the name of the style to be edited.



If checked, places the Banner button (as shown in the Styles view) in the page header.



Lets you choose a new footer for this page.





Lists the ActiveX controls available on your system. Select the ActiveX control to be inserted into the current selection.



Lists the properties available in the selected ActiveX control.







The left button aligns text flush left, the middle button aligns text to the center and the right button aligns text flush right.    When 
working in a text block, these buttons affect the current paragraph.    When working with Text in Element Settings (in Page view) 
or Text Settings (in Style view) these buttons affect the relative alignment of text only, not its relation to the element (use 
Horizontal and Vertical Position for this).





Displays the current background color of the selected data list or table. To change the color, click the Color button.



Enter the name of the remote host or server you wish to publish to.



Check here to have your password stored in memory.    If checked, you will not need to enter your password each time you 
publish.





Check this option to use the current default bullet style (as shown in Style view) in the selected data list.



Lets you switch between vertical and horizontal orientation.



Check or clear this box to show or hide column headers in the selected data list.



Chooses the file extension for the HTML file generated for the home page of your site.    The default choice, html, used by UNIX 
and Macintosh computers, is more commonly found on the World Wide Web; htm is used by IBM-PC compatibles with its three-
character extension limit.



Shows the date and time the current site was created.



Shows the date and time the current site was last changed.



Shows the color of the Site view background. To change the color, click the Color button. 











Enter the directory on the remote host you wish to start in.







Displays a list of symbol characters, with descriptions and Shortcut keys (if applicable) which can be inserted into a text block. 
Use Shortcut key combinations outside this dialog box, when entering text into a text block.    Insert the selected symbol into the 
text block at the insertion point by pressing the Insert button below.



Check this box to use a highlighted button (as shown in the current style) in the navigation bar.    Note: this option has no effect 
on nav bars with text buttons.



Check this box to include this site's home page in the navigation bar.



Displays the number of words in the current page.





Displays the number of characters in the current page.



Displays the number of lines in the current page.



Displays the number of words in the current text selection.



Displays the number of lines in the current text selection.



Displays the number of paragraphs in the current text selection.



Displays the number of characters in the current text selection.



Structure View. Provides a drag and drop graphical view of your site. You can use this view to visualize your site’s structure. 
You can also expand and collapse the structure and color code individual pages.





Finds the selected page and opens it in Page view.



Opens a pre-built ActiveX control Properties dialog box (if available), where you may edit the ActiveX control's properties.    Also 
use this property palette to modify ActiveX properties within NetObjects Fusion (for further information, see help on other controls
within this palette).



Displays the color that will be applied to the selected line or element border. To change the color, click the Color button.



Select a method of comparison from this dropdown list for this relational query



Displays the color that will be applied to the selected text if you choose the color option next to the swatch. To change the color, 
click the Color button.







Name assigned to the current page. You can change this name at any time.



Enter or select the number of rows for your table here.



Applies italic formatting to the selected text.



Name assigned to the current page layout. You can change this name at any time.



Opens a standard Windows file Open dialog box to let you locate a file.





Opens an alignment dialog to let you position text within the selected picture or graphic element. Applies only if the Text in 
Element checkbox is checked and text appears in the field above the Align button.



Displays the current picture used for the banner in this style.    Click on the Browse button to select a new picture.



Displays the Font currently selected for this style element.



Click here to open the standard Font dialog box, where you may select fonts and font styles to be applied to the text used in this 
style element.





This displays the current background style color.    Click on the Color button to change this color.



Displays the current picture used for the background in this style. Click on the Browse button to modify this selection.



Displays the current picture used for regular or non-highlighted buttons in this style. Click on the Browse button to modify this 
selection.



Displays the current picture used for highlighted buttons in this style. Click on the Browse button to modify this selection.



Click here to open the Image File Open dialog box, where you can select a picture for this style element.







Enter a full or partial name of the page within your site you wish to link the selected element to.    



Searches for pages beginning with the character(s) you’ve entered above.    Click on the Find button below to locate all matches.



Searches for pages which contain the character(s) you’ve entered above.    Click on the Find button below to locate all matches.



Searches for pages which end with the character(s) you’ve entered above.    Click on the Find button below to locate all matches.



Graphical display of the selected level.



Graphical display of the selected level.



Graphical display of the selected level.



Graphical display of the selected level.



Graphical display of the selected level.



Use these controls to apply the default color or choose a new color for the selected text.



Use these controls to add or remove background color in the selected text container.







Icon representing the audio controls element that is placed on the page when you choose the Inline option.





Opens a standard Windows search dialog to let you locate a picture to place on the selected button.



Displays the file name of the picture that appears on the selected button. If no picture is assigned to the button, this label is 
blank.    Click on the Browse button to select a picture file.



Set Style. Applies the selected style to the current site.



Page icon.    This icon is a representation of the actual page. Clicking on this icon reveals the Page tab of the Properties palette, 
where you may change the selected page's properties (also see help within the Page Properties palette).    Double-click on this 
page icon to edit the page in Page view, or click the right mouse button to view a pop-up menu with applicable commands.
Stacked page icon.    Page icons with a layered lower edge are representations of stacked pages. Double-click on a stacked 
page icon to edit the stacked page in Page view. 
External HTML file icon.  Page icons with diagonal hatching represent external HTML files used within your site. Double-click 
on this icon to go to the corresponding page in Page view.    To edit the external HTML file (with the editor specified in Edit | 
General Preferences),    double-click on the grayed-out layout in Page view.



Choose this option if the intended data object uses one of the pre-built database drivers listed in the dropdown list to the right.    
Click on the Browse button to choose a file that matches the driver type specified in the dropdown list.



Click on this button to add a new field to your data object.



Opens a standard Windows search dialog to let you locate a file.



Type the text that will appear in place of the sound graphic in client browsers that either can't display images or have image 
display turned off.



Click to apply the selected action.



Removes the currently assigned link.



Lets you turn on/off the autosave feature, which automatically saves your site every time you make a change. Turning off 
(unchecking) this feature can improve overall performance when working with large sites, but if you turn it off you MUST select 
Save Site from the File menu to save your work.



Type the text that will appear in place of the image representing the ActiveX control in client browsers that either can't display 
images or have image display features turned off.



Specify the file needed to implement this ActiveX control on the client side, almost always an .OCX files (less commonly.CAB 
or .INF files). Note: if the Set Codebase option was checked in the Insert ActiveX dialog box the necessary module will be 
automatically added to this edit box.    Also, the module used by a particular ActiveX control is displayed in the Insert ActiveX 
dialog box. See help for the Insert ActiveX dialog box.



Type the name of a script to run with the ActiveX control. To open the full script editing window, click the Script button.



Text will be aligned to the bottom of the style element.



Opens a standard Windows file Open dialog box to let you browse for files.



Opens the Image File Open dialog box, where you can select a new image or picture to be used for highlighted buttons in this 
style.







Opens a search dialog to let you choose a new bullet graphic for the selected data list. 



Opens the Enter Value dialog to let you add a new parameter or item.



Moves the selected parameter or item down one position on the list.



Removes the selected parameter or item from the list.



Opens a standard Windows Font selection dialog to let you choose a new monospace font and font size. You must match these 
settings to the monospace, fixed or teletype font settings in your browser's preferences.



Opens a standard Windows Font selection dialog to let you choose a new proportional font and font size. You must match these 
settings to the proportional font settings in your browser's preferences.





Click this button to assign a picture to the selected cell. When you select this option, a standard Windows search dialog appears 
to let you locate a picture. Caution: If the cell already contains text and you choose a picture to replace it, the text cannot be 
retrieved.



Click this button to enable text entry in the selected cell. Caution: If the cell already contains text and you assign a picture to it 
through the Picture type option, the existing cell text cannot be retrieved.



Chooses what type of element, text or picture, will appear in the Column number chosen in the edit box above. The default type 
is text.



Text will be aligned to the horizontal center of the style element.



Text will be aligned to the vertical center of the style element.



Enter the folder on the remote host where CGI (Common Gateway Interface) programs are located.    



Edit. Lets you edit the selected style element. You can also edit elements by double-clicking list items. 



Check this box to enable uploading only those file assets which have changed since the last time you've published or staged.    If 
you've deleted or changed files on your server, disable this option to re-publish or re-stage your entire site (NetObjects Fusion 
doesn't compare the server's files).    This option is enabled by default. 







Select this option if you want to use the current page background color as the background in the picture container.



Check this option to use a transparent GIF to maintain WYSIWYG layout in Netscape Navigator 3.0 (and older versions).    The 
file "dot_clear.gif" will be used to display your site in Netscape as it appears within NetObjects Fusion.



Check this box to have NetObjects Fusion automatically place all data fields on the stacked pages associated with this data 
object and list.    Go to the stacked pages in Page view to manually adjust the layout of the data fields and stacked pages.



Check this box to automatically add navigation buttons to the stacked pages associated with this data object and list.    
NetObjects Fusion will add Next, previous and up buttons to the set of stacked pages. Go to a stacked page in Page view to 
manually adjust the layout and properties of navigation buttons on the stacked pages.











Displays the currently selected solid background color for this page. Only applies if the Solid Color option is selected. To change 
the color, click the Color button.





Lists the pre-built database drivers available for the intended data object.    Click on the Browse button to choose a file that 
matches the driver type specified in this list.



Select a data field to be added to the current stacked page from the dropdown list.



Select a method of comparison from this dropdown list to use for this query.



Enter the value to be compared (according to the comparison method) in the specified data field.



Elements. Lists the editable elements that make up the selected style. You can double-click on any item in the element list to 
edit it.



Clicking this button opens the SQL Data Sources dialog box, where you may add and select from a list of external data sources.



Opens the Data Publishing dialog box, where you can change the name assigned to this list, show or hide fields assigned to the 
list, assign the Linked Field attribute to fields in the list, change the order in which fields appear, and other options.



Choose from the current set of Data Objects to be included in your data list.    Choose the New Button to create a new data 
object.









Enter the path for the local folder in which you would like to stage or publish your site.    Click the Browse button to locate the 
folder.



If you make the control a standard list box, this field lets you set the number of lines that are displayed in the box. If there are 
more items in the list than the number you set here, a scroll bar is added



If you make the control a standard list box, these buttons increase or decrease the number of lines displayed in the box. If there 
are more items in the list than the number you set here, a scroll bar is added.



Lets you change the text displayed on the element.



Click the up or down arrows to increase or decrease, in increments of one,    the maximum number of characters allowed in the 
edit box. If the box contains more text than shown in the Max Visible setting, the user can view the additional text by using the 
arrow keys to scroll right or left.



Enter the point size for the line width or graphic object border. Each click on a spin button changes the current size by one point. 



Contains the value that will be returned when the form is submitted and this checkbox or option is selected. All checkboxes and 
radio buttons should have a name and a value assigned to them (otherwise, if the option is selected, and the form is submitted, 
the default string “On” is returned when the form is submitted).



The number of lines that are visible in the edit box (which determines the onscreen height of the box). If the box contains more 
lines than the Visible Height setting, the user can view the additional text by scrolling up or down using the keyboard .



Click these buttons to increase or decrease the number of lines that are visible in the edit box (which determines the onscreen 
height of the box). If the box contains more lines than the Visible Height setting, the user can view the additional text by scrolling 
up or down using the keyboard arrow keys.



The number of characters that are visible in the edit box (which determines the onscreen width of the box). The maximum 
number of characters the box can contain is set in the Max Length control.    If the box contains more characters than the Visible 
Length setting, the user can view the additional text by scrolling right or left using the keyboard arrow keys.



Click these buttons to increase or decrease, in increments of one,    the number of characters that are visible in the edit box 
(which determines the onscreen width of the box). The maximum number of characters the box can contain is set in the Max 
Length control.    If the box contains more than the Visible Length setting, the user can view the additional text by scrolling right or
left using the keyboard arrow keys.





Enter the text you would like to be inserted into the published HTML page after the selected element. Click the Insert button to 
insert a text or HTML file in this edit box. Click OK to confirm the insertion, Cancel to exit this dialog without inserting or changing 
the script.



Sets the maximum number of characters allowed in the edit box. If the box contains more text than shown in the Max Visible 
setting, the user can view the additional text by using the arrow keys to scroll right or left.





The number of characters that are visible in the edit box (which determines the onscreen width of the box). The maximum 
number of characters the box can contain is set in the Max Length control.    If the box contains more characters than the Visible 
Length setting, the user can view the additional text by scrolling right or left using the keyboard arrow keys.











Select an initial data field to perform a Boolean query on.    



The file name and path for the picture that is displayed in the selected navigation control. To change the picture, click the Browse
button.



Enter the number of pixels to offset your background image from the left margin.



This buttons opens the Query dialog box, which allows you to set database queries or filters for the data fields listed below 
(further help is available within the Query dialog box).



Choose this option to set the navigation button level to pages on the first level of the site hierarchy.





With the Get method, the values of the form variables are sent as part of the URL. This corresponds to the “METHOD=GET” 
attribute of the Form tag in HTML. 



Post is the default method used by forms.    The values of the form variables are echoed as text, whereas in the Get method the 
values are sent as part of the URL. This corresponds to the “METHOD=POST” attribute of the Form tag in HTML. 



In this edit box specify the URL of the CGI script to be used by your site when processing forms. This corresponds to the “Action”
attribute of the Form tag in HTML.    This field is required.





Advanced users may specify a local copy of the CGI script used for processing forms. The Action field below should contain the 
full URL for the CGI script selected above. This file will be FTP’d to the CGI directory indicated in your Remote configuration 
(Publish or Stage Settings). Note: if your CGI script is already on your web server, you may leave this field blank.



This field is optional. Advanced users may need to specify a non-standard encoding type when configuring advanced forms. 
(MIME-type application/x-www-form-urlencoded is the default encoding type, which encodes the form’s name-value pairs as an 
URL is encoded).



Click this button to open a standard Open File dialog and select a local CGI script.



Opens the Forms Settings dialog, where you set the CGI-related functions for the form.









Lets you view or change the width of the grid blocks that are used to help you position items on the page. You can change the 
block width by typing a number directly into this field or clicking the spin buttons to change the value in increments of one unit.



Displays the currently selected unit of measurement used in determining the width of each grid block. You can change the unit 
used by choosing another Measurement Unit from the list above.



Click the up or down arrows to change the grid block height in increments of one unit.



Lets you view or change the height of the grid blocks that are used to help you position items on the page. You can change the 
block height by typing a number directly into this field or clicking the spin buttons to change the value in increments of one unit.



Displays the currently selected unit of measurement used in determining the height of each grid block. You can change the unit 
used by choosing another Measurement Unit from the list above.





Horizontally aligns the selected picture to the center of its bounding box, when the bounding box is sized differently from the 
picture.



Horizontally aligns the selected picture to the left of its bounding box, when the bounding box is sized differently from the picture.



Horizontally aligns the selected picture to the right of its bounding box, when the bounding box is sized differently from the 
picture.



Lets you select a MasterBorder for the current page.





Opens the Hidden Fields dialog, which lets you add or remove hidden fields (not visible in the browser) from your form.





Chooses the name of the HTML file generated for the home page of your site, which can be either the current name of the page, 
Index, Default or Home.    Current Page Name is the default choice.





If this option is checked, headers and footers within this site will be oriented horizontally, i.e. headers will be at the top, footers at 
the bottom of each page. The header/footer splitter bars will be horizontal, at the top and bottom of each page.    If this option is 
unchecked, headers and footers within this site will be oriented vertically, i.e. headers will be on the left, footers on the right of 
each page. The header/footer splitter bars will be vertical, on the left and right of each page.



Choose this option to display a set of graphical audio or video controls on the page. This interactive element can be used to 
control the sound or video element from the client browser.





Choose this option to set the navigation button level to documents on the parent level of the site hierarchy.



Choose this option to set the navigation button level to documents on the child level of the site hierarchy.







Opens a standard file Open dialog box where you may select HTML or other text files to insert into the selected edit box (where 
the cursor is currently located).



Lets you type in an HTML alternate tag for the selected element. This text—generally a short description of the element—
appears in place of the graphic representing the element in text-only web browsers or browsers in which graphics have been 
turned off.



Displays the file name of the selected Java applet or Shockwave file.



Text you want displayed in the control.





Lets you view or change the width or height of the current page layout in terms of the selected unit of measurement. You can 
change the layout width or height by typing a new number directly into this field or clicking the spin buttons to change the value in
increments of one unit.



Displays the currently selected unit of measurement used in determining layout and page size. You can change the unit used by 
clicking the View tab and choosing another Measurement Unit from the list. 



Displays the Page Type for the selected page, either Normal or Stacked Page (data pages used by a data list).



Opens a color selection dialog to let you choose a color for the table or data list background.



Lets you view or change the height or width of the current page layout in terms of the selected unit of measurement. You can 
change the layout height or width by typing a new number directly into this field or clicking the spin buttons to change the value in
increments of one unit.



Displays the currently selected unit of measurement used in determining layout and page size. You can change the unit used by 
clicking the View tab and choosing another Measurement Unit from the list.





Text will be aligned to the left margin of the style element.







When this option is checked, the selected data list field above will be considered a linked field, which means that the data within 
that field is linked to its corresponding page within the set of stacked pages used by the current data list. When the data list is 
viewed in a browser, data displayed in the column for a linked field will be seen as highlighted links to the corresponding data 
pages (within the set of stacked pages). To indicate that a data list field is linked, "(link)" is added to the end of the fieldname on 
the list above.





Displays the URL (internet address) for this external link.



Displays all pages which contain this asset.



Lists the parameters of the selected items that are to appear in the selected list box. To change the current value of any 
parameter or item, double-click its name on the list. To add or remove a parameter or item, click the + or - buttons below the list. 
To reposition an item on the list, select the item and click the up or down arrow buttons.



Choose this option to stage or publish your site locally.    Enter or browse for the folder in which to stage or publish the folders of 
HTML pages and assets.







Displays the name of the currently selected monospace font in use throughout your site.







Displays the name of the selected asset.





Click this button to create a new data object.    The Data Object dialog box will open (see help on individual options within the 
Data Object dialog box).    





Adds a new button to the header or footer navigation bar. The button picture is set in the Nav. Button properties palette.



Select the logical conjunction (“and” or “or”) to compare data fields.    Select “end” to end your query without specifying further 
conditions.









Select this button if the currently selected page is to be included in the published site. Note: All pages are normally included in 
the published site. To exclude a page, select the page and click the Don't Publish option. To include a previously excluded page, 
click the Publish option back on.







Displays a list of objects to be selected from.



The name of the selected ActiveX control or NetObjects Component.



Choose this option if the data object will use the Open Database Connectivity (ODBC) standard.    Click on the Select button to 
open a dialog where Data Sources and ODBC drivers for this data object are chosen.



Click this button to open the Data Source Type dialog box, where you specify the location and type of a data object sourced with 
external data.



Select this button if the currently selected page is to be excluded from the published site.



Lets you change the name of the currently selected page.



Select this button if the currently selected page is to be included in the published site. Note: All pages are normally included in 
the published site. To exclude a page, select the page and click the Don't Publish option. To include a previously excluded page, 
toggle the Publish option back on.









Displays the data type (string, integer) required by the selected parameter.



Describes the required contents of the selected parameter.



Opens a color selection dialog to let you choose a color for the selected line or border on the selected graphic element. In the 
Line properties palette, you can only set the color when the Draw option is selected.



Opens a font selection dialog box to let you choose a font for the text that appears in the selected picture or graphic element. 



Opens the Link dialog box to let you add or change a hypertext link on the selected picture or graphic element. The link can point
to another page within your site or to another page or site on the Internet.



Opens the Alignment dialog box which lets you choose the position the image "snaps" to if you change the size or shape of the 
container. If, for example, you choose Left and Bottom alignment and then enlarge the picture container, the picture will maintain 
its original size, but snap to the bottom left corner of the enlarged container.



Lets you type in an HTML alternate attribute (ALT) for the selected picture or graphic object. This text, generally a short 
description of the picture or element, appears in place of the image in text-only web browsers or browsers with graphical display 
turned off.



If this page uses an image for the background, the image file name is displayed here.



Stretches the graphic to fill the selected picture container's size and shape.



To add text to the selected picture, check the Text in Element checkbox, then type the text into this field.



Opens a color selection dialog to let you choose a color for the text that appears in the selected picture or graphic element. 











You've selected an image form button. Click on the Browse button to select a picture file.    By default, a graphic form button acts 
as a Submit button. 



Makes the button a "reset" control. When the user clicks the button in a client web browser, form contents on the page are 
cleared.



Makes the button a "submit" control. When the user clicks the button in a client web browser, form contents on the page are sent 
to the site.



Makes the default state of the control "selected" or "checked."





The image file will be converted from its currently file format to a .GIF file, one of the two image file types supported by most 
browsers. Choose JPEG below to convert the image to a .JPG file (called .JPEG on UNIX and Mac), the other image file type 
supported by most browsers.



Choose this option if you want to control the length, width, angle and color of the selected line.



Choose this option to make the selected line a horizontal rule.    An <HR> tag will be added to the HTML source for this page.



The image file will be converted from its currently file format to a .JPG file (.JPEG on UNIX and Mac), one of the two image file 
types supported by most browsers. Choose GIF above to convert the image to a .GIF file, the other image file type supported by 
most browsers.



Choose this option to make the control a standard list box.





Choose this option if you would prefer no background for this style.



Choose this option to apply the line picture style (specified in Style view) to the selected rule.





Choose this option to create an internal data object. Select a name, enter comments and create data fields below (also see help 
on each individual item).











Choose this option to include a data object sourced with external data. Click on the Source button to open the Data Source Type 
dialog box to select your external data source type (also see help for that dialog box).



The data field will consist of images.    If you are creating this data object internally, you may select images by double-clicking on 
the empty data field after it is placed on a stacked data page.





Choose this option to stage or publish your site on a remote host or server.    Click the Configure button to configure settings for 
staging or publishing remotely.







Check this box to have the spaces in the names of your assets replaced with underscores when published (or staged) to a 
server.    For example, a picture named My Picture.jpg when FTP'ed would become My_Picture.jpg.    Only the name of the file 
NetObjects Fusion publishes is changed, not the name of the local file.



Enter the name for a field within this data object.    Choose from the options below to determine the type of data field (see help on
individual options below).



Text will be aligned to the right margin of the style element.





Check this option if you would like to offset your background image the number of pixels specified in the Left and Top fields on 
the right. Since most browsers (such as Netscape Navigator or Microsoft Internet Explorer) add a small gutter on the top and left 
margins, you may find that text will not align with your background image perfectly. Offsetting your background image will allow 
you compensate for this gutter problem.











This list displays the data fields (of the chosen data object) which will be added to the current data list.    The checkboxes to the 
left of each field indicate whether or not this field will be included in the data list.    You may reorder their positions within the data 
list with the up and down arrow buttons on the lower right (the topmost field will be displayed in the leftmost column, and so 
forth).



Displays the name of the current site (if creating a new site, enter its name here).





Select an AutoSite or Page template from this list to base your new site on.



Templates.    Offers two different types of templates to give you a head start with building your site.
AutoSites are fully structured sites with suggested content and navigation elements. You can open them as new sites or insert 
them into other sites.
Page Templates are pre-built pages with suggested content. You can open them as new sites or insert them into other sites.





Choose the data field on which this data list will be sorted from this dropdown list. This option is available only when a data 
object is accessed by the data list.











Lets you type in an HTML alternate tag for the selected element. This text—generally a short description of the element—
appears in place of the element in text-only web browsers or browsers in which graphics (or other features) are unsupported or 
have been turned off.



Enter the relevant text in this edit box.



Indicates that work on the page is complete.



Style Gallery.    Lists the SiteStyles that can be applied to your site and displays the various elements that make up the style. To 
edit a style's element, click the Elements button or double-click the style name.



Lets you apply a solid color background to the selected table.



Removes any solid color background from the selected table.



Lets you enter the margin, in points, between cell contents and cell container edges.



Lets you enter the margin, in points, between cells within the table or data list and its outside borders.











Enter the number of columns for your table here.



Enter the number of columns for your table here.







Enter or select the number of rows for your table here.







Choose this option to reapply the formatting of the chosen style to the active paragraph.    The formatting for the entire paragraph
or text block (not just the current selection) will be replaced with the formatting for the style chosen.    Redefining the style, the 
alternate option, not reapplying the style, is the default option.



Choose this option to redefine the chosen style using the current text selection as an example.    The formatting of the chosen 
style will be replaced with the formatting of the text selection.    This is the default option when reapplying paragraph styles.



Applies bold formatting to the selected text.



Lets you choose a bullet style for the selected paragraph.







Click this button to open a color selection dialog and choose a new color for the selected text. The new color appears in the 
swatch next to the button.





Click this button to apply the color shown in the swatch to the selected text. To change the currently defined color, click the Color 
button.





Applies the default site color to the selected text.





Lists available fonts you can apply to the selected text. Site Style is the default font.    



Applies a solid color background to the selected text container. The color that will be applied is shown in the swatch next to the 
button. To change the color, click the Color button.



Choose a style for the selected paragraph. If you choose a style from this list, the style overrides any previously assigned font or 
size settings. You can also choose Add... from the list to add a new style based on any font or size settings you apply.



Inserts the selected symbol above into the text block at the insertion point.









Check this box if you want to add text to the selected picture or graphic object container.











Displays the paragraph style to be reapplied or redefined. The options below determine whether this style or the paragraph itself 
will be modified. Redefining the style using the selection as an example is the default choice (see help for each option below).



Displays the paragraph style to be reapplied or redefined. The options below determine whether this style or the paragraph itself 
will be modified. Redefining the style using the selection as an example is the default choice (see help for each option below).





Removes any solid color background in the selected text container. 









Text will be aligned to the top of the style element.



Site view. This is the Site view where you build, organize and manage the structure of your site. You can drag pages and 
sections to new locations in your site, and NetObjects Fusion updates the page links automatically.



















Enter the URL (Internet address) to be linked to the selected object.



Vertically aligns the selected picture to the bottom of its bounding box, when the bounding box is sized differently from the 
picture.



Vertically aligns the selected picture to the center of its bounding box, when the bounding box is sized differently from the picture.



Vertically aligns the selected picture to the center of its bounding box, when the bounding box is sized differently from the picture.









Displays the number of paragraphs in the current page.





When this box is checked (it's checked by default), a visible border is added to all elements placed on the page. To remove the 
borders, clear the checkbox.



Select this button if the currently selected page is to be excluded from the published site.



Enter or modify the Author Name, which is added to the HTML source. 



This text field displays the module (usually an .OCX file) which the selected ActiveX control uses for implementation.



Checking this option will place the filename listed in the above text field into the Codebase field in the ActiveX properties tab. 
(also see help for the text field above).



HIDC_DOFILE



Enter an HTML tag or tags to be inserted into current cursor position within the selected text block.



HIDC_SOLINK



HIDC_DOIMAGE



HIDC_DOLINK



Enter the number of pixels to move your background image to the left.



Enter the number of pixels to move your background image toward the top.



Enter the number of pixels to move your background image toward the top.



Lets you offset your background image. Most browsers (such as Netscape Navigator or Microsoft Internet Explorer) add a small 
gutter to the top and left edges of their windows. Offsetting your background images will allow you to compensate by moving the 
image to the left and toward the top.



Select the protocol to use to publish your site. Currently FTP (the protocol most often used for uploading files) is the only 
available protocol.



Click here to configure settings for remote staging.    Opens the Remote dialog box, where settings may be entered or modified.



Enter the text you would like to be inserted into the published HTML page before the selected element. Click the Insert button to 
insert a text or HTML file in this edit box.    Click OK to confirm the insertion, Cancel to exit this dialog without inserting or 
changing the script.



Displays the name used by this name-value pair.    Enter a name here if creating a new name-value pair.    



The data field will consist of formatted text, which includes font styles, paragraph and other formatting attributes.



The data field will consist of simple text, without formatting.



Choose this option to go to the page which begins with the characters entered above. A list of all pages which match the search 
characters will be displayed.



Choose this option to go to the page which ends with the characters entered above. A list of all pages which match the search 
characters will be displayed.



Choose this option to go to the page which contains the characters entered above. A list of all pages which match the search 
characters will be displayed.



Lets you preview the entire site when the Preview button is pressed. You may selectively preview the current page (and not the 
entire site) by holding down Ctrl while pressing the Preview button.    All links to other pages in your site will be disabled when 
previewing just the current page.



Check this option to preview the active or current page, and not the entire site, when the Preview button is pressed.    If this 
option is not checked, you may selectively preview an active page (and not the entire site) by holding down Ctrl while pressing 
the Preview button.



Enter the name or partial name of the page you wish to go to. Use the options below to choose whether to search for a page 
which begins with, contains, or ends with the text entered here. A list of all pages which match the search characters will be 
displayed.



Enter the relevant text in this edit box.



Folder in which the primary pages of your site will be stored. You can use any local or network path. 



Click here to configure settings for remote publishing.    Opens the Remote dialog box, where settings may be entered or 
modified.



Enter the number of pixels to move your background image to the left.



Displays the number of pages in your site.



Enter the text you would like to be inserted into the published HTML page within the tag associated with the selected element. 
The text inside the element is placed just before the tag’s closing angle bracket. For example, if you’ve placed the picture 
“airplane.jpg” on your page and added the text ‘lowsrc=”airplane_low.jpg”’, the HTML source will read <IMG SRC=”airplane.jpg” 
lowsrc=”airplane_low.jpg”>. Click the Insert button to insert a text or HTML file in this edit box. Click OK to confirm the insertion, 
Cancel to exit this dialog box without inserting the script.



Lets you offset your background image. Most browsers (such as Netscape Navigator or Microsoft Internet Explorer) add a small 
gutter to the top and left edges of their windows. Offsetting your background images will allow you to compensate by moving the 
image to the left and toward the top.



Displays the file name of the selected Java applet, Shockwave or other plug-in file.



Displays the Page Type for the selected page, either Normal or Stacked Page (data pages used by a data list).



Shows the color of the currently selected page icon. To change the color, click the Color button.



Displays the current background color of the selected data list or table. To change the color, click the Color button.



Shows the color of the currently selected page icon. To change the color, click the Color button.



Displays the name of the currently selected proportional font used throughout your site.



Displays the name of the currently selected monospace font in use throughout your site.



Displays the file name represented by the selected element.



Displays the color that will be applied to the selected line or element border. To change the color, click the Color button.



Displays the color that will be applied to the selected line or element border. To change the color, click the Color button.



Shows the current fill color for the selected graphic element. To change the color, click the Color button.



Shows the current fill color for the selected graphic element. To change the color, click the Color button.



Displays the file name of the selected Java applet, Shockwave or other plug-in file.



Displays the name of the current site (if creating a new site, enter its name here).



Shows the date and time the current site was created.



Shows the date and time the current site was last changed.



Displays the number of pages in your site.



Displays the current picture used for the banner in this style.    Click on the Browse button to select a new picture.



Displays the Font currently selected for this style element.



Displays the current picture used for regular or non-highlighted buttons in this style. Click on the Browse button to modify this 
selection.



Displays the current picture used for highlighted buttons in this style. Click on the Browse button to modify this selection.



Displays the color that will be applied to the selected text if you choose the color option next to the swatch. To change the color, 
click the Color button.



Shows the color that will be applied to the selected text container background if you choose the background color option. To 
change the color, click the Color button.



When a style is selected, you can view its elements in the window on the right. Double-clicking a style or clicking the Elements 
button in the secondary control bar will open the Elements view, where you may edit the style's elements.



When an element is selected, you can edit it by double-clicking the list item or clicking the Edit button in the secondary control 
bar.    See help for individual controls within each dialog box for further information.



Files. Shows you a list of files (such as pictures, audio, video, external HTML documents, Java applets, etc.) that are associated 
with your site. You can use the list to manage these files and their associations.
Links. Shows you a list of page, smart, and external links that are associated with your site, as well as the page or pages on 
which each link appears.
Data Objects. Shows you a list of data objects that are associated with your site. Data objects define data-based information 
from either internal or external sources You can use the list to remove the data object from your site or edit the data object 
definition.
Variables. Shows you a list of User defined variables that are used within your site, as well as the page or pages on which each 
variable appears.



Enter or modify the name for this link. This name, used in Assets view, is an internal reference and is not added to HTML 
generated when your site is staged or published.



Choose this option to enable the Snap to Grid feature. All elements placed on a page will snap to the grid.    Grid settings are 
found in the View properties tab, in Page view.



HIDC_EDIT1_VALUE



HIDC_ABOUTBOX



HIDC_CUT



HIDC_COPY



Select a tail style to use for the selected line. You may choose a Point, Arrow, Diamond, Circle or Square.



HIDC_PASTE



Select a head style to use for the selected line. You may choose a Point, Arrow, Diamond, Circle or Square.



HIDC_UNDO



Check this box to have the line head and tail share the same style.



HIDC_LOOKUP



Check this box to have the line head and tail share the same color.



HIDC_COMMENT_TYPE



Enter or use the spin buttons to adjust the line width value from 1 to 100.    



Standard Cut, Copy, Paste and Undo buttons.    Use these to easily cut, copy and paste text or undo actions within this dialog 
box.



Enter or use the spin buttons to adjust the line width value from 1 to 100.



HIDC_FUNC_NAME



HIDC_LIST1



HIDC_LIST2



Displays a list of installed NetObjects Fusion Components.    To add a Component to this list, click on the Add… button below.



Check this box to outline the head and tail with the line color.



HIDC_EDITBODY



HIDC_FILESASSETS



HIDC_LISTFOLDERS



Select the type of variable to insert at the cursor position into the text block.    Select Date & Time to insert date or time variables 
(click the Date Format… button to choose from many date and time formats), or Site & General to insert site information and 
other variable.    These fields will update when you switch from view to view, preview or publish.    Select User defined to choose 
from text variables you have created (click the New… button to define a new variable).



Displays the name of the current MasterBorder. You may change this name at any time, which will update throughout your site.    
To create a new MasterBorder, select the New button on the Layout properties palette, select the MasterBorder, and change its 
name and settings from this property palette.



HIDC_LISTASSETS



Displays all available variables for the field type chosen above.    If a Date & Time field is selected, click the Date Format… 
button to choose a date and time format.    If User defined is chosen, choose from the list of defined variables, or click the 
New… button to define a new one.



The value for the currently selected variable is displayed here.    The values are displayed only and are not editable.



HIDC_FILEPATHLABEL



Click on this button to choose a date format for the currently selected Date & Time field. Opens the Date Format dialog box, 
where many date and time formats are available.



HIDC_FILEPATH



HIDC_SITE_CUSTOM_ADD



HIDC_SITE_CUSTOM_DELETE



HIDC_EDIT_TAGNAME



HIDC_SITE_CUSTOM_NAME



Opens the New Anchor dialog box.    Click this button to create (or remove) an anchor for the selected element.    To link the 
selected element to an already defined anchor click the Link… button and choose an anchor from the Internal Link tab.



Select this option to create an internal link to the current page. If desired, select an anchor from the Select Anchor dropdown list 
below to create a link to an anchor on the current page.



Click this icon to include a frame for the left side of the current MasterBorder.    The order of frames chosen (displayed in 
parentheses below) will determine whether a frame spans the height of the MasterBorder margin or ends at another frame’s 
edge.



HIDC_RADIO_CENTER



When this option is selected, a background grid is displayed in Page view.    Set the grid width and height below in terms of the 
current unit of measurement (see above).    Check the snap to grid/guides box below to have positioned elements snap to the 
grid.



When this option is selected, guides are displayed in Page view.    By default, one horizontal and vertical guide will appear on 
your screen.    Drag to reposition a guide, or hold down Ctrl and drag from a guide to create a new guide. Check the snap to 
grid/guides box below to have positioned elements snap to your guides.



HIDC_SITE_CUSTMO_LIST



Check this box to replace the current layout with an external HTML file.      Locate an external HTML file with the standard Open 
dialog box which appears when this option is selected.    The selected HTML file will be published in place of the current internal 
page layout.    No changes are made to the external HTML file.    To edit the external HTML file (with the editor specified in Edit | 
General Preferences), double-click anywhere in the grayed-out page view.    You may toggle between the internal layout (which is
not lost) and the selected external HTML file.



Displays the name of the currently selected anchor.    If creating a new anchor, enter its name here.



HIDC_USEANCHOR



Click this icon to include a frame for the right side of the current MasterBorder.    The order of frames chosen (displayed in 
parentheses below) will determine whether a frame spans the height of the MasterBorder margin or ends at another frame’s 
edge.



HIDC_FRAME_BORDER



HIDC_PICTURE_TEXT_ALIGN



The value for the currently selected variable is displayed here.    The values are displayed only and are not editable.



HIDC_RADIO_LEFT



HIDC_FINDPAGE



Displays the name of all pages in the current site. Enter a full or partial name of the desired page in the edit box above to jump to
the desired page in this list box.



Click this icon to include a frame for the top of the current MasterBorder.    The order of frames chosen (displayed in parentheses 
below) will determine whether a frame spans the length of the MasterBorder margin or ends at another frame’s edge.



Check this box to allow users to resize the current frame from within their browser window.    If unchecked, the frame will be set to
its current fixed height and width.



HIDC_ORIENTATION_SLIDER



Choose a date and/or time format to use for the current variable from the many formats below.



HIDC_ANCHORNAME



Displays a list of anchors defined for the page selected above.    Select an anchor from this dropdown list to create or modify the 
internal link to an anchor within the selected page.



Click this icon to include a frame for the bottom of the current MasterBorder.    The order of frames chosen (displayed in 
parentheses below) will determine whether a frame spans the length of the MasterBorder margin or ends at another frame’s 
edge.



HIDC_FRAME_BORDERSZ



Displays the current level of text rotation in degrees.    Use the slider control on the left to adjust the number of degrees the text 
will be rotated.    If the Right angles check box below is checked, this number will be constrained to 90 degree increments.



HIDC_RADIO_RIGHT



HIDC_PAGENAME_INTERNALLINK



Displays a list of anchors defined for the current page.    Select a new anchor from this list if changing the currently selected 
anchor.



HIDC_FRAME_BORDERSZ_SPIN



HIDC_STATIC_EXAMPLE



Select this option to create an internal link to a page within the current site. Enter a full or partial name of the desired page in the 
edit box (on the right) to jump to the desired page in the list box below.



Displays the current frame's name.    The default names are Left Frame, Right Frame, Top Frame or Bottom Frame.    You may 
enter a new name for the current frame in this edit box.    NetObjects Fusion uses this name when generating the HTML source 
for your site.



If this box is checked, text rotation will be constrained to 90 degree increments.    The current level of text rotation is displayed 
above.    Use the slider control on the left to adjust the degree of text rotation.



HIDC_ORIENTATION_SLIDER2



Click here to make the current frame scrollable.    Regardless of the frame's contents, site visitors will see scroll bars for this 
frame in their browser window.



HIDC_CHECK_RA2



Click here to make the current frame size not scrollable. Regardless of the frame's contents, site visitors will never see scroll bars
for this frame in their browser window.



Click here to have browsers automatically determine whether to include scroll bars or not for the current frame.    If the contents 
of the frame fits within the frame size, no scroll bars will be displayed.    If the contents extend beyond the frame size (such as 
when users resize their browser window) scroll bars will be displayed.



Enter the number of the FTP port you would like to publish or stage to (the default is 21).    In most cases, you will not need to 
modify this field. 



Check this box to enable the generation of comments in the HTML source.    NetObjects Fusion adds various comments to the 
HTML to help describe the generated source.



Check/uncheck this box to enable/disable the generation of a data (.MCF) file for Apple’s HotSauce (previously known as Project
X) site map format.



HIDC_ARCHIVE



Click on this button to define a new text variable when the User defined type is selected above. Opens the New Variable dialog 
box, where you name and assign a value to a new variable.



HIDC_ARCHIVE_FORMAT



Enter a name for the new User defined variable here.



Enter a value for the new User defined variable here.



Enter an indent level for this style in the edit box, or use the spin buttons to adjust the level.    Note: each indent level increment 
of 1.00 is equal to 40 pixels.



Displays the name of the currently selected anchor.    If creating a new anchor, enter its name here.



Enter the number of directory levels you wish to limit this import to, or use the spin buttons to adjust the value.



Select the text alignment (Left, Center or Right) to be used for this style.



Click on this button to remove the currently selected anchor from the page.



Enter the maximum number of pages to import from the chosen site in this edit box, or use the spin buttons to adjust the value.



HIDC_SLURPHOMEPAGE



Lets you view or change the width of the top margin in terms of the current unit of measurement. You can change the margin size
by typing a new number directly into this field or clicking the spin buttons to change the value in increments of one unit.



HIDC_SLURPMAXTIMEOUT



HIDC_TOP_MARGIN_SPIN



Click the up or down arrows to change the top margin width in increments of one unit.



HIDC_SLURPLOCALPATH



Lets you view or change the width of the bottom margin in terms of the current unit of measurement. You can change the margin 
size by typing a new number directly into this field or clicking the spin buttons to change the value in increments of one unit.



Click the up or down arrows to change the bottom margin width in increments of one unit.



Select this option to have the imported site converted to NetObjects Fusion format.    When converted all text, links, pictures and 
other elements within pages are brought into Page view, and can be modified as any NetObjects Fusion page layout.    When this
box is unchecked, each page is considered an external HTML file, which can only be edited with the HTML editor specified in 
Edit | Preferences.



HIDC_SLURPLOCALPATH2



Displays the currently selected unit of measurement used in determining margin size. You can change the unit used by clicking 
the View tab and choosing another Measurement Unit from the list.



Enter the local path and filename of the page to be imported as the root or Home page.    The standard filename is index.html 
(browsers look for and automatically open files of this name when pointed to a folder).



Displays the currently selected unit of measurement used in determining margin size. You can change the unit used by clicking 
the View tab and choosing another Measurement Unit from the list.



Enter the domain name used by the local site you wish to import.    NetObjects Fusion will define imported assets as internal or 
external based on the domain name entered here. For example, links which include this domain name in their URL will be 
considered internal.



HIDC_TEXT_PD_BROWSE



HIDC_SLURPIMPORTOPTIONS



Click on this button to open the Text Settings dialog box, where you may modify the text settings for the current style element.



Opens the Custom Names dialog box, where you can customize the title, button name, banner name and file extension for the 
current page.



HIDC_DONTSHOW



HIDC_TEXT_SELECTITEMS



HIDC_SLURPDIRBROWSE



Enter the correct file or folder name in this edit box.    Click on the Browse button to open a standard Open dialog box.



Click here open the Paragraph Style dialog box, where you select or modify the current style’s attributes.    You may also select 
and format text (using the options on this property palette) and reselect the style in the dropdown list.    The Reapply Style dialog 
box will open, which will allow you to redefine the style with the character formatting of the selected text.



Choose an application to use as an HTML editor, which will be invoked for pages which you associate with external HTML files.    
Enter the filename and path here, or click on the Browse… button to open a standard file Open dialog box to browse for a 
program file (.exe).



Displays the current display setting for the selected nav bar.    Click on the Set… button to open the Nav Bar Display dialog box 
and adjust the current display setting.



Click on this button to open the Text Settings dialog box, where you may modify the text settings for the current style element.



Click here to include a background sound for the current page.    The Background Sound dialog box will open, where you select a
sound file.    (To modify your selection at a later point, click on the Sound… button.) 



Check this box to limit the number of pages NetObjects Fusion will attempt to import from the chosen site.    Enter the maximum 
number of pages in the edit box, or use the spin buttons to adjust the value.



Displays the missing file or folder name which is no longer properly associated to its file asset.



Open a standard file Open dialog box where you may browse for a program file (.exe) to use as an HTML editor, which will be 
invoked for pages which you associate with external HTML files.



Click here to create a new Paragraph Style. The New Paragraph Style dialog box opens, where you name your new style. To 
define its attributes, either click on the Edit button (which opens a separate Paragraph Style dialog box) or select and format text 
(using the options on this property palette) and reselect the style in the dropdown list on the left.    The Reapply Style dialog box 
will open, which will allow you to redefine the style with the character formatting of the selected text.



Enter a name for your form here.    The form name is used primarily for advanced scripting.



Select this option to limit the depth of directory levels NetObjects Fusion will import from the chosen site.    Enter the number of 
levels directly into the edit box or use the spin buttons to adjust the value.



Opens a standard Windows file Open dialog box, where you may browse for files or folders.



Check this box to allow your margins to resize when objects are dragged beyond the edges of the current page margins.    When 
objects are placed or pasted outside of the current margins, they will automatically resize.    Also allows you resize margins by 
dragging margin borders.    This option is disabled by default.



HIDC_SLURP_ANMCONTROL



Select this option to use the current SiteStyle for primary or secondary buttons used for this nav bar.    Select a button style from 
the Buttons group above.    This option has no effect on text buttons.



HIDC_SLURPIMPORT_REMOTE



Click on this button to skip this file or folder and continue verifying file assets.



Enter a default page or layout width, in pixels, to be used throughout the current site, or use the spin buttons to adjust.



Select this option to choose a style different from the selected Site Style for use only with the selected banner.    Select a different
style to use for the selected banner from the dropdown list.    



Enter the URL address of the remote site you wish to import.



HIDC_SLURPIMPORT_LOCAL



Lists all found missing file or sub-folders which were previously found in the missing folder.



Opens the Background Sound dialog box, where you enter a sound file for the current page.



Select a style to use for the selected banner.    This affects the current banner only.



Enter the path and filename of a sound file to use as the background sound for this page (.au, .wav and .mid files are supported).
Click on the Browse button to open a standard file Open dialog box to browse for sound files.



Opens the Nav Bar Display dialog box, where you choose which levels and pages the selected navigation bar will display.    See 
help on individual controls within the Nav Bar Display dialog box for further help.



HIDC_EDIT_BG_LOOP



Enter HTML or other script text to be inserted between the opening and closing Head tags (if Layout, Master or Frame Script), or 
before the selected element's definition tag (if Element Script).    Click on the Insert button to open a standard file Open dialog 
box to insert a text file into this edit box.



Click on the spin buttons to the right to rotate the selected picture in 90 degrees increments.



Check this box to have the selected background sound repeat continuously when site visitors browse to this page.



Enter the URL address of the remote site you wish to import.



Enter HTML or other script text to be inserted between the opening and closing Head tags (if Layout, Master or Frame Script), or 
before the selected element's definition tag (if Element Script).    Click on the Insert button to open a standard file Open dialog 
box to insert a text file into this edit box.



Displays the font chosen.    To change the current font click on the Set… button to open a standard Font dialog box.



Opens a standard file Open dialog box to browse for sound files (.au, .wav and .mid files are supported), or directly enter the 
path and filename of a sound file to use as the background sound for this page in the edit box. 



Enter HTML or other script text to be inserted at the beginning of, but not inside, the Body tag (if Layout, Master or Frame Script),
or after the selected element's definition tag (if Element Script).    Click on the Insert button to open a standard file Open dialog 
box to insert a text file into this edit box.



Click this button to flip the selected banner 180 degrees.    



HIDC_STATIC_FONT2



HIDC_STATIC_COLOR_WELL



Enter HTML attributes to be inserted inside the Body tag (if Layout, Master or Frame Script), or inside the selected element's 
definition tag (if Element Script). This text is inserted inside the tag itself, so only applicable HTML attributes for the Body or 
element definition tag will work. Click on the Insert button to open a standard file Open dialog box to insert a text file into this edit 
box.



HIDC_RCOMBO



Click this button to add all fields listed above to this data list.



Enter HTML attributes to be inserted inside the Body tag (if Layout, Master or Frame Script), or inside the selected element's 
definition tag (if Element Script). This text is inserted inside the tag itself, so only applicable HTML attributes for the Body or 
element definition tag will work. Click on the Insert button to open a standard file Open dialog box to insert a text file into this edit 
box.



Click on this button to add a new Component to the list of available components.    Opens a standard file Open dialog box where 
you can select a .NFX or NetObjects Fusion Component file. 



Enter HTML or other script text to be inserted at the beginning of, but not inside, the Body tag (if Layout, Master or Frame Script),
or after the selected element's definition tag (if Element Script).    Click on the Insert button to open a standard file Open dialog 
box to insert a text file into this edit box.



Displays the color chosen for the text.



Click on the spin buttons to the right to rotate the selected picture in 90 degrees increments.



HIDC_SERVER_LIST



HIDC_CLEAR_FILTER



Opens the Insert Variable dialog box, where you may enter Date and Time, Site or User-defined variables into the selected edit 
box (where the cursor is currently located).    See help within the dialog box for further information.



Displays a number indicating the order of frames selected with the icons above.    This order determines which frames span the 
height or width of the MasterBorder margin or end at another frame’s edge.



Displays a number indicating the order of frames selected with the icons above.    This order determines which frames span the 
height or width of the MasterBorder margin or end at another frame’s edge.



Displays a number indicating the order of frames selected with the icons above.    This order determines which frames span the 
height or width of the MasterBorder margin or end at another frame’s edge.



Displays a number indicating the order of frames selected with the icons above.    This order determines which frames span the 
height or width of the MasterBorder margin or end at another frame’s edge.



HIDC_TEXTFIELD_URL



HIDC_TEXTFIELD_TEXT



HIDC_TEXTFIELD_HTML



When this option is checked, HTML frame borders will be generated and displayed in web browsers.



HIDC_TEXTFIELD_DBOPTIONS



HIDC_RADIO_NOCONVERT



HIDC_INPUTPROMPT



HIDC_FILEASSETTAB



Opens a standard Windows file Open dialog box to browse for the Home page of your local site or section.



Click to cancel your modification to the ActiveX or NetObjects Component property highlighted below.



HIDC_HTMLTAG



Click this button to open an applicable dialog box (such as a standard file Open or Color dialog box) to edit the selected 
parameter.



Select this option to create a new site based on a remote web site.    The Set Remote Import dialog box will open if you choose to
create a new site in this manner.    See help for controls within that dialog box.



Displays the total Width and Height for the current page, which includes the current layout size and MasterBorder size, in terms 
of the selected unit of measurement.



Use these spin buttons to adjust the the number of directory levels you wish to limit this import to.



Select from a dropdown list of available Java applet (.class) files.    To add or delete class files from this list click on the List… 
button, which opens the Java Applet Files dialog box.    This dialog box allows you to manage a list of Java applet files you plan 
to use throughout your site. 



HIDR_LAYOUT_MENU



Click the up or down arrows to change the left margin height in increments of one unit.



Displays the currently selected unit of measurement used in determining margin size. You can change the unit used by clicking 
the View tab and choosing another Measurement Unit from the list.



Lets you view or change the height of the left margin in terms of the current unit of measurement. You can change the margin 
size by typing a new number directly into this field or clicking the spin buttons to change the value in increments of one unit.



Enter a default page or layout height, in pixels, to be used throughout the current site, or use the spin buttons to adjust.



Enter a custom title for the current or selected page.    Site visitors will see this title in the titlebar of their browser when viewing 
this page. This overrides the default page title, which takes from the page name displayed in Page properties (which is used as 
the HTML filename).



Displays the total Width and Height for the current page, which includes the current layout size and MasterBorder size, in terms 
of the selected unit of measurement.



Select this option to create a new site based on a local copy of a pre-existing web site.    The Set Local Import dialog box will 
open if you choose to create a new site in this manner.    See help for controls within that dialog box.



HIDC_BUTTON3



HIDC_BUTTON4



HIDR_SITESLURP_FILECOPY_AVI



Click on this button to delete a Java applet file from the list.



Applies strikeout formatting to the selected text.



Check/uncheck this box to enable/disable the generation of a data file for NetObjects Fusion’s Sitemapper component.



HIDC_INSERT_SCRIPT2



Click this button to open the Text in Element Settings dialog box, where you can modify various attributes of the text you wish to 
place on the selected element.    See help on individual controls within the Text in Element Settings dialog box.



HIDC_PICT_TEXT_ORIENTATION



HIDC_EDIT4



HIDC_EDIT5



Enter value(s) here.



Opens a standard Color dialog box, where you can choose a color for the line's tail. 



Enter or edit the highlighted ActiveX control or NetObjects Fusion Component property in this edit box.    Click the check icon to 
save your changes, or the X icon to cancel the adjustment.    (For editing certain properties, such as Color, double-clicking on the 
property will open an applicable standard Windows dialog box.)    



Displays the currently selected unit of measurement used in determining page size. You can change the unit used by clicking the 
View tab and choosing another Measurement Unit from the list.



Displays the current line head color.    Click on the Color button to change this color.



Displays the current line tail color.    Click on the Color button to change this color.



Displays the current line color.    Click on the Color button to change this color.



Displays the currently selected unit of measurement used in determining page height and width. You can change the unit used by
clicking the View tab and choosing another Measurement Unit from the dropdown list.



HIDC_SLURPTIMEOUT_CHECK



HIDC_TEXT_LOCK2



HIDC_FIELD_VAL



Enter a custom banner title for the current or selected page.    This overrides the default banner title, which takes from the page 
name displayed in Page properties.    This applies to all banners, whether placed in the MasterBorder or in the page layout.



HIDC_STATIC_TEXT_BOX2



Enter a custom nav bar button name for the current or selected page.    This overrides the default nav bar button name, which 
takes from the page name displayed in Page properties.    This custom name will be used in all nav bar buttons throughout your 
site.



HIDC_SITE_CUSTOM_VALUE



HIDC_SLURPCASEURLS_CHECK



Click the up or down arrows to change the right margin height in increments of one unit.



Displays the currently selected unit of measurement used in determining margin size. You can change the unit used by clicking 
the View tab and choosing another Measurement Unit from the list.



HIDC_ANCHOR



HIDC_CURSOR2



Shows the available properties for the current ActiveX control or NetObjects Component.    Depending on which type of property 
is selected, you will either see an edit box or drop-down combo box at top, and (when applicable) a set of spin buttons or a 
square button to the right.    Enter values directly into the edit box, or choose a value from the drop-down list. The spin buttons 
allow you to adjust numerical values, while the square button will open an applicable standard dialog box for the selected 
property.    When editing a property such as Color, for example, a standard Windows Color dialog box will open when the square 
button is clicked.    Click the checkmark icon to save your changes, or the X icon to cancel the current adjustment. 



Use this slider to to adjust the degree of text rotation.    In Page view, the text is re-oriented directly on-screen.    Choose undo 
from the Edit menu to undo any changes made in this dialog box. The current level of text rotation is displayed to the right. If the 
Right angles check box is checked, text rotation will be constrained to 90 degree increments. 



HIDC_TEXTFIELD_HTMLFILE



Displays the current line color.    Click on the Color... button to change this color.



Lets you view or change the height of the right margin in terms of the current unit of measurement. You can change the margin 
size by typing a new number directly into this field or clicking the spin buttons to change the value in increments of one unit.



Displays the current background sound file you have selected for this page.



Enter a custom file extension to use for the current or selected page.    This overrides the default extension name, which is set in 
Settings for Stage or Publish, in Publish view.    This custom extension will apply to the current page's filename only.



When this option is selected, neither the grid nor guides are displayed in Page view.



Displays the external HTML file you have chosen to replace the current page layout.



Use these spin buttons to adjust the indent level for this style, or enter a number directly into the edit box.    Note: each indent 
level increment of 1.00 is equal to 40 pixels.



Use these spin buttons to adjust the maximum number of pages to import from the chosen site or directly enter a value into the 
edit box.



HIDC_SPIN



Enter a default page or layout width, in pixels, to be used throughout the current site, or use the spin buttons to adjust.



Opens a standard Color dialog box, where you can choose a color for the selected line. 



HIDC_PICTURE_TEXT_CENTER



Opens a standard file Open dialog box, where you select an HTML file to replace the current page layout.



HIDC_PICTURE_TEXT_RIGHT



Displays the current line head color.    Click on the Color button to change this color.



Applies subscript formatting to the selected text.



Enter or modify the text you wish to place on the current selected object or element.    Modify settings for the text in element with 
the options below.



Opens a standard Color dialog box, where you can choose a color for the line head.



Applies superscript formatting to the selected text.



Displays the current line tail color.    Click on the Color button to change this color.



HIDC_SPIN_BG_LOOP



Enter a default page or layout height, in pixels, to be used throughout the current site, or use the spin buttons to adjust.



Click on these spin buttons to rotate the selected picture in 90 degrees increments.



Displays the selected button text.



Check this box to enable the snap to objects feature.      When an element or object is positioned near enough to another 
onscreen, it will “snap” to the adjacent object.



Select this option to create a new site from scratch.    A blank site with one page will open in Site view.



Select this option to create a new site based on a NetObjects Fusion AutoSite template.    Choose an AutoSite template from the 
dropdown list (on the right).



Opens a standard Windows file Open dialog box to let you browse for NetObjects Fusion template (.nft) files.    Choose from 
predefined templates or from .nft files you've created (Page templates, for example, can be found in the NetObjects Fusion\
Templates\Pages folder). 



Displays the template path and filename you wish to base this new site on.    You may directly enter or modify the path and 
filename here.    Click on the Browse button to open a standard Windows file Open dialog box, which lets you browse for 
NetObjects Fusion template (.nft) files.    Choose from predefined templates or from .nft files you've created (Page templates, for 
example, can be found in the NetObjects Fusion\Templates\Pages folder). 



Select this option to create a new site based on a NetObjects Fusion template (.nft) file. Click on the Browse button (to the right) 
to open a standard Windows file Open dialog box, which lets you browse for template files, or directly enter the full path and 
name in the edit box.    Choose from predefined templates or from .nft files you've created (Page templates, for example, can be 
found in the NetObjects Fusion\Templates\Pages folder). 



Choose an AutoSite template from this list to create a new site based on a NetObjects Fusion AutoSite template.    AutoSites 
templates displayed here are .nft (NetObjects Fusion template) files found in the NetObjects Fusion\Templates\AutoSites folder.



Select this option to insert a section based on a NetObjects Fusion Page template into the current site as a child of the selected 
page (in Site view).    Choose a Page template from the dropdown list on the right.    Page templates displayed here are .nft 
(NetObjects Fusion template) files found in the NetObjects Fusion\Templates\Pages folder.



Select this option to insert a section based on a NetObjects Fusion template (.nft) file into the current site as a child of the 
selected page (in Site view).    Click on the Browse button (to the right) to open a standard Windows file Open dialog box, which 
lets you browse for template files or directly enter the full path and name in the edit box.    



Displays the path and filename of the template to be inserted into the current site.    You may directly enter or modify the path and
filename here.    Click on the Browse button to open a standard Windows file Open dialog box, which lets you browse for 
NetObjects Fusion template (.nft) files. 



Opens a standard Windows file Open dialog box to let you browse for NetObjects Fusion template (.nft) files. 



Choose a Page template from this list to create a new site based on a NetObjects Fusion Page template.    Page templates 
displayed here are .nft (NetObjects Fusion template) files found in the NetObjects Fusion\Templates\Pages folder.



Select this option to insert a local copy of a pre-existing web site as a section into the current site (as a child of the selected 
page).    The Set Local Import dialog box will open if you choose to insert a section of this type.    See help for controls within that 
dialog box.



Select this option to insert a remote web site as a section into the current site (as a child of the selected page).    The Set Remote
Import dialog box will open if you choose to insert a section of this type.    See help for controls within that dialog box.



Opens a standard Windows file Open dialog box, where you may browse for a picture file to use for this style's background.



Positions text horizontally to the left within the element.    Not to be confused with the Relative Alignment buttons (see help on 
Relative Alignment buttons for further information).



Positions text horizontally to the center within the element.    Not to be confused with the Relative Alignment buttons (see help on 
Relative Alignment buttons for further information).



Positions text horizontally to the right within the element.    Not to be confused with the Relative Alignment buttons (see help on 
Relative Alignment buttons for further information).



Positions text vertically to the top within the element.    Not to be confused with the Relative Alignment buttons (see help on 
Relative Alignment buttons for further information).



Positions text vertically to the center within the element.    Not to be confused with the Relative Alignment buttons (see help on 
Relative Alignment buttons for further information).



Positions text vertically to the bottom within the element.    Not to be confused with the Relative Alignment buttons (see help on 
Relative Alignment buttons for further information).



Check this option to have NetObjects Fusion always open in a maximized window.



Adjust the current value with these spin buttons.



Enter a value in pixels with which to inset the text within the current text block.



Displays a list of URLs used within the current site.    You may choose an external link from this list to use for the current object or
text.



Choose an internet protocol type from the dropdown list to use for this external URL.    You may also type directly into this 
dropdown list/edit box. 



HIDC_EDIT_INLINE



HIDC_LOOKUP2



HIDC_LOOKUP1



Check this radio button to optimize NetObjects Fusion's HTML generation for Netscape browsers. Optimized WYSIWYG support 
displays your previewed or published site in Netscape as it appears within NetObjects Fusion.



Check this radio button to optimize NetObjects Fusion's HTML generation for Microsoft Internet Explorer.    Optimized WYSIWYG
support displays your previewed or published site in Internet Explorer as it appears within NetObjects Fusion.



Choose a language dictionary to use for spell checking from this dropdown list.



Check this option to disable the conversion of High ASCII characters to HTML character entities (also called escape sequences). 
Especially useful for building non-English web sites using double-byte character sets.



Use these spin buttons to adjust the value in pixels with which to inset the text within the current text block.



Click here to leave the word in the Not found box unchanged.



Click here to open the Spell Check Options dialog box, where you specify the lanaguage and personal dictionary to use when 
checking spelling in NetObjects Fusion.



Words not found in the dictionary and personal dictionary file (selected in the Spell Check Options dialog box) are displayed 
here.    For more information, view help for each control within this dialog box.



Suggested spellings for the word not found are displayed here.    A suggested word spelling will appear in the Change to box.    
Choose another word from the list of suggestions to replace the current entry in the Change to box.    For more information, view 
help for each control within this dialog box.



Displays the personal dictionary file in use.    Click the Browse button to locate a dictionary file (*.dic) or enter its path and name 
here.



Click here to change all instances of the word in the Not found box to the word in the Change to box.



Click here to leave all instances of the word in the Not found box unchanged during this spell check.



Click here to add the word in the Not found box to the personal dictionary selected in Spell Check Options.



Click here to change the word in the Not found box to the word in the Change to box.



Click here to display a list of proposed alternatives for the word in the Change to box.



Click on this button to open the Insert Variable dialog box where you may specify a Variable to be inserted into the raw HTML 
source of the active text block (at the insertion point), along with any other HTML tags or scripts entered in this dialog.



Locks minimum height of current text block.    Use this feature to maintain a fixed minimal height, even when the block contains 
little text.    This is helpful in preserving layouts when a site visitor's browser font size is smaller than the default, or when 
designing layouts before all text is entered.    



Hold down this button to view a superimposed outline of the HTML tables which will be generated for the current layout (grid lines
and object outlines will disappear while this button is pressed).    The Table Structure options above provide a choice in the 
method of HTML table generation. View help on these controls for more information. This feature is primarily for advanced users 
who wish to view the HTML table structure which NetObjects Fusion will generate. For further information on this feature, see the
Viewing HTML Table Structure topic in the NetObjects Fusion Help system.



Browsers' font preferences will affect the appearance of page layouts, and text blocks will grow or shrink vertically based on 
these settings. These two Table Structure options offer some control over these differences by determining the method by which 
NetObjects Fusion generates HTML tables. When the Columns option is selected, NetObjects Fusion will preserve the space 
between text blocks and the object(s) beneath it by generating HTML tables with a preference for columns. In this case, the 
relative vertical position of objects within columns will be preserved, but not the relative horizontal position of objects across 
columns.    When the Rows option is selected, the relative horizontal positions of text blocks and other objects will be preserved, 
but not the relative vertical position of objects within columns.    The Columns option is selected by default.    To view the HTML 
table structure NetObjects Fusion will use for the current layout, hold down the Show HTML Table button (see help on this button 
below). For further information on this feature, view the Choosing a Preferred Table Structure topic in the NetObjects Fusion 
Help system.



Browsers' font preferences will affect the appearance of page layouts, and text blocks will grow or shrink vertically based on 
these settings. These two Table Structure options offer some control over these differences by determining the method by which 
NetObjects Fusion generates HTML tables. When the Columns option is selected, NetObjects Fusion will preserve the space 
between text blocks and the object(s) beneath it by generating HTML tables with a preference for columns. In this case, the 
relative vertical position of objects within columns will be preserved, but not the relative horizontal position of objects across 
columns.    When the Rows option is selected, the relative horizontal positions of text blocks and other objects will be preserved, 
but not the relative vertical position of objects within columns.    The Columns option is selected by default.    To view the HTML 
table structure NetObjects Fusion will use for the current layout, hold down the Show HTML Table button (see help on this button 
below). For further information on this feature, view the Choosing a Preferred Table Structure topic in the NetObjects Fusion 
Help system.



These two Table Structure options affect the method by which NetObjects Fusion generates HTML for the current frame source.   
Browsers' font preferences will affect the appearance of layouts, and text blocks will grow or shrink vertically based on these 
settings. These two Table Structure options offer some control over these differences by determining the method by which 
NetObjects Fusion generates HTML tables. When the Columns option is selected, NetObjects Fusion will preserve the space 
between text blocks and the object(s) beneath it by generating HTML tables with a preference for columns. In this case, the 
relative vertical position of objects within columns will be preserved, but not the relative horizontal position of objects across 
columns.    When the Rows option is selected, the relative horizontal positions of text blocks and other objects will be preserved, 
but not the relative vertical position of objects within columns.    The Columns option is selected by default.    To view the HTML 
table structure NetObjects Fusion will use for the current frame source, hold down the Show HTML Table button found in the 
Layout properties palette, making sure View | Show Layout Only is unchecked (also view help on this control).    For further 
information on this feature, view the Choosing a Preferred Table Structure topic in the NetObjects Fusion Help system.



These two Table Structure options affect the method by which NetObjects Fusion generates HTML for the current frame source.   
Browsers' font preferences will affect the appearance of layouts, and text blocks will grow or shrink vertically based on these 
settings. These two Table Structure options offer some control over these differences by determining the method by which 
NetObjects Fusion generates HTML tables. When the Columns option is selected, NetObjects Fusion will preserve the space 
between text blocks and the object(s) beneath it by generating HTML tables with a preference for columns. In this case, the 
relative vertical position of objects within columns will be preserved, but not the relative horizontal position of objects across 
columns.    When the Rows option is selected, the relative horizontal positions of text blocks and other objects will be preserved, 
but not the relative vertical position of objects within columns.    The Columns option is selected by default.    To view the HTML 
table structure NetObjects Fusion will use for the current frame source, hold down the Show HTML Table button found in the 
Layout properties palette, making sure View | Show Layout Only is unchecked (also view help on this control).    For further 
information on this feature, view the Choosing a Preferred Table Structure topic in the NetObjects Fusion Help system.



When this box is checked, NetObjects Fusion's Automatic backup feature is enabled. Customize your automatic backup settings 
with the various options found below (in the Backup Settings group box). See help for each individual control below for further 
information. Automatic backup is enabled by default.



When this box is checked, a message box will prompt you before NetObjects Fusion saves a backup file. You will have the 
choice to save or not.



Specifies the maximum number of backup files to be maintained in the location specified above.    When the maximum number is 
reached, the earliest backups are deleted.    Enter a number directly or click the spin buttons to change.    The maximum allowed 
number of backup files is 20.



Specifies the maximum number of backup files to be maintained in the location specified above.    When the maximum number is 
reached, the earliest backups are deleted.    Enter a number directly or click the spin buttons to change. The maximum allowed 
number of backup files is 20, and the default setting is 2.



Specify the location you wish to keep your backup site files.    Click on Browse to browse for a new location.    The default backup 
location is a "Backups" folder found within the current site folder (User Sites\Sitename\Backups).



Opens the Select Folder dialog box, where you may select an alternative folder for your backup files.



Select a file naming convention from the dropdown list.    Choose from either dated backup files or sequentially numbered backup
files.



When this box is checked, NetObjects Fusion compacts the active site's database whenever you exit the application. The feature
is enabled by default (it is recommended that this option be enabled). The result of compaction is decreased .nod file sizes.




